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Safety information

Always follow basic safety precautions when 
using this product to reduce risk of injury from 
fire or electric shock.

1. Read and understand all instructions in the 
documentation that comes with the printer.

2. Observe all warnings and instructions 
marked on the product.

3. Unplug this product from wall outlets before 
cleaning.

4. Do not install or use this product near water, 
or when you are wet.

5. Install the product securely on a stable 
surface.

6. Install the product in a protected location 
where no one can step on or trip over the line 
cord, and the line cord cannot be damaged.

7. If the product does not operate normally, see 
Solve a problem.

8. There are no user-serviceable parts inside. 
Refer servicing to qualified service personnel.
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1 How do I?

● Get started

● Print

● Copy and scan

● Fax

● Web Services

● Work with ink cartridges

● Solve a problem
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2 Get started

This guide provides details about how to use the printer and how to resolve problems.

● Accessibility

● HP EcoSolutions (HP and the Environment)

● Understand the printer parts

● Use the printer control panel

● Paper basics

● Load paper

● Load an original on the scanner glass

● Load an original in the document feeder

● Insert a USB flash drive

● Update the printer

● Open the HP printer software (Windows)

● Turn the printer off

Accessibility
The printer provides a number of features that make it accessible for people with disabilities.

Visual

The HP software provided with the printer is accessible for users with visual impairments or low vision by 
using your operating system's accessibility options and features. The software also supports most assistive 
technology such as screen readers, Braille readers, and voice-to-text applications. For users who are color 
blind, colored buttons and tabs used in the HP software have simple text or icon labels that convey the 
appropriate action.

Mobility

For users with mobility impairments, the HP software functions can be executed through keyboard 
commands. The HP software also supports Windows accessibility options such as StickyKeys, ToggleKeys, 
FilterKeys, and MouseKeys. The printer doors, buttons, paper trays, and paper-width guides can be operated 
by users with limited strength and reach.

Support

For more details about the accessibility of this printer and HP's commitment to product accessibility, visit HP's 
website at www.hp.com/accessibility.

For accessibility information for Mac OS X, visit the Apple website at www.apple.com/accessibility.
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HP EcoSolutions (HP and the Environment)
Hewlett-Packard is committed to helping you optimize your environmental footprint and empowering you to 
print responsibly—at home or in the office.

For more detailed information about environmental guidelines that HP follows during the manufacturing 
process, see Environmental product stewardship program. For more information about HP's environmental 
initiatives, visit www.hp.com/ecosolutions.

● Manage Power

● Optimize Printing Supplies

Manage Power
To conserve electricity, the printer comes with the following features:

Sleep mode

Power usage is reduced while in Sleep mode. The printer goes into low-power mode after 5 minutes of 
inactivity.

To change the period of inactivity before the printer goes to sleep:

1. From the printer control panel display, touch .

2. Touch Sleep Mode, and then touch the desired option.

Schedule On and Off

Use this feature to automatically the printer on or off on selected days. For example, you can schedule the 
printer to turn on at 8 a.m. and turn off at 8 p.m. from Monday to Friday. In this way, you will save energy 
during the night and weekends.

To schedule the day and time for On and Off:

1. From the printer control panel display, touch .

2. Touch Schedule Printer On/Off.

3. Touch the desired option, and follow the on-screen messages to set the day and time to turn the printer 
off and on.

CAUTION: Always turn the printer off properly, using either Schedule Off or  (the Power button).

If you improperly turn the printer off, the print carriage might not return to the correct position, causing 
problems with the ink cartridges and print quality issues.

Optimize Printing Supplies
To optimize printing supplies such as ink and paper, try the following:

● Recycle used original HP ink cartridges through HP Planet Partners. For more information, visit 
www.hp.com/recycle.

● Optimize paper usage by printing on both sides of the paper.

● Save ink and paper when printing web content with HP Smart Print. For more information, visit 
www.hp.com/go/smartprint.
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● Change the print quality in the printer driver to a draft setting. The draft setting uses less ink.

● Do not clean the printhead unnecessarily. Doing so wastes ink and shortens the life of the cartridges.

Understand the printer parts
This section contains the following topics:

● Front view

● Printing supplies area

● Back view

Front view

1 Document feeder

2 Scanner glass

3 Front universal serial bus (USB) port

4 Power button

5 Output tray

6 Input tray

7 Output tray extender

8 Control panel display

9 Control panel

10 Document feeder tray

11 Document feeder paper-width guides
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Printing supplies area

1 Printhead

2 Ink cartridges

NOTE: Ink cartridges should be kept in the printer to prevent possible print quality issues or printhead 
damage. Avoid removing supplies for extended periods of time. Do not turn the printer off when a cartridge is 
missing.

Back view

1 Rear universal serial bus (USB) port

2 Ethernet network port

3 Fax port (2-EXT)

4 Fax port (1-LINE)

5 Power input
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Use the printer control panel
This section contains the following topics:

● Overview of buttons and lights

● Control panel display icons

● Change printer settings

Overview of buttons and lights
The following diagram and related table provides a quick reference to the printer control panel features.

Label Name and Description

1 Wireless light: Indicates the status of the printer's wireless connection.

2 Home button: Returns to the home screen from any other screen.

3 Control panel display: Touch the screen to select menu options, or scroll through the menu items. For information about the icons 
that appear on the display, see Control panel display icons.

4 Back button: Returns to the previous menu.

5 Help button: Opens the Help menu.

Control panel display icons

Icon Purpose

Displays a screen where you can make copies or select other options.

Shows that an Ethernet network connection exists and also provides easy access to the network status screen.

From the HP wireless direct menu you can turn on HP wireless direct (with and without security), turn HP wireless 
direct off, and display the HP wireless direct name and password (if HP wireless direct is turned on with security).

Shows that HP ePrint is turned on. For more information, see HP ePrint .
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Icon Purpose

Displays a screen where you can send a fax, or change fax settings.

Displays a screen where you can make a scan.

Displays a screen where you can use a number of HP printables, which are apps for your printer.

Displays the Photo screen for printing photos and creating passport photos.

Displays the Setup screen for generating reports, and changing fax and other maintenance settings.

The screen shows How To videos, printer feature information, and tips.

Displays wireless status and menu options. For more information, see Set up the printer for wireless 
communication.

NOTE:  (Ethernet) and  (Wireless) will not be displayed at the same time. Showing the Ethernet icon or 

the wireless icon depends on the way your printer is connected to the network. If the network connection of the 

printer has not been set up, by default, the printer control panel display shows  (Wireless).

Displays a screen where you can configure some of the printer's environmental features.

Displays status information for the Auto Answer function, fax logs, and the fax sound volume.

Displays a screen where you can see information about the ink cartridges, including fill levels.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-
ink warning message, consider having a replacement cartridge available to avoid possible printing delays. You do 
not need to replace cartridges until the print quality becomes unacceptable.

Change printer settings
Use the control panel to change the printer function and settings, print reports, or get help for the printer.

TIP: If the printer is connected to a computer, you can also change the printer settings using HP software 
tools available on your computer, such as the HP printer software, HP Utility (OS X), or the embedded web 
server (EWS).

For more information about these tools, see Printer management tools.

To change settings for a function

The Home screen of the control panel display shows the available functions for the printer.

1. From the control panel display, touch and slide your finger across the screen and then touch the icon to 
select the desired function.

2. After selecting a function, touch and scroll through the available settings, and then touch the setting 
you want to change.

3. Follow the prompts on the control panel display to change the settings.
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NOTE: Touch  (Home) to return to the Home screen.

To change the printer settings

To change the printer settings or print reports, use the options available on the Setup Menu screen:

1. From the printer control panel display, touch Setup .

2. Touch and scroll through the screens.

3. Touch the screen items to select screens or options.

NOTE: Touch  (Home) to return to the Home screen.

Paper basics
The printer is designed to work well with most types of office paper. It is best to test a variety of print paper 
types before buying large quantities. Use HP paper for optimum print quality. Visit the HP website at 
www.hp.com for more information about HP paper.

HP recommends plain papers with the ColorLok logo for printing everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of 
reliability and print quality, and produce documents with crisp, vivid color, bolder blacks, 
and that dry faster than ordinary plain papers. Look for papers with the ColorLok logo in 
a variety of weights and sizes from major paper manufacturers.

This section contains the following topics:

● Recommended papers for printing

● Order HP paper supplies

● Tips for selecting and using paper

Recommended papers for printing
If you want the best print quality, HP recommends using HP papers that are specifically designed for the type 
of project you are printing.

Depending on your country/region, some of these papers might not be available.
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Photo printing

● HP Premium Plus Photo Paper

HP Premium Plus Photo Paper is HP’s highest-quality photo paper for your best photos. With HP 
Premium Plus Photo Paper, you can print beautiful photos that are instant-dry so you can share them 
right off the printer. It is available in several sizes, including A4, 8.5 x 11 inches, 4 x 6 inches (10 x 15 
cm), 5 x 7 inches (13 x 18 cm), and 11 x 17 inches (A3), and in two finishes - glossy or soft gloss (semi-
gloss). Ideal for framing, displaying, or gifting your best photos and special photo projects. HP Premium 
Plus Photo Paper delivers exceptional results with professional quality and durability.

● HP Advanced Photo Paper

This thick photo paper features an instant-dry finish for easy handling without smudging. It resists 
water, smears, fingerprints, and humidity. Your prints have a look and feel comparable to a store-
processed photo. It is available in several sizes, including A4, 8.5 x 11 inches, 10 x 15 cm (4 x 6 inches), 
13 x 18 cm (5 x 7 inches), and two finishes – glossy or soft-gloss (satin matte). It is acid-free for longer 
lasting documents.

● HP Everyday Photo Paper

Print colorful, everyday snapshots at a low cost, using paper designed for casual photo printing. This 
affordable photo paper dries quickly for easy handling. Get sharp, crisp images when you use this paper 
with any inkjet printer. It is available in glossy finish in several sizes, including A4, 8.5 x 11 inches, and 
10 x 15 cm (4 x 6 inches). It is acid-free for longer lasting documents.

● HP Photo Value Packs

HP Photo Value Packs conveniently package original HP ink cartridges and HP Advanced Photo Paper to 
save you time and take the guesswork out of printing affordable, lab-quality photos with your HP 
printer. Original HP inks and HP Advanced Photo Paper have been designed to work together so your 
photos are long lasting and vivid, print after print. Great for printing out an entire vacation's worth of 
photos or multiple prints to share.

Business documents

● HP Premium Presentation Paper 120g Matte

This paper is a heavy two-sided matte paper perfect for presentation, proposals, reports, and 
newsletters. It is heavyweight for an impressive look and feel.

● HP Brochure Paper 180g Glossy or HP Professional Paper 180 Glossy

These papers are glossy-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.

● HP Brochure Paper 180g Matte or HP Professional Paper 180 Matt

These papers are matte-coated on both sides for two-sided use. They are the perfect choice for near-
photographic reproductions and business graphics for report covers, special presentations, brochures, 
mailers, and calendars.
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Everyday printing

All the papers listed for everyday printing feature ColorLok Technology for less smearing, bolder blacks, and 
vivid colors.

● HP Bright White Inkjet Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp text. It is opaque enough for two-
sided color usage with no show-through, which makes it ideal for newsletters, reports, and flyers.

● HP Printing Paper

HP Printing Paper is a high-quality multifunction paper. It produces documents that look and feel more 
substantial than documents printed on standard multipurpose or copy paper. It is acid-free for longer 
lasting documents.

● HP Office Paper

HP Office Paper is a high-quality multifunction paper. It is suitable for copies, drafts, memos, and other 
everyday documents. It is acid-free for longer lasting documents.

● HP Office Recycled Paper

HP Office Recycled Paper is a high-quality multifunction paper made with 30% recycled fiber.

Order HP paper supplies
The printer is designed to work well with most types of office paper. Use HP paper for optimum print quality.

To order HP papers and other supplies, go to www.hp.com . At this time, some portions of the HP website are 
available in English only.

HP recommends plain papers with the ColorLok logo for printing and copying of everyday documents. All 
papers with the ColorLok logo are independently tested to meet high standards of reliability and print quality, 
and produce documents with crisp, vivid color, bolder blacks and dry faster than ordinary plain papers. Look 
for papers with the ColorLok logo in a variety of weights and sizes from major paper manufacturers.

Tips for selecting and using paper
For the best results, observe the following guidelines.

● Load only one type of paper at a time into a tray or document feeder.

● When loading the tray and document feeder, make sure the paper is loaded correctly.

● Do not overload the tray or document feeder.

● To prevent jams, poor print quality, and other printing problems, avoid loading the following paper in the 
tray or document feeder:

— Multipart forms

— Media that is damaged, curled, or wrinkled

— Media with cutouts or perforations

— Media that is heavily textured, embossed, or does not accept ink well

— Media that is too lightweight or stretches easily

— Media that contains staples or clips

For more information on loading paper, see Load paper or Load an original in the document feeder.
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Load paper
To load standard paper

1. Lift the output tray.

2. Pull out the input tray to extend it.

NOTE: To load legal-size paper, slide the grey button (on the front left of the input tray) to the right, 
and lower the front of the tray.

3. Slide the paper-width guides out as far as possible.
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4. Insert the paper print-side down in the center of the tray.

Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of the input 
tray, and does not exceed the stack height marking on the side of the tray.

NOTE: Do not load paper while the printer is printing.

5. Slide the paper-width guides in the tray until they touch the edge of the stack of paper, and then close 
the tray.
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6. A message appears on the control panel display prompting you to change the paper setting if you have 
changed the media type, or retain the setting if you have replaced what was previously loaded.

7. Pull out the output tray extension.

To load an envelope

1. Lift the output tray.

2. Pull out the input tray to extend it.
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3. Insert the envelopes with the side you want to print on down, and load according to the graphic.

Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of the input 
tray, and does not exceed the stack height marking on the side of the tray.

NOTE: Do not load envelopes while the printer is printing.

4. Slide the paper-width guides in the tray until they touch the edge of the stack of envelopes, and then 
reinsert the tray.

5. A message appears on the control panel display prompting you to change the paper setting if you have 
changed the media type, or retain the setting if you have replaced what was previously loaded.

6. Pull out the output tray extension.
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To load cards and photo paper

1. Lift the output tray.

2. Pull out the input tray to extend it.

3. Insert the paper print-side down in the center of the tray.

Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of the input 
tray, and does not exceed the stack height marking on the side of the tray.

NOTE: Do not load paper while the printer is printing.
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4. Slide the paper-width guides in the tray until they touch the edge of the stack of paper, and then close 
the tray.

5. A message appears on the control panel display prompting you to change the paper setting if you have 
changed the media type, or retain the setting if you have replaced what was previously loaded.

6. Pull out the output tray extension.

Load an original on the scanner glass
You can copy, scan, or fax originals by loading them on the scanner glass.

NOTE: Many of the special features do not work correctly if the scanner glass and lid backing are not clean. 
For more information, see Maintain the printer.

NOTE: Remove all originals from the document feeder tray before lifting the lid on the printer.

To load an original on the scanner glass

1. Lift the scanner lid.
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2. Load your original print-side down as shown in the following illustration.

TIP: For more help on loading an original, refer to the engraved guides along the edge of the scanner 
glass.

3. Close the lid.

Load an original in the document feeder
You can copy, scan, or fax a document by placing it in the document feeder.

The document feeder tray holds a maximum of 35 sheets of plain A4-, Letter-, or legal-size paper.

CAUTION: Do not load photos in the document feeder; this might cause damage to your photos. Use only 
paper that is supported by the document feeder.

For more information, see Tips for selecting and using paper.

NOTE: Some features, such as the Fit to Page copy feature, do not work when you load your originals in the 
document feeder. For those features to work, load your originals on the scanner glass.

To load an original in the document feeder

1. Load your original print-side up into the document feeder.

a. If you are loading an original printed in portrait orientation, place the pages so that the top edge of 
the document goes in first. If you are loading an original printed in landscape orientation, place the 
pages so that the left edge of the document goes in first.

b. Slide the paper into the document feeder until you hear a tone or see a message on the printer 
control panel display indicating that the loaded pages were detected.

TIP: For more help on loading originals in the document feeder, refer to the diagram engraved in the 
document feeder tray.
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2. Slide the paper-width guides inward until they stop at the left and right edges of the paper.

Insert a USB flash drive
You can insert a USB flash drive into the port on the front of the printer. You can transfer files from the USB 
flash drive to your computer or scan files to the USB flash drive from the printer.

CAUTION: Do not remove the flash drive from the printer USB port while it is being accessed by the printer. 
This can damage the files on the USB flash drive. You can safely remove a USB flash drive only when the USB 
port light is not blinking.

The printer does not support encrypted USB flash drives.

Update the printer
HP is always working to improve the performance of its printers and bring you the latest features.

By default, if the printer is connected to a network and Web Services has been enabled, the printer 
automatically checks for updates.

To update the printer using the printer control panel

1. From the printer control panel display, touch Setup .

2. Touch Printer Maintenance .

3. Touch Update the Printer .
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To enable the printer to automatically check for updates

NOTE: The default setting of Auto Update is On .

1. From the printer control panel display, touch  (HP ePrint).

2. Touch OK .

3. Touch Settings , and then touch Update the Printer .

4. Touch Auto Update and then touch On .

To update the printer using the embedded web server

1. Open the EWS.

For more information, see Embedded web server.

2. Click the Tools tab.

3. In the Printer Updates section, click Firmware Updates, and then follow the on-screen instructions.

NOTE: If a printer update is available, the printer downloads and installs the update, and then restarts. 

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-screen 
instructions to set up a proxy server. If you do not have the details, contact your network administrator or the 
person who set up the network.

Open the HP printer software (Windows)
After installing the HP printer software, depending on your operating system, do one of the following:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the printer 
name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then select 
the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

Turn the printer off
Turn the printer off by pressing  (the Power button) located on the front left side of the printer. The power 
light flashes while the printer shuts down. Wait until the power light turns off before unplugging the power 
cord or turning off a power strip.

CAUTION: If you improperly turn the printer off, the print carriage might not return to the correct position, 
causing problems with the ink cartridges and print quality.

CAUTION: Never turn off the printer when ink cartridges are missing. HP recommends that you replace any 
missing cartridges as soon as possible to avoid print quality issues, possible extra ink usage from the 
remaining ink cartridges, or damage to the ink system.
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3 Print

Most print settings are automatically handled by the software application. Change the settings manually only 
when you want to change print quality, print on specific types of paper, or use special features.

For more information about selecting the best print paper for your documents, see Paper basics.

TIP: This printer includes HP ePrint, a free service from HP that allows you to print documents on your HP 
ePrint-enabled printer anytime, from any location, without any additional software or printer drivers. For 
more information, see HP ePrint .

TIP: You can use this printer to print documents and photos on your mobile device (such as a smartphone or 
tablet). For more information, visit the HP Mobile Printing website ( www.hp.com/go/mobileprinting ). (At this 
time, this website might not be available in all languages.)

● Print documents

● Print brochures

● Print on envelopes

● Print photos

● Print on special and custom-size paper

● Print on both sides (duplexing)

● Print using the maximum dpi

● Tips for print success

● Print with AirPrint™

Print documents
To print documents (Windows)

1. Load paper in the tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. Select the appropriate options.
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● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, and then select the appropriate print quality in the Quality Settings area.

● Click the Advanced button, in the Paper/Output area, select the appropriate paper size from the 
Paper Size drop-down list.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the 
paper size on the printer control panel to match.

For more printing options, see Tips for print success.

6. Click OK to close the Properties dialog box.

7. Click Print or OK to begin printing.

To print documents (OS X)

1. Load paper in the tray. For more information, see Load paper.

2. From the File menu in your software, choose Print.

3. Make sure your printer is selected.

4. Specify the page properties.

If you do not see options on the Print dialog, click Show Details.

NOTE: The following options are available for your printer. Locations for the options can vary from one 
application to another.

● Choose the paper size.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the 
paper size on the printer control panel to match.

● Select the orientation.

● Enter the scaling percentage.

5. Click Print.

Print brochures
To print brochures (Windows)

1. Load paper in the tray. For more information, see Load paper.

2. On the File menu in your software application, click Print .

3. Make sure the printer you want to use is selected.

4. To change settings, click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties , Options , Printer 
Setup , Printer , or Preferences .

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. Select the appropriate options.

ENWW Print brochures 21



● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, and then select the appropriate print quality in the Quality Settings area.

● Click the Advanced button, in the Paper/Output area, select the appropriate paper size from the 
Paper Size drop-down list.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the 
paper size on the printer control panel to match.

For more printing options, see Tips for print success.

6. Click OK .

7. Click Print or OK to begin printing.

To print brochures (OS X)

1. Load paper in the tray. For more information, see Load paper.

2. From the File menu in your software application, click Print .

3. Make sure your printer is selected.

If you do not see options on the Print dialog, click Show Details.

4. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you are done 
selecting the paper size, click OK to close Page Setup and return to the Print dialog.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the paper 
size on the printer control panel to match.

5. Click Paper Type/Quality from the pop-up menu, and then select the following settings:

● Paper Type: The appropriate brochure paper type

● Quality: Normal or Best

6. Select any other print settings that you want, and then click Print to begin printing.

Print on envelopes
Avoid envelopes with the following characteristics:

● Very slick finish

● Self-stick adhesives, clasps, or windows

● Thick, irregular, or curled edges

● Areas that are wrinkled, torn, or otherwise damaged

Make sure the folds of envelopes you load in the printer are sharply creased.

NOTE: For more information about printing on envelopes, see the documentation available with the 
software program you are using.
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To print envelopes (Windows)

1. Load envelopes in the tray. For more information, see Load paper.

2. On the File menu in your software, click Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, and then select the appropriate print quality in the Quality Settings area.

● Click the Advanced button, in the Paper/Output area, select the appropriate paper size from the 
Paper Size drop-down list.

NOTE: If you change the Paper Size, ensure that you load the correct paper into the printer, and 
set the paper size on the printer control panel to match.

For more printing options, see Tips for print success.

6. Click OK, and then click Print or OK in the Print dialog box.

To print envelopes (OS X)

1. Load envelopes print-side down in the tray. For more information, see Load paper.

2. From the File menu in your software, choose Print.

3. Make sure your printer is selected.

4. Set the print options.

If you do not see options on the Print dialog, click Show Details.

NOTE: The following options are available for your printer. Locations for the options can vary from one 
application to another.

a. Select the appropriate envelope size from the Paper Size pop-up menu.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the 
paper size on the printer control panel to match.

b. From the pop-up menu, choose Paper Type/Quality, and verify the paper type setting is set to 
Plain Paper.

5. Click Print.

Print photos
Do not leave unused photo paper in the input tray. The paper might start to curl, which could impair the 
quality of your printout. Photo paper should be flat before printing.
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TIP: You can use this printer to print documents and photos on your mobile device (such as a smartphone or 
tablet). For more information, visit the HP Mobile Printing website ( www.hp.com/go/mobileprinting ). (At this 
time, this website might not be available in all languages.)

To print a photo from the computer (Windows)

1. Load paper in the tray. For more information, see Load paper.

2. From your software, select Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

5. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, and then select the appropriate print quality in the Quality Settings area.

● Click the Advanced button, in the Paper/Output area, select the appropriate paper size from the 
Paper Size drop-down list.

NOTE: If you change the Paper Size, ensure that you have loaded the correct paper and set the 
paper size on the printer control panel to match.

For more printing options, see Tips for print success.

NOTE:  For maximum dpi resolution, go to Paper/Quality tab, select Photo Paper from the Media 
drop-down list, and then click the Advanced button and select Yes from the Print in Max DPI drop-down 
list. If you want to print max DPI in grayscale, select High Quality Grayscale from the Print in Grayscale 
drop-down list. 

6. Click OK to return to the Properties dialog box.

7. Click OK, and then click Print or OK in the Print dialog box.

NOTE:  After the printing is finished, remove unused photo paper from the input tray. Store the photo paper 
so it does not start to curl, which could reduce the quality of your printout. 

To print a photo from the computer (OS X)

1. Load paper in the tray. For more information, see Load paper.

2. From the File menu in your software, choose Print.

3. Make sure your printer is selected.

4. Set the print options.

If you do not see options on the Print dialog, click Show Details.

NOTE: The following options are available for your printer. Locations for the options can vary from one 
application to another.

a. Choose the appropriate paper size in the Paper Size pop-up menu.
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NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the 
paper size on the printer control panel to match.

b. Select an Orientation.

c. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

● Paper Type: The appropriate photo paper type

● Quality: Best or Maximum dpi

● Click the Color Options disclosure triangle, and then choose the appropriate Photo Fix 
option.

— Off: applies no changes to the image.

— Basic: automatically focuses the image; moderately adjusts image sharpness.

5. Select any other print settings you want, and then click Print.

To print photos from a USB flash drive

You can connect a USB flash drive (such as a keychain drive) to the USB port on the front of the printer.

For more information about using memory devices, see Insert a USB flash drive.

CAUTION: Do not remove the flash drive from the printer USB port while it is being accessed by the printer. 
This can damage the files on the USB flash drive. You can safely remove a USB flash drive only when the USB 
port light is not blinking.

1. Insert a USB flash drive into the front USB port.

2. From the control panel display, touch Print Photos.

3. From the control panel display, touch View and Print to display photos.

4. On the printer display, select a photo that you want to print and touch Continue.

5. Scroll up or down to specify the number of photos to print.

6. Touch  (Edit) to select options to edit the selected photos. You can rotate, crop a photo, or turn Photo 
Fix or Red Eye Removal on and off.

7. Touch Done and touch Continue to preview the selected photo. If you wish to adjust layout or paper 
type, touch  (Settings), and then touch your selection. You can also save any new settings as defaults.

8. Touch Print to begin printing.

Print on special and custom-size paper
If your application supports custom-size paper, set the size in the application before printing the document. If 
not, set the size in the printer driver. You might need to reformat existing documents to print them correctly 
on custom-size paper.

To set up custom sizes (Windows)

1. Depending on your operating system, do one of the following:

ENWW Print on special and custom-size paper 25



● Windows 8.1 and Windows 8: Point to or tap the upper-right corner of the screen to open the 
Charms bar, click the Settings icon, click or tap Control Panel, and then click or tap View devices 
and printers. Click or tap the printer name, and click or tap Print server properties.

● Windows 7: From the Windows Start menu, click Devices and Printers. Select the printer name, 
and select Print server properties.

● Windows Vista: From the Windows Start menu, click Control Panel, and then click Printers. Right-
click an empty area in the Printers window, and select Server Properties.

● Windows XP: From the Windows Start menu, click Control Panel, and then click Printers and 
Faxes. From the File menu, click Server Properties.

2. Select the Create a new form check box.

3. Enter the name of the custom size paper.

4. Enter the dimensions of the custom size in the Form description (measurements) section.

5. Click Save Form, and then click Close.

To print on special or custom-size paper (Windows)

NOTE: Before you can print on custom-size paper, you must set up the custom size in the Print Server 
Properties.

1. Load the appropriate paper in the tray. For more information, see Load paper.

2. From the File menu in your software application, click Print.

3. Make sure your printer is selected.

4. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

5. On the Layout tab or Paper/Quality tab, click the Advanced button.

6. In the Paper/Output area, select the custom size from the Paper Size drop-down list.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the paper 
size on the printer control panel to match.

7. Select any other print settings that you want, and then click OK.

8. Click Print or OK to begin printing.

To set up custom sizes (OS X)

1. Depending on your operating system, do one of the following:
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● From the File menu in your software application, click Page Setup, and then make sure the printer 
you want to use is selected in the Format For pop-up menu.

● From the File menu in your software application, click Print, and then make sure the printer you 
want to use is selected.

2. Select Manage Custom Sizes in the Paper Size pop-up menu.

NOTE: If you do not see these options in the Print dialog, click the disclosure triangle next to the 
Printer pop-up menu or click Show Details.

3. Click the + on the left side of the screen, double-click Untitled, and type a name for the new custom 
size.

4. In the Width and Height boxes, type the dimensions, and then set the margins, if you want to customize 
them.

5. Click OK.

To print on special or custom-size paper (OS X)

Before you can print on custom-size paper, you must set up the custom size in the the HP software.

1. Load the appropriate paper in the tray. For more information, see Load paper.

2. From the File menu in your software application, click Print.

3. Make sure your printer is selected.

If you do not see options on the Print dialog, click Show Details.

4. Select a paper size from the pop-up menu.

If the Paper Size pop-up menu is not in the Print dialog, click the Page Setup button. When you are done 
selecting the paper size, click OK to close Page Setup and return to the Print dialog.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the paper 
size on the printer control panel to match.

5. Click Paper Handling from the pop-up menu.

6. Under Destination Paper Size, click Scale to fit paper size.

7. Select any other print settings that you want, and then click Print to begin printing.

NOTE: Software and system requirements can be found in the Readme file, which is available on the HP 
printer software CD provided with your printer.

Print on both sides (duplexing)
You can print on both sides of a sheet of paper automatically by using the automatic two-sided printing 
mechanism (duplexer).

To print on both sides of the page (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.
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3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

4. Select the appropriate options.

● On the Layout tab, select Portrait or Landscape orientation, and select Flip on Long Edge or Flip 
on Short Edge from the Print on Both Sides drop-down list.

● On the Paper/Quality tab, select the appropriate paper type from the Media drop-down list in the 
Tray Selection area, and then select the appropriate print quality in the Quality Settings area.

● Click the Advanced button, in the Paper/Output area, select the appropriate paper size from the 
Paper Size drop-down list.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the 
paper size on the printer control panel to match.

For more printing options, see Tips for print success.

5. Click OK to print.

To print on both sides of the paper (OS X)

1. From the File menu in your software, choose Print.

2. In the Print dialog, choose Layout from the pop-up menu.

3. Choose the type of binding you want for your two-sided pages, and then click Print.

Print using the maximum dpi
Use the maximum dots per inch (dpi) mode to print high-quality, sharp images on photo paper.

Printing in maximum dpi takes longer than printing with other settings and requires a large amount of 
memory.

To print in maximum dpi mode (Windows)

1. From your software, select Print.

2. Make sure your printer is selected.

3. Click the button that opens the Properties dialog box.

Depending on your software application, this button might be called Properties, Options, Printer Setup, 
Printer Properties, Printer, or Preferences.

NOTE: To set print settings for all print jobs, make the changes in the HP software provided with the 
printer. For more information on the HP software, see Printer management tools.

4. Click the Paper/Quality tab.

5. From the Media drop-down list, select an appropriate paper type.

6. Click the Advanced button.

7. In the Printer Features area, select Yes from the Print in Max DPI drop-down list.
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8. Select the appropriate paper size from the Paper Size drop-down list.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the paper 
size on the printer control panel to match.

9. Click OK to close the advanced options.

10. Confirm Orientation on the Layout tab, and then click OK to print.

To print using maximum dpi (OS X)

1. From the File menu in your software, choose Print.

2. Make sure your printer is selected.

3. Set the print options.

If you do not see options on the Print dialog, click Show Details.

NOTE: The following options are available for your printer. Locations for the options can vary from one 
application to another.

a. Choose the appropriate paper size in the Paper Size pop-up menu.

NOTE: If you change the Paper Size ensure that you have loaded the correct paper and set the 
paper size on the printer control panel to match.

b. From the pop-up menu, choose Paper Type/Quality, and then choose the following settings:

● Paper Type: The appropriate paper type

● Quality: Maximum dpi

4. Select any other print settings that you want, and then click Print.

Tips for print success
Software settings selected in the print driver only apply to printing, they do not apply to copying or scanning.

You can print your document on both sides of the paper. For more information, see Print on both sides 
(duplexing).

Ink tips

● If the print quality is not acceptable, see Solve printing problems for more information.

● Use Original HP ink cartridges.

Original HP ink cartridges are designed and tested with HP printers and papers to help you easily 
produce great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs 
required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased Original HP ink cartridges, go to www.hp.com/go/anticounterfeit.

● Install both the black and color cartridges correctly.

For more information, see Replace the ink cartridges.

● Check the estimated ink levels in the cartridges to make sure there is sufficient ink.

Ink level warnings and indicators provide estimates for planning purposes only.
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For more information, see Check the estimated ink levels.

NOTE: When you receive a low-ink warning message, consider having a replacement cartridge 
available to avoid possible printing delays. You do not need to replace the cartridges until print quality 
becomes unacceptable.

● Always turn off the printer with  (the Power button) to allow the printer to protect the nozzles.

Paper loading tips

For more information, also see Load paper.

● Ensure the paper is loaded in the tray properly, and matches the currently set paper size for the printer. 
Upon closing the tray you should be prompted to confirm or set the paper size. For more information, 
see Load paper.

● Load a stack of paper (not just one page). All the paper in the stack should be of the same size and type 
to avoid a paper jam.

● Load paper with the print-side down.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the guides do 
not bend the paper in the tray.

Printer settings tips (Windows)

● To change default print settings, click Print, Scan & Fax , and then click Set Preferences in the HP 
printer software.

Depending on your operating system, do one of the following to open the printer software:

— Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

— Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

— Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

● To select the number of pages to print per sheet, on the Layout tab of the printer driver, select the 
appropriate option from the Pages per Sheet drop-down list.

● If you want to change the page orientation, set it in your application interface.

● To view more printing settings, on the Layout or Paper/Quality tab of the printer driver, click the 
Advanced button to open the Advanced Options dialog box.

NOTE: The preview on the Layout tab cannot reflect what you select from the Pages per Sheet 
Layout, the Booklet, or the Page Borders drop-down lists.

— Print in Grayscale: Allows you to print a black and white document using the black ink only. Select 
Black Ink Only, and then click the OK button.

— Pages per Sheet Layout: Helps you specify the order of the pages if you print document in more 
than two pages per sheet.

— Borderless Printing: Select this feature to print photos without border. Not all paper types support 
this feature. You will see an alert icon beside the option if the selected paper type in the Media 
drop-down list does not support it.
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— Preserve Layout: This feature only works with the duplex printing. If the image is larger than the 
printable area, select this feature to scale the page content to be within the smaller margins so 
that extra pages are not created.

— HP Real Life Technologies: This feature smooths and sharpens images and graphics for improved 
print quality.

— Booklet: Allows you to print a multiple-page document as a booklet. It places two pages on each 
side of a sheet that can then be folded into a booklet in half size of the paper. Select a binding 
method from the drop-down list, and then click OK.

○ Booklet-LeftBinding: The binding side after folded into a booklet appears at the left side. 
Select the option if your reading habit is from left to right.

○ Booklet-RightBinding: The binding side after folded into a booklet appears at the right side. 
Select the option if your reading habit is from right to left.

— Page Borders: Allows you to add the borders to the pages if you print the document with two or 
more pages per sheet.

● You can use printing shortcut to save time setting printing preferences. A printing shortcut stores the 
setting values that are appropriate for a particular kind of job, so that you can set all the options with a 
single click. To use it, go to the Printing Shortcut tab, select one printing shortcut, and then click OK.

To add a new printing shortcut, after making settings on the Layout or Paper/Quality tab, click the 
Printing Shortcut tab, click Save As and enter a name, and then click OK.

To delete a printing shortcut, select it, and then click Delete.

NOTE: You cannot delete the default printing shortcuts.

Printer settings tips (OS X)

● On the Print dialog, use the Paper Size pop-up menu to select the size of paper loaded in the printer.

● On the Print dialog, choose the Paper Type/Quality pop-up menu and select the appropriate paper type 
and quality.

● To print a black and white document using only black ink, choose the Paper Type/Quality from the pop-
up menu. Then click the Color Options disclosure triangle and choose Grayscale from the Color pop-up 
menu and select Black Print Cartridge Only.

Notes

● Original HP ink cartridges are designed and tested with HP printers and papers to help you easily 
produce great results, time after time.

NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Product service or repairs 
required as a result of using a non-HP supply will not be covered under warranty.

If you believe you purchased Original HP ink cartridges, go to www.hp.com/go/anticounterfeit.

● Ink level warnings and indicators provide estimates for planning purposes only.

NOTE: When you receive a low-ink warning message, consider having a replacement cartridge 
available to avoid possible printing delays. You do not need to replace the cartridges until print quality 
becomes unacceptable.
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Print with AirPrint™
Printing using Apple’s AirPrint is supported for iOS 4.2 and Mac OS X 10.7 or later. Use AirPrint to print 
wirelessly to the printer from an iPad (iOS 4.2), iPhone (3GS or later), or iPod touch (third generation or later) 
in the following mobile applications:

● Mail

● Photos

● Safari

● Supported third-party applications, for example Evernote

To use AirPrint, ensure the following:

● The printer must be connected to the same network as your AirPrint enabled device. For more 
information about using AirPrint and about which HP products are compatible with AirPrint, go to 
www.hp.com/go/mobileprinting .

● Load paper that matches the paper settings of the printer (see Load paper for more information). 
Accurately setting the paper size for the paper that is loaded, enables a mobile device to know what 
paper size it is printing.
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4 Copy and scan

● Copy

● Scan

Copy
To copy documents

1. Make sure you have paper loaded in the main tray. For more information, see Load paper.

2. Place your original print-side down on the scanner glass or print-side up in the document feeder.

For more information, see Load an original on the scanner glass or Load an original in the document 
feeder.

3. From the printer control panel display, touch Copy .

4. Scroll up or down to select the number of copies.

TIP: To save these settings as defaults for future jobs, from the printer control panel display, touch 
Copy , touch  ( Copy Settings ), and then touch Save Current Settings.

5. Touch Black or Color to start the copy job.

Copy settings

You can customize copy jobs using the various settings available from the printer control panel.

In the Copy menu, touch  ( Copy Settings ) and change the desired settings.

● Two-Sided

● ID Card Copy

● Quality

● Lighter/Darker

● Resize

● Collate

● Margin Shift

● Enhancements

● Save Current Settings

● Restore Settings

Scan
You can scan documents, photos, and other paper types, and send them to a variety of destinations, such as a 
computer or an email recipient.

ENWW Copy 33



When scanning documents with the HP printer software, you can scan to a format that can be searched and 
edited.

When scanning a borderless original, use the scanner glass and not the document feeder.

NOTE: Some scan functions are only available after you have installed the HP printer software.

TIP: If you have problems scanning documents, see Solve scan problems.

● Scan to a computer

● Scan to a memory device

● Scan to Email

● Scan using Webscan

● Scanning documents as editable text

Scan to a computer
Before scanning to a computer, make sure you have already installed the HP recommended printer software. 
The printer and computer must be connected and turned on.

In addition, on Windows computers, the printer software must be running prior to scanning.

You can use the HP printer software to scan documents into editable text. For more information, see Scanning 
documents as editable text.

To enable the scan to a computer feature (Windows)

The scan to a computer feature is enabled by default from the factory. Follow these instructions if the feature 
has been disabled, and you wish to enable it again (either using an Ethernet cable or wireless connection).

1. Open the HP printer software.

2. Go to the Scan section.

3. Select Manage Scan to Computer.

4. Click Enable.

To enable the scan to a computer feature (OS X)

The scan to a computer feature is enabled by default from the factory. Follow these instructions if the feature 
has been disabled, and you wish to enable it again.

1. Open HP Utility.

2. Under Scan Settings, click Scan to Computer.

3. Ensure that Enable Scan to Computer is selected.

To scan an original from the printer control panel

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For more information, see Load an original on the scanner glass or Load an original in the document 
feeder.

2. Touch Scan , and then select Computer.

3. Touch a computer that you want to scan to.
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4. Choose the type of scan profile you want.

5. Touch Start Scan .

To scan an original from HP printer software (Windows)

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For more information, see Load an original on the scanner glass or Load an original in the document 
feeder.

2. Depending on your operating system, do one of the following:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. Click the Print, Scan & Fax icon, and then select Scan a Document or Photo.

4. Select the type of scan that you want from the shortcut menu and then click Scan.

NOTE: If Show Scan Preview is selected, you will be able to make adjustments to the scanned image in 
the preview screen.

5. Select Save if you want to keep the application open for another scan, or select Done to exit the 
application.

After the scan is saved, Windows Explorer will open the directory where the scan was saved.

To scan an original from HP printer software (OS X)

1. Open HP Scan.

HP Scan is located in the Applications/Hewlett-Packard folder at the top level of the hard disk.

2. Click Scan .

3. Choose the type of scan profile you want and follow the on-screen instructions.

Scan to a memory device
You can scan directly to a USB flash drive from the printer control panel without using a computer or the HP 
printer software provided with the printer.

NOTE: You can also use the HP printer software to scan documents into editable text. For more information, 
see Scanning documents as editable text.

To scan an original to a memory device from the printer control panel

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For more information, see Load an original on the scanner glass or Load an original in the document 
feeder.

2. Insert a USB flash drive. For more information, see Insert a USB flash drive.

3. Touch Scan , and then select Memory Device.
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4. Make changes to scan options, if needed.

5. Touch Start Scan .

Scan to Email
The Scan-to-Email App is an application that allows you to quickly scan and email photos or documents to the 
specified recipients directly from your HP e-All-in-One printer. You can set up your email addresses, log in to 
your accounts with the given PIN codes, and then scan and email your documents.

This section contains the following topics:

● Set up Scan to Email

● Use Scan to Email

● Change account settings

Set up Scan to Email

To set up Scan to Email

1. Enable Web Services on the printer. For more information, see Set up Web Services.

2. Touch Scan, and then touch Email.

3. On the Welcome screen, touch Continue.

4. Touch in the Email: box to enter your email address, and then touch Done.

5. Touch Continue.

6. A PIN will be sent to the email address you entered. Touch Continue.

7. Touch the PIN to enter your PIN and then touch Done.

8. Touch Store Email or Auto-login, depending upon how you want the printer to store your login 
information.

9. Select your scan type by touching Photo or Document.

10. For photos, select the scan settings, and touch Continue.

For documents, continue with the next step.

11. Veriify the email information, and touch Continue.

12. Touch Scan to Email.

13. Touch OK when the scan completes, and then touch Yes to send another email, or No to finish.

Use Scan to Email

To use Scan to Email

1. Load your original print-side down on the scanner glass or print-side up in the document feeder. For 
more information, see Load an original on the scanner glass or Load an original in the document feeder.

2. Touch Scan, and then touch Email.

3. On the control panel display, select the account that you want to use, and touch Continue.

NOTE: Select My account is not listed if you do not have an account. You will be prompted to enter 
your email address and receive a PIN.
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4. If prompted, enter the PIN.

5. Select your scan type by touching Photo or Document.

6. For photos, select the scan settings, and touch Continue.

For documents, continue with the next step.

7. To add or remove recipients, touch Modify Recipient(s), and when finished touch Done.

8. Verify the email information and touch Continue.

9. Touch Scan to Email.

10. Touch OK when the scan completes, and then touch Yes to send another email, or No to finish.

Change account settings

To change account settings

1. Touch Scan, and then touch Email.

2. On the control panel display, select the account that you want to change, and touch Modify.

3. Select which setting you want to modify, and follow the onscreen prompts..

● Auto-login

● Store Email

● Remove from list

● Change PIN

● Delete Account

Scan using Webscan
Webscan is a feature of the embedded web server that lets you scan photos and documents from your printer 
to your computer using a web browser.

This feature is available even if you did not install the printer software on your computer.

For more information, see Embedded web server.

NOTE: By default, Webscan is off. You can enable this feature from the EWS. 

If you are unable to open Webscan in the EWS, your network administrator might have turned it off. For more 
information, contact your network administrator or the person who set up your network.

To enable Webscan

1. Open the embedded web server. For more information, see Embedded web server.

2. Click the Settings tab.

3. In the Security section, click Administrator Settings.

4. Select Webscan to enable Webscan.

5. Click Apply and then click OK .

ENWW Scan 37



To scan using Webscan

Scanning using Webscan offers basic scan options. For additional scan options or functionality, scan from the 
HP printer software.

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For more information, see Load an original on the scanner glass or Load an original in the document 
feeder.

2. Open the embedded web server. For more information, see Embedded web server.

3. Click the Scan tab.

4. Click Webscan in the left pane, change any settings, and then click Start Scan .

TIP: To scan documents as editable text, you must install the HP software included with the printer. For 
more information, see Scanning documents as editable text.

Scanning documents as editable text
When scanning documents, you can use the HP software to scan documents into a format that you can 
search, copy, paste, and edit. This allows you to edit letters, newspaper clippings, and many other documents.

● Scan documents as editable text

● Guidelines for scanning documents as editable text

Scan documents as editable text

Use the following guidelines for scanning documents as editable text.

To scan documents as editable text (Windows)

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For more information, see Load an original on the scanner glass or Load an original in the document 
feeder.

2. Depending on your operating system, do one of the following:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, and then select the 
printer name.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, and then 
select the printer name.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder for the printer, and then select the icon with the printer's name.

3. Click the Print, Scan & Fax icon, and then select Scan a Document or Photo.

4. Select the type of editable text you want to use in the scan:

I want to... Follow these steps

Extract just the text, without any of the formatting of the 
original

Select the Save as Editable Text (OCR) shortcut from the list, 
and then select Text (.txt) from the File Type drop-down 
menu.
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Extract the text, as well as some of the formatting of the 
original

Select the Save as Editable Text (OCR) shortcut from the list, 
and then select Rich Text (.rtf) from the File Type drop-down 
menu.

Extract the text and make it searchable in PDF readers Select the Save as PDF shortcut from the list, and then select 
Searchable PDF (.pdf) from the File Type drop-down menu.

5. Click Scan and follow the on-screen instructions.

To scan documents as editable text (OS X)

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For more information, see Load an original on the scanner glass or Load an original in the document 
feeder.

2. Open HP Scan.

HP Scan is located in the Applications/Hewlett-Packard folder at the top level of the hard disk.

3. Click the Scan button. A dialog appears requesting confirmation of your scanning device and the scan 
settings preset.

4. Follow the on-screen instructions to complete the scan.

5. When all of the pages have been scanned, select Save from the File menu. The Save dialog appears.

6. Select the type of editable text.

I want to... Follow these steps

Extract just the text, without any of the formatting of the 
original

Select TXT from the Format pop-up menu.

Extract the text, as well as some of the formatting of the 
original

Select RTF from the Format pop-up menu.

Extract the text and make it searchable in PDF readers Select Searchable PDF from the Format pop-up menu.

7. Click Save.

Guidelines for scanning documents as editable text

To ensure that the software can convert your documents successfully, do the following:

● Make sure the scanner glass or document feeder window is clean.

When the printer scans the document, smudges or dust on the scanner glass or document feeder 
window can be scanned, as well, and can prevent the software from converting the document to 
editable text.

● Make sure the document is loaded correctly.

Make sure the original is properly loaded and that the document is not skewed. For more information, 
see Load an original on the scanner glass or Load an original in the document feeder.

● Make sure the text on the document is clear.

To successfully convert the document to editable text, the original must be clear and of high quality.

The following conditions can cause the software to not convert the document successfully:
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— The text on the original is faint or wrinkled.

— The text is too small.

— The structure of the document is too complex.

— The text is tightly spaced. For example, if the text that the software converts has missing or 
combined characters, "rn" might appear as "m."

— The text is on a colored background. Colored backgrounds can cause images in the foreground to 
blend too much.

● Choose the correct profile.

Be sure to select a shortcut or preset that allows scanning as editable text. These options use scan 
settings designed to maximize the quality of your OCR scan.

Windows: Use the Editable Text (OCR) or Save as PDF shortcuts.

OS X: Use the Documents preset.

● Save your file in the correct format.

If you want to extract just the text from the document, without any of the formatting of the original, 
select a plain text format, such as Text (.txt) or TXT.

If you want to extract the text, as well as some of the formatting of the original, select Rich Text Format, 
such as Rich Text (.rtf) or RTF, or searchable PDF format, such as Searchable PDF (.pdf) or Searchable 
PDF .
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5 Fax

You can use the printer to send and receive faxes, including color faxes. You can schedule faxes to be sent at 
a later time and set up phone book contacts to send faxes quickly and easily to frequently used numbers. 
From the printer control panel, you can also set a number of fax options, such as resolution and the contrast 
between lightness and darkness on the faxes you send.

NOTE: Before you begin faxing, make sure you have set up the printer correctly for faxing. You can verify the 
fax is set up correctly by running the fax setup test from the printer control panel.

Learn more about fax setup and test, click here to go online for more information.

● Send a fax

● Receive a fax

● Set up phone book contacts

● Change fax settings

● Fax and digital phone services

● Fax over Internet Protocol

● Use reports

Send a fax
You can send a fax in a variety of ways, depending on your situation or need.

● Send a standard fax

● Send a standard fax from the computer

● Send a fax from a phone

● Send a fax using monitor dialing

● Send a fax from memory

● Send a fax to multiple recipients

● Send a fax in Error Correction Mode

Send a standard fax
You can easily send a single- or multiple-page black-and-white or color fax by using the printer control panel.

NOTE: If you need printed confirmation that your faxes were successfully sent, fax confirmation must be 
enabled.
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To send a standard fax from the printer control panel

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For more information, see Load an original on the scanner glass or Load an original in the document 
feeder.

2. From the printer control panel display, touch Fax .

3. Touch Send Now.

4. Enter the fax number by using the keypad.

TIP: To add a pause in the fax number you are entering, touch * repeatedly, until a dash (-) appears on 
the display.

5. Touch Black or Color .

If the printer detects an original loaded in the document feeder, it sends the document to the number 
you entered.

TIP: If the recipient reports issues with the quality of the fax, try changing the resolution or contrast of 
your fax.

Send a standard fax from the computer
You can fax a document directly from your computer without printing it first.

To use this feature, make sure you have installed the HP printer software on your computer, the printer is 
connected to a working telephone line, and the fax function is set up and functioning correctly.

To send a standard fax from the computer (Windows)

1. Open the document on your computer that you want to fax.

2. On the File menu in your software application, click Print.

3. From the Name list, select the printer that has “fax” in the name.

4. To change settings (such as selecting to send the document as a black fax or a color fax), click the 
button that opens the Properties dialog box. Depending on your software application, this button might 
be called Properties, Options, Printer Setup, Printer, or Preferences.

5. After you have changed any settings, click OK.

6. Click Print or OK.

7. Enter the fax number and other information for the recipient, change any further settings for the fax, 
and then click Send Fax. The printer begins dialing the fax number and faxing the document.

To send a standard fax from the computer (OS X)

1. Open the document on your computer that you want to fax.

2. From the File menu in your software, click Print.

3. Select the printer that has “(Fax)” in the name.

4. Enter a fax number or a name from your Contacts that already has a fax number entry.

5. When you have finished filling out the fax information, click Fax.
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Send a fax from a phone
You can send a fax using your telephone extension. This allows you to talk with the intended recipient before 
sending the fax.

To send a fax from an extension phone

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For more information, see Load an original on the scanner glass or Load an original in the document 
feeder.

2. Dial the number by using the keypad on the phone that is connected to the printer.

If the recipient answers the telephone, inform the recipient that they should receive the fax on their fax 
machine after they hear fax tones. If a fax machine answers the call, you will hear fax tones from the 
receiving fax machine.

3. From the printer control panel display, touch Fax .

4. Touch Send and Receive.

5. Touch Send Fax .

6. If the original is loaded on the scanner glass, touch Use Glass.

7. When you are ready to send the fax, touch Black or Color .

NOTE: If prompted, select Send Fax .

The telephone is silent while the fax is transmitting. If you want to speak to the recipient after, remain 
on the line until the transmission is complete. If you were finished talking to the recipient, you can hang 
up the telephone as soon as the fax begins transmitting.

Send a fax using monitor dialing
When you send a fax using monitor dialing, you can hear the dial tones, telephone prompts, or other sounds 
through the speakers on the printer. This enables you to respond to prompts while dialing, as well as control 
the pace of your dialing.

TIP: If you are using a calling card and do not enter your PIN fast enough, the printer might start sending fax 
tones too soon and cause your PIN not to be recognized by the calling card service. If this is the case, you can 
create a phone book contact to store the PIN for your calling card. For more information, see Set up phone 
book contacts.

NOTE: Make sure the volume is turned on to hear a dial tone.

To send a fax using monitor dialing from the printer control panel

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For additional information, see Load an original on the scanner glass or Load an original in the 
document feeder.

2. From the printer control panel display, touch Fax .

3. Touch Send New Fax.

4. Touch Black or Color .
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5. When you hear the dial tone, enter the number by using the keypad on the printer control panel.

6. Follow any prompts that might occur.

TIP: If you are using a calling card to send a fax and you have your calling card PIN stored as a phone 
book contact, when prompted to enter your PIN, touch  (Phone book) to select the phone book contact 
where you have your PIN stored.

Your fax is sent when the receiving fax machine answers.

Send a fax from memory
You can scan a black-and-white fax into memory and then send the fax from memory. This feature is useful if 
the fax number you are trying to reach is busy or temporarily unavailable. The printer scans the originals into 
memory and sends them once it is able to connect to the receiving fax machine. After the printer scans the 
pages into memory, you can immediately remove the originals from the document feeder tray or scanner 
glass.

NOTE: You can only send a black-and-white fax from memory.

To send a fax from memory

1. Ensure that San and Fax Method is turned on.

a. From the printer control panel display, touch Setup .

b. Touch Fax Setup , and then touch Preferences .

c. Set Scan and Fax Method to on.

2. Load your original print-side up in the document feeder.

For additional information, see Load an original in the document feeder.

3. From the printer control panel display, touch Fax .

4. Touch Send Now.

5. If the original is loaded on the scanner glass, touch Use Glass.

NOTE: If you select Use Glass, the printer follows the method for sending a standard fax. For more 
information on sending a standard fax, see Send a standard fax

6. Enter the fax number by using the keypad, touch  (Phone book) to select a phone book contact or to 
select a previously dialed or received number.

7. Touch Black .

The printer scans the originals into memory and sends the fax when the receiving fax machine is 
available.

Send a fax to multiple recipients
You can send a fax to multiple recipients by creating a group phone book contact made up of two or more 
individual recipients.
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To send a fax to multiple recipients using group phone book

1. Load your original print-side down on the scanner glass or print-side up in the document feeder.

For additional information, see Load an original on the scanner glass or Load an original in the 
document feeder.

2. From the printer control panel display, touch Fax .

3. Touch Send Now.

4. If the original is loaded on the scanner glass, touch Use Glass.

5. Touch  (Phone book).

6. Touch  (Group Phone Book Contact).

7. Touch the name of the group phone book contact.

8. Touch Send Fax .

If the printer detects an original loaded in the document feeder, it sends the document to each number 
in the Group Phone Book contact.

TIP: If the recipient reports issues with the quality of the fax, try changing the resolution or contrast of 
your fax.

Send a fax in Error Correction Mode
Error Correction Mode (ECM) prevents loss of data due to poor phone lines by detecting errors that occur 
during transmission and automatically requesting retransmission of the erroneous portion. Phone charges 
are unaffected, or might even be reduced, on good phone lines. On poor phone lines, ECM increases sending 
time and phone charges, but sends the data much more reliably. The default setting is On . Turn ECM off only 
if it increases phone charges substantially, and if you can accept poorer quality in exchange for reduced 
charges.

If you turn ECM off:

● The quality and transmission speed of faxes you send and receive are affected.

● The Fax Speed is automatically set to Medium .

● You can no longer send or receive faxes in color.

To change the ECM setting from the control panel

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Preferences .

4. Touch Error Correction Mode to turn on or off.

5. Select On or Off .

Receive a fax
You can receive faxes automatically or manually. If you turn off the Auto Answer option, you must receive 
faxes manually. If you turn on the Auto Answer option (the default setting), the printer automatically answers 
incoming calls and receives faxes after the number of rings that are specified by the Rings to Answer setting. 
(The default Rings to Answer setting is five rings.)
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If you receive a Legal-size or larger fax and the printer is not currently set to use Legal-size paper, the printer 
reduces the fax so that it fits on the paper that is loaded. If you have disabled the Automatic Reduction 
feature, the printer prints the fax on two pages.

NOTE: If you are copying a document when a fax arrives, the fax is stored in the printer memory until the 
copying finishes.

● Receive a fax manually

● Set up backup fax

● Reprint received faxes from memory

● Forward faxes to another number

● Set automatic reduction for incoming faxes

● Block unwanted fax numbers

● Receive faxes using HP Digital Fax

Receive a fax manually
When you are on the phone, the person you are speaking with can send you a fax while you are still 
connected. You can pick up the handset to talk or listen for fax tones.

You can receive faxes manually from a phone that is directly connected to the printer (on the 2-EXT port).

To receive a fax manually

1. Make sure the printer is turned on and you have paper loaded in the main tray.

2. Remove any originals from the document feeder tray.

3. Set the Rings to Answer setting to a high number to allow you to answer the incoming call before the 
printer answers. Or, turn off the Auto Answer setting so that the printer does not automatically answer 
incoming calls.

4. If you are currently on the phone with the sender, instruct the sender to press Start on their fax 
machine.

5. When you hear fax tones from a sending fax machine, do the following:

a. From the printer control panel display, touch Fax , touch Send and Receive, and then touch Receive 
Now.

b. After the printer begins to receive the fax, you can hang up the phone or remain on the line. The 
phone line is silent during fax transmission.

Set up backup fax
Depending on your preference and security requirements, you can set up the printer to store all the faxes it 
receives, only the faxes it receives while the printer is in an error condition, or none of the faxes it receives.

To set backup fax from the printer control panel

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Preferences .

4. Touch Backup Fax Reception.

46 Chapter 5   Fax ENWW



5. Touch the required setting.

On The default setting. When Backup fax is On , the printer stores all received faxes in memory. This 
enables you to reprint up to 30 of the most recently printed faxes if they are still saved in memory.

NOTE: When printer memory is low, it overwrites the oldest, printed faxes as it receives new 
faxes. If the memory becomes full of unprinted faxes, the printer stops answering incoming fax 
calls.

NOTE: If you receive a fax that is too large, such as a very detailed color photo, it might not be 
stored in memory due to memory limitations.

On Error Only Causes the printer to store faxes in memory only if an error condition exists that prevents the 
printer from printing the faxes (for example, if the printer runs out of paper). The printer continues 
to store incoming faxes as long as there is memory available. (If the memory becomes full, the 
printer stops answering incoming fax calls.) When the error condition is resolved, the faxes stored 
in memory print automatically, and then they are deleted from memory.

Off Faxes are never stored in memory. For example, you might want to turn off Backup fax for security 
purposes. If an error condition occurs that prevents the printer from printing (for example, the 
printer runs out of paper), the printer stops answering incoming fax calls.

Reprint received faxes from memory
The received faxes that are not printed out are stored in memory.

NOTE: After the memory becomes full, the printer cannot receive the new fax until you print or delete the 
faxes from memory. You might also want to delete the faxes in memory for security or privacy purposes.

Depending on the sizes of the faxes in memory, you can reprint up to 30 of the most recently printed faxes, if 
they are still in memory. For example, you might need to reprint your faxes if you lost the copy of your last 
printout.

To reprint faxes in memory from the printer control panel

1. Make sure you have paper loaded in the main tray. For more information, see Load paper.

2. From the printer control panel display, touch Fax .

3. Touch Reprint.

The faxes are printed in the reverse order from which they were received with the most recently received 
fax printed first, and so on.

4. If you want to stop reprinting the faxes in memory, touch  (Cancel).

Forward faxes to another number
You can set up the printer to forward your faxes to another fax number. All faxes are forwarded in black and 
white, regardless of how they were originally sent.

HP recommends that you verify the number you are forwarding to is a working fax line. Send a test fax to 
make sure the fax machine is able to receive your forwarded faxes.

To forward faxes from the printer control panel

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Preferences .
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4. Touch Fax Forwarding.

5. Touch On (Print and Forward) to print and forward the fax, or select On (Forward) to forward the fax.

NOTE: If the printer is not able to forward the fax to the designated fax machine (for example, if it is 
not turned on), the printer prints the fax. If you set up the printer to print error reports for received 
faxes, it also prints an error report.

6. At the prompt, enter the number of the fax machine intended to receive the forwarded faxes, and then 
touch Done . Enter the required information for each of the following prompts: start date, start time, 
end date, and end time.

7. Fax forwarding is activated. Touch OK to confirm.

If the printer loses power when fax forwarding is set up, it saves the fax forwarding setting and phone 
number. When the power is restored to the printer, the fax forwarding setting is still On .

NOTE: You can cancel fax forwarding by selecting Off from the Fax Forwarding menu.

Set automatic reduction for incoming faxes
The Automatic Reduction setting determines what the printer does if it receives a fax that is too large for the 
loaded paper size. This setting is turned on by default, so the image of the incoming fax is reduced to fit on 
one page, if possible. If this feature is turned off, information that does not fit on the first page is printed on 
a second page. Automatic Reduction is useful when you receive a Legal-size fax and Letter-size paper is 
loaded in the main tray.

To set automatic reduction from the printer control panel

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Preferences .

4. Touch Automatic Reduction to turn on or off.

Block unwanted fax numbers
If you subscribe to a caller ID service through your phone provider, you can block specific fax numbers so the 
printer does not receive faxes received from those numbers. When an incoming fax call is received, the printer 
compares the number to the list of junk fax numbers to determine if the call should be blocked. If the number 
matches a number in the blocked fax numbers list, the fax is not received. (The maximum number of fax 
numbers you can block varies by model.)

NOTE: This feature is not supported in all countries/regions. If it is not supported in your country/region, 
Junk Fax Blocking does not appear in the Preferences menu.

NOTE: If no phone numbers are added in the Caller ID list, it is assumed that you are not subscribed to a 
Caller ID service.

You can block specific fax numbers by adding them to the junk fax list, unblock these numbers by removing 
them from the junk fax list, and print a list of blocked junk fax numbers.

To add a number to the junk fax list

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .
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3. Touch Preferences .

4. Touch Junk Fax Blocking .

5. Touch + (Plus Sign).

6. Do one of the following.

● To select a fax number to block from the call history list, touch  (Call history).

● Manually enter a fax number to block, and touch Add.

NOTE: Make sure you enter the fax number as it appears on the control panel display, and not the fax 
number that appears on the fax header of the received fax, as these numbers can be different.

To remove numbers from the junk fax list

If you no longer want to block a fax number, you can remove it from the junk fax list.

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Preferences .

4. Touch Junk Fax Blocking .

5. Touch the number you want to remove, and then touch Remove.

To print a junk fax list

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Reports .

3. Touch Print Fax Reports .

4. Touch Junk Fax Report.

5. Touch Print to begin printing.

Receive faxes using HP Digital Fax
You can use HP Digitial Fax to automatically receive faxes and save them directly to your computer. This saves 
paper and ink.

Received faxes are saved as TIFF (Tagged Image File Format) or PDF (Portable Document Format).

The files are named in the following method: XXXX_YYYYYYYY_ZZZZZZ.tif, where X is the sender's 
information, Y is the date, and Z is the time that the fax was received.

NOTE: Fax to Computer is available for receiving black-and-white faxes only. Color faxes will be printed.

● HP Digital Fax requirements

● Activate HP Digital Fax

● Modify HP Digital Fax settings
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HP Digital Fax requirements

● The destination folder of the computer must be available at all times. The destination computer must 
also be awake, faxes will not be saved if the computer is asleep or in hibernate mode.

● Paper must be loaded in the input tray. For more information, see Load paper.

Activate HP Digital Fax

To set up HP Digital Fax (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Print, Scan & Fax and click Digital Fax Setup Wizard .

3. Follow the on-screen instructions.

To set up HP Digital Fax (OS X)

1. Open HP Utility. For more information, see HP Utility (OS X).

2. Select the printer.

3. Click Digital Fax Archive in the Fax Settings section.

Modify HP Digital Fax settings

You can turn off HP Digital Fax and disable printing faxes from the printer control panel.

To modify settings from the printer control panel

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Preferences , and then touch HP Digital Fax.

4. Select the setting that you want to change. You can change the following settings:

● Fax Printing: Choose this option to print faxes as they are received. If you turn off printing, color 
faxes will still print.

● Turn Off HP Digital Fax: Choose this option to turn off HP Digital Fax.

NOTE: Use the HP printer software on your computer to turn on HP Digital Fax.

To modify settings from the HP printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Print, Scan & Fax and click Digital Fax Setup Wizard .

3. Follow the on-screen instructions.

To modify settings from the HP printer software (OS X)

1. Open HP Utility. For more information, see HP Utility (OS X).

2. Select the printer.

3. Click Digital Fax Archive in the Fax Settings section.
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Turn off HP Digital Fax

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Preferences and then touch HP Digital Fax.

4. Touch Turn Off HP Digital Fax.

5. Touch Yes.

Set up phone book contacts
You can set up frequently used fax numbers as phone book contacts. This lets you quickly dial those numbers 
using the printer control panel.

TIP: In addition to creating and managing phone book contacts from the printer control panel, you can also 
use tools available on your computer, such as the HP software included with the printer and the printer EWS. 
For more information, see Printer management tools.

● Set up and change phone book contacts

● Set up and change group phone book contacts

● Delete phone book contacts

● Print a list of phone book contacts

Set up and change phone book contacts
You can store fax numbers as phone book contacts.

To set up phone book contacts

1. From the printer control panel display, touch Fax .

2. Touch Send Now.

3. Touch  (Phone book).

4. Touch  (Phone Book Contact).

5. Touch  (Plus Sign) to add a contact.

6. Touch Name and then type the name of the phone book contact, and then touch Done .

7. Touch Fax Number and type the fax number for the phone book contact, and then touch Done .

NOTE: Be sure to include any pauses or other required numbers, such as an area code, an access code 
for numbers outside a PBX system (usually a 9 or 0), or a long-distance prefix.

8. Touch Add.

To change phone book contacts

1. From the printer control panel display, touch Fax .

2. Touch Send Now.

3. Touch  (Phone book).
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4. Touch  (Phone Book Contact).

5. Touch  (Edit) to edit a contact.

6. Touch the phone book contact that you want to edit.

7. Touch Name and then edit the name of the Phone Book contact, and then touch Done .

8. Touch Fax Number and edit the fax number for the phone book contact, and then touch Done .

NOTE: Be sure to include any pauses or other required numbers, such as an area code, an access code 
for numbers outside a PBX system (usually a 9 or 0), or a long-distance prefix.

9. Touch Done .

Set up and change group phone book contacts
You can store groups of fax numbers as group phone book contacts.

To set up group phone book contacts

NOTE:  Before you can create a group phone book contact, you must have already created at least one 
phone book contact.

1. From the printer control panel display, touch Fax .

2. Touch Send Now.

3. Touch  (Phone book).

4. Touch  (Group Phone Book Contact).

5. Touch  (Plus Sign) to add a group.

6. Touch Name and then type the name of the group, and then touch Done .

7. Touch Number of Members, select the phone book contacts you want to include in this group, and then 
touch Select.

8. Touch Create.

To change group phone book contacts

1. From the printer control panel display, touch Fax .

2. Touch Send Now.

3. Touch  (Phone book).

4. Touch  (Group Phone Book Contact).

5. Touch  (Edit) to edit a group.

6. Touch the group phone book contact that you want to edit.

7. Touch Name and then edit the name of the group phone book contact, and then touch Done .

8. Touch Number of Members.

9. Select the phone book contacts you want to delete from this group, or touch  (Plus Sign) to add a 
contact to the group.

10. Touch Done .
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Delete phone book contacts
You can delete phone book contacts or group phone book contacts.

1. From the printer control panel display, touch Fax .

2. Touch Send Now.

3. Touch  (Phone book).

4. Touch  (Phone Book Contact).

5. Touch  (Edit).

6. Touch the name of the phone book contact you want to delete.

7. Touch Delete.

8. Touch Yes to confirm.

Print a list of phone book contacts
You can print a list of your phone book contacts.

1. Load paper in the tray. For more information, see Load paper.

2. From the printer control panel, touch Setup .

3. Touch Fax Setup , and then touch Reports .

4. Touch Print Phone Book.

Change fax settings
After completing the steps in the getting started guide that came with the printer, use the following steps to 
change the initial settings or to configure other options for faxing.

● Configure the fax header

● Set the answer mode (Auto answer)

● Set the number of rings before answering

● Change the answer ring pattern for distinctive ring

● Set the dial type

● Set the redial options

● Set the fax speed

● Set the fax sound volume

Configure the fax header
The fax header prints your name and fax number on the top of every fax you send. HP recommends that you 
set up the fax header by using the HP software provided with the printer. You can also set up the fax header 
from the printer control panel, as described here.

NOTE: In some countries/regions, the fax header information is a legal requirement.
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To set or change the fax header

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Preferences .

3. Touch Fax Header.

4. Enter your personal or company name, and then touch Done .

5. Enter your fax number, and then touch Done .

Set the answer mode (Auto answer)
The answer mode determines whether the printer answers incoming calls.

● Turn on the Auto Answer setting if you want the printer to answer faxes automatically. The printer 
answers all incoming calls and faxes.

● Turn off the Auto Answer setting if you want to receive faxes manually. You must be available to 
respond in person to the incoming fax call or else the printer does not receive faxes.

To set the answer mode

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Preferences .

3. Touch Auto Answer to turn it on or off.

You may also access this feature by pressing  (the Fax Status button) on the Home screen.

Set the number of rings before answering
If you turn on the Auto Answer setting, you can specify how many rings occur before incoming calls are 
automatically answered.

The Rings to Answer setting is important if you have an answering machine on the same phone line as the 
printer, because you want the answering machine to answer the phone before the printer does. The number 
of rings to answer for the printer should be greater than the number of rings to answer for the answering 
machine.

For example, set your answering machine to a low number of rings and the printer to answer in the maximum 
number of rings. (The maximum number of rings varies by country/region.) In this setup, the answering 
machine answers the call and the printer monitors the line. If the printer detects fax tones, it receives the fax. 
If the call is a voice call, the answering machine records the incoming message.

To set the number of rings before answering

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Preferences .

3. Touch Rings to Answer .

4. Touch the number of rings.

5. Touch Done to accept the setting.
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Change the answer ring pattern for distinctive ring
Many phone companies offer a distinctive ring feature that allows you to have several phone numbers on one 
phone line. When you subscribe to this service, each number is assigned a different ring pattern. You can set 
up the printer to answer incoming calls that have a specific ring pattern.

If you connect the printer to a line with distinctive ring, have your telephone company assign one ring pattern 
to voice calls and another ring pattern to fax calls. HP recommends that you request double or triple rings for 
a fax number. When the printer detects the specified ring pattern, it answers the call and receives the fax.

TIP: You can also use the Ring Pattern Detection feature in the printer control panel to set distinctive ring. 
With this feature, the printer recognizes and records the ring pattern of an incoming call and, based on this 
call, automatically determines the distinctive ring pattern assigned by your telephone company to fax calls. 

If you do not have a distinctive ring service, use the default ring pattern, which is All Rings .

NOTE: The printer cannot receive faxes when the main phone number is off the hook.

To change the answer ring pattern for distinctive ring

1. Verify that the printer is set to answer fax calls automatically.

2. From the printer control panel display, touch Setup .

3. Touch Fax Setup , and then select Preferences .

4. Touch Distinctive Ring .

5. A message appears stating that this setting should not be changed unless you have multiple numbers 
on the same telephone line. Touch Yes to continue.

6. Do one of the following:

● Touch the ring pattern assigned by your telephone company to fax calls.

● Touch Ring Pattern Detection, and then follow the instructions on the printer control panel.

NOTE: If the Ring Pattern Detection feature cannot detect the ring pattern or if you cancel the feature 
before it finishes, the ring pattern is automatically set to the default, which is All Rings .

NOTE: If you are using a PBX phone system that has different ring patterns for internal and external 
calls, you must call the fax number from an external number. 

Set the dial type
Use this procedure to set tone-dialing or pulse-dialing mode. The factory-set default is Tone. Do not change 
the setting unless you know that your phone line cannot use tone dialing.

NOTE: The pulse-dialing option is not available in all countries/regions.

To set the dial type

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Preferences .

3. Touch Dial Type.

4. Touch to select Tone Dialing or Pulse Dialing.
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Set the redial options
If the printer was unable to send a fax because the receiving fax machine did not answer or was busy, the 
printer attempts to redial based on the settings for the redial options. Use the following procedure to turn the 
options on or off.

● Busy redial: If this option is turned on, the printer redials automatically if it receives a busy signal. The 
default is On .

● No answer redial: If this option is turned on, the printer redials automatically if the receiving fax 
machine does not answer. The default is Off .

● Connection problem redial: If this option is turned on, the printer redials automatically if there has been 
a problem connecting with the receiving fax machine. Connection problem redial works only for sending 
faxes from memory. The default is On .

To set the redial options

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Preferences .

3. Touch Auto Redial .

4. Touch Busy Redial , or No Answer Redial , or Connection Problem Redial , and then select the 
appropriate options.

Set the fax speed
You can set the fax speed used to communicate between your printer and other fax machines when sending 
and receiving faxes.

If you use one of the following, setting the fax speed to a slower speed might be required:

● An Internet phone service

● A PBX (private branch exchange) system

● Fax over Internet Protocol (FoIP)

● An integrated services digital network (ISDN) service

If you experience problems sending and receiving faxes, try using a slower Fax Speed . The following table 
provides the available fax speed settings.

Fax speed setting Fax speed

Fast v.34 (33600 baud)

Medium v.17 (14400 baud)

Slow v.29 (9600 baud)

To set the fax speed

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Preferences .

3. Touch Fax Speed .

4. Touch to select an option.
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Set the fax sound volume
You can change the volume of fax sounds.

To set the fax sound volume

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Preferences .

3. Touch Volume.

4. Touch to select Soft, Loud, or Off .

Fax and digital phone services
Many telephone companies provide their customers with digital phone services, such as the following:

● DSL: A Digital subscriber line (DSL) service through your telephone company. (DSL might be called ADSL 
in your country/region.)

● PBX: A private branch exchange (PBX) phone system.

● ISDN: An integrated services digital network (ISDN) system.

● FoIP: A low-cost phone service that allows you to send and receive faxes with your printer by using the 
Internet. This method is called Fax over Internet Protocol (FoIP).

For more information, see Fax over Internet Protocol.

HP printers are designed specifically for use with traditional analog phone services. If you are in a digital 
phone environment (such as DSL/ADSL, PBX, or ISDN), you might need to use digital-to-analog filters or 
converters when setting up the printer for faxing.

NOTE: HP does not guarantee that the printer will be compatible with all digital service lines or providers, in 
all digital environments, or with all digital-to-analog converters. It is always recommended that you discuss 
with the telephone company directly for the correct setup options based on their line services provided.

Fax over Internet Protocol
You might be able to subscribe to a low cost phone service that allows you to send and receive faxes with your 
printer by using the Internet. This method is called Fax over Internet Protocol (FoIP).

You probably use a FoIP service (provided by your telephone company) when you:

● Dial a special access code along with the fax number.

● Have an IP converter box that connects to the Internet and provides analog phone ports for the fax 
connection.

NOTE: You can only send and receive faxes by connecting a phone cord to the port labeled "1-LINE" on the 
printer. This means that your connection to the Internet must be done either through a converter box (which 
supplies regular analog phone jacks for fax connections) or your telephone company.

TIP: Support for traditional fax transmission over any Internet protocol telephone systems are often 
limited. If you experience problems faxing, try using a slower fax speed or disabling the fax error-correction 
mode (ECM). However, if you turn off ECM, you cannot send and receive color faxes.

For more information about changing the fax speed, see Set the fax speed. For more information about using 
ECM, see Send a fax in Error Correction Mode.
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If you have questions about Internet faxing, contact your Internet faxing services support department or your 
local service provider for further assistance.

Use reports
You can set up the printer to print error reports and confirmation reports automatically for each fax you send 
and receive. You can also manually print system reports as required; these reports provide useful system 
information about the printer.

By default, the printer is set to print a report only if there is a problem sending or receiving a fax. 
A confirmation message that indicates whether a fax was successfully sent appears briefly on the control 
panel display after each transaction.

NOTE: If the reports are not legible, you can check the estimated ink levels from the control panel or the HP 
software. For more information, see Check the estimated ink levels.

NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you receive a low-
ink alert, consider having a replacement cartridge available to avoid possible printing delays. You do not need 
to replace the ink cartridges until the print quality becomes unacceptable.

NOTE: Ensure that the printheads and ink cartridges are in good conditions and installed properly. For more 
information, see Work with ink cartridges.

This section contains the following topics:

● Print fax confirmation reports

● Print fax error reports

● Print and view the fax log

● Clear the fax log

● Print the details of the last fax transaction

● Print a Caller ID Report

● View the Call History

Print fax confirmation reports
You can print a confirmation report either when a fax is sent, or when any fax is sent or received. The default 
setting is On (Fax Send). When turned off, a confirmation message appears briefly on the control panel after 
each fax is sent or received.

NOTE: You can include an image of the first page of the fax on the Fax Sent Confirmation report if you select 
On (Fax Send) or On (Fax Send and Fax Receive) , and if you scan the fax to send from memory or use the 
Scan and Fax option.

To enable fax confirmation

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Reports and touch Fax Confirmation .

4. Touch to select one of the following options.
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Off Does not print a fax confirmation report when you send and receive faxes successfully. This is the 
default setting.

On (Fax Send) Prints a fax confirmation report for every fax you send.

On (Fax Receive) Prints a fax confirmation report for every fax you receive.

On (Fax Send and Fax 
Receive)

Prints a fax confirmation report for every fax you send and receive.

To include an image of the fax on the report

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Reports and touch Fax Confirmation .

4. Touch On (Fax Send) or On (Fax Send and Fax Receive) .

5. Touch Fax confirmation with image.

Print fax error reports
You can configure the printer so that it automatically prints a report when there is an error during 
transmission or reception.

To set the printer to print fax error reports automatically

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup .

3. Touch Reports and touch Fax Error Report.

4. Touch to select one of the following.

On (Fax Send and Fax 
Receive)

Prints whenever a fax error occurs.

Off Does not print any fax error reports.

On (Fax Send) Prints whenever a transmission error occurs. This is the default setting.

On (Fax Receive) Prints whenever a receiving error occurs.

Print and view the fax log
You can print a log of faxes that have been received and sent by the printer.

To print the fax log from the printer control panel

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Reports .

3. Touch Print Fax Reports .

4. Touch Print Last 30 Transactions .

5. Touch Print to begin printing.
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Clear the fax log
Clearing the fax log also deletes all faxes stored in memory.

To clear the fax log

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Tools.

3. Touch Clear Fax Log.

Print the details of the last fax transaction
The Last Fax Transaction report prints the details of the last fax transaction to occur. Details include the fax 
number, number of pages, and the fax status.

To print the Last Fax Transaction report

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Reports .

3. Touch Print Fax Reports .

4. Touch Last Transaction.

5. Touch Print to begin printing.

Print a Caller ID Report
You can print a list of Caller ID fax numbers.

To print a Caller ID History Report

1. From the printer control panel display, touch Setup .

2. Touch Fax Setup , and then touch Reports .

3. Touch Print Fax Reports .

4. Touch Caller ID Report.

5. Touch Print to begin printing.

View the Call History
You can view a list of all the calls placed from the printer.

NOTE: You cannot print the call history.

To view the call history

1. From the printer control panel display, touch Fax .

2. Touch Send New Fax.

3. Touch  (Phone book).

4. Touch  (Call history).
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6 Web Services

The printer offers innovative, web-enabled solutions that can help you quickly access the Internet, obtain 
documents, and print them faster and with less hassle—and all without using a computer.

NOTE:  To use these web features, the printer must be connected to the Internet (either using an Ethernet 
cable or wireless connection). You cannot use these web features if the printer is connected using a USB cable.

This section contains the following topics:

● What are Web Services?

● Set up Web Services

● Use Web Services

● Remove Web Services

What are Web Services?
HP ePrint

● HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled printer anytime, 
from any location. It's as simple as sending an email to the email address assigned to your printer when 
you enable Web Services on the printer. No special drivers or software are needed. If you can send an 
email, you can print from anywhere, using HP ePrint.

Once you have signed up for an account on HP Connected ( www.hpconnected.com ), you can sign in to 
view your HP ePrint job status, manage your HP ePrint printer queue, control who can use your printer's 
HP ePrint email address to print, and get help for HP ePrint.

HP Printables

● HP Printables allow you to easily locate and print preformatted web content, directly from your printer. 
You can also scan and store your documents digitally on the Web.

HP Printables provide a wide range of content, from store coupons to family activities, news, travel, 
sports, cooking, photos, and many more. You can even view and print your online images from popular 
photo sites.

Certain HP Printables also allow you to schedule the delivery of app content to your printer.

Preformatted content designed specifically for your printer means no cut-off text and pictures and no 
extra pages with only one line of text. On some printers, you can also choose paper and print quality 
settings on the print preview screen.

Set up Web Services
Before you set up Web Services, make sure your printer is connected to the Internet using either an Ethernet 
or wireless connection.

To set up Web Services, use one of the following methods.
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To set up Web Services using the printer control panel

1. From the printer control panel display, touch Setup .

2. Touch Web Services Setup .

3. Touch Accept to accept the Web Services terms of use and enable Web Services.

4. In the Auto Update screen, touch Yes to allow the printer to automatically check for and install product 
updates.

NOTE: If a printer update is available, the printer will download and install the update, and then 
restart. You will have to repeat the instructions from step 1 to set up HP ePrint.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-screen 
instructions to set up a proxy server. If you do not have the proxy details, contact your network 
administrator or the person who set up the network.

5. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.

To set up Web Services using the embedded web server

1. Open the EWS. For more information, see Embedded web server.

2. Click the Web Services tab.

3. In the Web Services Settings section, click Setup , click Continue, and follow the on-screen instructions 
to accept the terms of use.

4. If prompted, choose to allow the printer to check for and install printer updates.

NOTE: If a printer update is available, the printer downloads and installs the update, and then restarts. 
Repeat the instructions from step 1 to set up HP ePrint.

NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-screen 
instructions to set up a proxy server. If you do not have the proxy details, contact your network 
administrator or the person who set up the network.

5. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.

To set up Web Services using the HP printer software (Windows)

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. In the window that appears, double-click Print, Scan & Fax and then select Connect your printer to the 
web under Print. The printer's home page (embedded web server) opens.

3. Click the Web Services tab.

4. In the Web Services Settings section, click Setup , click Continue, and follow the on-screen instructions 
to accept the terms of use.

5. If prompted, choose to allow the printer to check for and install printer updates.

NOTE: If a printer update is available, the printer will download and install the update, and then 
restart. You will have to repeat the instructions from step 1 to set up HP ePrint.
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NOTE: If prompted for proxy settings and if your network uses proxy settings, follow the on-screen 
instructions to set up a proxy server. If you do not have the details, contact your network administrator 
or the person who set up the network.

6. When the printer is connected to the server, the printer prints an information page. Follow the 
instructions on the information page to finish the setup.

Use Web Services
The following section describes how to use and configure Web Services.

● HP ePrint 

● HP Printables

HP ePrint
To use HP ePrint, do the following:

● Be sure you have an Internet- and email-capable computer or mobile device.

● Enable Web Services on the printer. For more information, see Set up Web Services.

TIP: For more information about managing and configuring HP ePrint settings and to learn about the latest 
features, visit HP Connected at www.hpconnected.com .

To print documents using HP ePrint

1. On your computer or mobile device, open your email application.

2. Create a new email message, and then attach the file that you want to print.

3. Enter the printer's email address in the “To” line of the email message, and then select the option to 
send the email message.

NOTE: Do not enter any additional email addresses in either the "To" or "Cc" fields. The HP ePrint 
server does not accept print jobs if there are multiple email addresses.

To find the printer's email address

1. Make sure you have created an ePrint account.

To sign up for an account on HP Connected, visit www.hpconnected.com .

2. From the printer control panel display, touch  (HP ePrint).

To customize the email address, touch Print Info. The printer prints an information page that contains 
the printer code and instructions on how to customize the email address.

To turn off HP ePrint

1. From the printer control panel, touch  (HP ePrint), and then touch  (Web Services Settings).

2. Touch ePrint, and then touch Off .

NOTE: To remove all Web Services, see Remove Web Services.
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HP Printables
HP Printables allow you to easily locate and print preformatted web content, directly from your printer.

To use HP Printables

1. From the printer control panel, touch  (HP Printables).

2. Touch the HP Printables you want to use.

For more information about individual HP Printables, visit www.hpconnected.com .

To manage HP Printables

● You can manage your HP Printables with HP Connected. You can add, configure, or remove HP Printables, 
and set the order in which they appear on your printer control panel display.

Turn off HP Printables

1. From the printer control panel, touch  (HP ePrint), and then touch  (Web Services Settings).

2. Touch HP Printables, and then touch Off .

NOTE: To remove all Web Services, see Remove Web Services.

Remove Web Services
To remove Web Services, complete the following steps:

1. From the printer control panel display, touch  (HP ePrint), and then touch  (Web Services 
Settings).

2. Touch Remove Web Services.
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7 Work with ink cartridges

This section contains the following topics:

● Information on ink cartridges and the printhead

● Check the estimated ink levels

● Replace the ink cartridges

● Order ink cartridges

● Store printing supplies

● Anonymous usage information storage

● Ink cartridge warranty information

Information on ink cartridges and the printhead
The following tips help maintain HP ink cartridges and ensure consistent print quality.

● The instructions in this user guide are for replacing ink cartridges, and are not intended for first time 
installation. For the first time installation, follow the instructions in the setup poster provided with the 
printer.

● When you turn the printer off, always use the  (Power) button. This allows the printer to cap the 
printhead and protect it from damage. For more information, see Turn the printer off.

● Do not clean the printhead unnecessarily. This wastes ink and shortens the life of the cartridges.

● Handle ink cartridges carefully. Dropping, jarring, or rough handling during installation can cause 
temporary printing problems.

● If you are transporting the printer, do the following to prevent ink leaking from the printer or other 
damage from occurring to the printer:

— Make sure you turn off the printer by pressing the  (Power) button. Wait until all sounds of 
internal motion stop before unplugging the printer. For more information, see Turn the printer off.

— The printer must be transported sitting flat; it should not be placed on its side, back, front, or top.

CAUTION: HP recommends that you replace any missing cartridges as soon as possible to avoid print quality 
issues and possible extra ink usage or damage to the ink system. Never turn off the printer when ink 
cartridges are missing.

Check the estimated ink levels
You can check the estimated ink levels from the printer software or from the printer control panel. For 
information about using the printer software, see Printer management tools. You can also print the printer 
status report to view this information (see Printer status report).

To check the estimated ink levels from the printer control panel

▲ From the printer control panel  (Home) screen, touch  ( Ink Information ).
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NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you receive a low-
ink alert, consider having a replacement cartridge available to avoid possible printing delays. You do not have 
to replace the cartridges until the print quality becomes unacceptable.

NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge that has been used in 
another printer, the ink level indicator might be inaccurate or unavailable.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways, including in the 
initialization process, which prepares the printer and cartridges for printing, and in printhead servicing, which 
keeps print nozzles clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge after 
it is used. For more information, see www.hp.com/go/inkusage .

Replace the ink cartridges
If you do not already have replacement ink cartridges for the printer, see Order ink cartridges. Not all 
cartridges are available in all countries/regions.

CAUTION: HP recommends that you replace any missing cartridges as soon as possible to avoid print quality 
issues and possible extra ink usage or damage to the ink system. Never turn off the printer when ink 
cartridges are missing.

For information on recycling used ink supplies, see HP inkjet supplies recycling program.

To replace the ink cartridges

1. Make sure the printer is turned on.

2. Open the ink cartridge access door.

NOTE: Wait until the print carriage stops moving before proceeding.

3. Press the front of the ink cartridge to release it, and then remove it from the slot.
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4. Remove the new ink cartridge from its packaging.

5. Using the color-coded letters for help, slide the ink cartridge into the empty slot until it clicks securely 
into the slot.

Make sure that you insert the ink cartridge into the slot that has the same colored letter as the color you 
are installing.

6. Repeat steps 3 through 5 for each ink cartridge you are replacing.

7. Close the ink cartridge access door.

Order ink cartridges
To order ink cartridges, go to www.hp.com . (At this time, some portions of the HP website are available in 
English only.) Ordering cartridges online is not supported in all countries/regions. However, many countries 
have information on ordering by telephone, locating a local store and printing a shopping list. In addition, you 
can visit the www.hp.com/buy/supplies page to obtain information about purchasing HP products in your 
country.

Use only the replacement cartridges that have the same cartridge number as the ink cartridge you are 
replacing. You can find the cartridge number in the following places:
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● In the embedded web server, by clicking the Tools tab, and then, under Product Information clicking Ink 
Gauge. For more information, see Embedded web server.

● On the printer status report (see Printer status report).

● On the label of the ink cartridge you are replacing.

● On a sticker inside the printer. Open the ink cartridge access door to locate the sticker.

● In the printer software, click Shop, and then click Shop For Supplies Online.

NOTE: The Setup ink cartridge that comes with the printer is not available for separate purchase.

Store printing supplies
● Keep all ink cartridges in the original sealed packages until they are needed.

● Ink cartridges can be left in the printer for extended periods of time. However, to assure optimal ink 
cartridge health, be sure to turn off the printer properly. For more information, see Turn the printer off.

● Store ink cartridges at room temperature (15-35° C or 59-95° F).

Anonymous usage information storage
The HP cartridges used with this printer contain a memory chip that assists in the operation of the printer. In 
addition, this memory chip stores a limited set of anonymous information about the usage of the printer, 
which might include the following: the number of pages printed using the cartridge, the page coverage, 
frequency of printing, and the printing modes used.

This information helps HP design future printers to meet our customers' printing needs. The data collected 
from the cartridge memory chip does not contain information that can be used to identify a customer or user 
of the cartridge or their printer.

HP collects a sampling of the memory chips from cartridges returned to HP's free return and recycling 
program (HP Planet Partners: www.hp.com/recycle ). The memory chips from this sampling are read and 
studied in order to improve future HP printers. HP partners who assist in recycling this cartridge might have 
access to this data, as well.

Any third party possessing the cartridge might have access to the anonymous information on the memory 
chip. If you prefer to not allow access to this information, you can render the chip inoperable. However, after 
you render the memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can make this information inaccessible 
by turning off the memory chip's ability to collect the printer's usage information.

To disable the usage information function

1. From the printer control panel, touch Setup .

2. Select Preferences , and then touch Store Anonymous Usage Information.

3. Touch Off to disable the collection of usage information.

NOTE: To turn the usage information function on, restore the factory defaults. For more information about 
how to restore the defaults, see Restore defaults and settings.

NOTE: You can continue to use the cartridge in the HP printer if you turn off the memory chip's ability to 
collect the printer's usage information.
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Ink cartridge warranty information
The HP cartridge warranty is applicable when the product is used in its designated HP printing device. This 
warranty does not cover HP ink products that have been refilled, remanufactured, refurbished, misused, or 
tampered with.

During the warranty period the product is covered as long as the HP ink is not depleted and the end of 
warranty date has not been reached. The end of warranty date, in YYYY-MM format, may be found on the 
product as indicated:
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8 Network setup

Additional advanced settings are available from the printer's home page (embedded web server or EWS). For 
more information, see Embedded web server.

This section contains the following topics:

● Set up the printer for wireless communication

● Change network settings

● Use HP wireless direct

Set up the printer for wireless communication
● Before you begin

● Set up the printer on your wireless network

● Change the connection type

● Test the wireless connection

● Turn on or off the wireless capability of the printer

NOTE: If you encounter problems connecting the printer, see Unable to connect the printer wirelessly.

TIP: For more information about setting up and using the printer wirelessly, visit the HP Wireless Printing 
Center ( www.hp.com/go/wirelessprinting ).

Before you begin
Ensure the following:

● The printer is not connected to the network using an Ethernet cable.

● The wireless network is set up and working properly.

● The printer and the computers that use the printer are on the same network (subnet).

While connecting the printer, you might be prompted to enter the wireless network name (SSID) and a wireless 
password.

● The wireless network name is the name of your wireless network.

● The wireless password prevents other people from connecting to your wireless network without your 
permission. Depending on the level of security required, your wireless network might use either a WPA 
passphrase or WEP key.

If you have not changed the network name or the security passkey since setting up your wireless network, 
you can sometimes find them on the back or side of the wireless router.

If you cannot find the network name or the security password or cannot remember this information, see the 
documentation provided with your computer or with the wireless router. If you still cannot find this 
information, contact your network administrator or the person who set up the wireless network.
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Set up the printer on your wireless network
Use the Wireless Setup Wizard from the printer control panel display to set up wireless communication.

NOTE: Before you proceed, go through the list at Before you begin.

1. From the printer control panel, touch Setup .

2. Touch Network Setup.

3. Touch Wireless Settings.

4. Touch Wireless Setup Wizard .

5. Follow the display instructions to complete the setup.

If you are already using the printer with a different type of connection, such as a USB connection, follow the 
instructions in Change the connection type to set up the printer on your wireless network.

Change the connection type
After you have installed the HP printer software and connected the printer to your computer or to a network, 
you can use the software to change the connection type (for example, from a USB connection to a wireless 
connection).

NOTE: Connecting an Ethernet cable turns off the wireless capability of the printer.

To change from an Ethernet connection to a wireless connection (Windows)

1. Remove the Ethernet cable from the printer.

2. Run the Wireless Setup Wizard to make the wireless connection. For more information, see Set up the 
printer on your wireless network.

Open the printer software after the installation. For more information, see Open the HP printer software 
(Windows).

To change from a USB connection to a wireless network (Windows)

Before you proceed, go through the list at Before you begin.

1. Depending on your operating system, do one of the following:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, select the printer name, 
and then click Utilities.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, select the 
printer name, and then click Utilities.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, click the folder of your printer.

2. Click Printer Setup & Software.

3. Select Convert a USB connected printer to wireless. Follow the onscreen instructions.

To change from a USB or Ethernet connection to a wireless connection (OS X)

Before you proceed, go through the list at Before you begin.

1. Connect the printer to your wireless network.

2. Open System Preferences .
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3. Depending on your operating system, click Print & Fax , Print & Scan , or Printers & Scanners in the 
Hardware section.

4. Select your printer in the left pane and click - at the bottom of the list. Do the same for the fax entry, if 
there is one for the current connection.

5. Open HP Utility.

HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top level of the hard 
disk.

6. Choose Devices > HP Auto Wireless Connect and follow the prompts.

 Learn more about how to change from a USB to wireless connection. Click here to go online for more 

information. At this time, this website might not be available in all languages.

To change from a wireless connection to a USB or Ethernet connection (Windows)

● Connect the USB or Ethernet cable to the printer.

To change from a wireless connection to a USB or Ethernet connection (OS X)

Add the printer to the print queue.

1. Open System Preferences .

2. Depending on your operating system, click Print & Fax , Print & Scan , or Printers & Scanners in the 
Hardware section.

3. Click + below the list of printers at the left.

4. Select the printer from the list of detected printers, and click Add.

Test the wireless connection
Print the wireless test report for information about the printer wireless connection. The wireless test report 
provides information about the printer status, hardware (MAC) address, and IP address. If the printer is 
connected to a network, the test report displays details about the network settings.

To print the wireless test report

1. From the printer control panel, touch  (the Wireless button), and then touch  (the Settings 
button).

2. Touch Print Reports

3. Touch Wireless Test Report.

Turn on or off the wireless capability of the printer
The blue Wireless light on the printer control panel is lit when the wireless capability of the printer is on.

NOTE: Connecting an Ethernet cable to the printer automatically turns off the wireless capability and the 
Wireless light.

1. From the printer control panel, touch Setup and then touch Network Setup.

2. Touch Wireless Settings.

3. Touch Wireless to turn it on or off.
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Change network settings
From the printer control panel, you can set up and manage your printer' wireless connection and perform a 
variety of network management tasks. This includes viewing and changing network settings, restoring 
network defaults, and turning the wireless function on or off.

CAUTION: Network settings are provided for your convenience. However, unless you are an advanced user, 
you should not change some of these settings (such as the link speed, IP settings, default gateway, and 
firewall settings).

To print network settings

Use one of the following ways:

● From the printer control panel, touch  (Wireless) or  (Ethernet). The network status screen is 

displayed. Select Print Details to print the network configuation page.

● Print the network configuration page. For more information, see Network configuration page.

To set the link speed

You can change the speed at which data is transmitted over the network. The default is Automatic.

1. From the printer control panel, touch Setup and then touch Network Setup.

2. Touch Ethernet Settings.

3. Select Advanced Settings.

4. Touch Link Speed.

5. Touch the appropriate option that matches your network hardware.

To change IP settings

The default IP setting for the IP settings is Automatic, which sets the IP settings automatically. If you are an 
advanced user and want to use different settings (such as the IP address, subnet mask, or the default 
gateway), you can change them manually.

CAUTION: Be careful when manually assigning an IP address. If you enter an invalid IP address during the 
installation, your network components cannot connect with the printer.

1. From the printer control panel, touch Setup and then touch Network Setup.

2. Touch Ethernet Settings or Wireless Settings.

3. Touch Advanced Settings.

4. Touch IP Settings.

5. A message appears warning that changing the IP address removes the printer from the network. Touch 
OK to continue.

6. Automatic is selected by default. To change the settings manually, touch Manual, and then enter the 
appropriate information for the following settings:

● IP Address

● Subnet Mask
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● Default Gateway

● DNS Address

7. Enter your changes, and then touch Done .

8. Touch OK .

Use HP wireless direct
With HP wireless direct, you can print wirelessly from a computer, smart phone, tablet, or other wireless-
capable device—without connecting to an existing wireless network.

Guidelines when using HP wireless direct

● Make sure your computer or mobile device has the necessary software.

If you are using a computer, make sure you have installed the printer software provided with the printer.

● If you have not installed the HP printer software on the computer, connect to HP wireless direct first and 
then install the printer software. Select Wireless when prompted by the printer software for a 
connection type.

● If you are using a mobile device, make sure you have installed a compatible printing app. For more 
information about mobile printing, visit www.hp.com/global/us/en/eprint/mobile_printing_apps.html.

● Make sure HP wireless direct is turned on in the printer and, if necessary, security is enabled.

● Up to five computers and mobile devices can use the same HP wireless direct connection.

● HP wireless direct can be used while the printer is also connected either to a computer using a USB cable 
or to a network using a wireless connection.

● HP wireless direct cannot be used to connect a computer, mobile device, or printer to the Internet.

To turn on HP wireless direct

1. From the printer control panel, touch  (HP wireless direct).

2. Touch On for HP Wireless Direct.

TIP: If you would like to use HP wireless direct with greater security and if the computer or mobile 
device supports WPA2 encryption, touch Security to enable or disable security. With security enabled, 
only users with the password can connect wirelessly to the printer. Without enabling security, anyone 
with a wireless device within the wireless range of the printer can connect to the printer.

3. Touch HP Wireless Direct Name to display the HP wireless direct name.

4. If you have enabled security, touch Security Password to display the HP wireless direct password.

TIP: You can also turn on HP wireless direct from the EWS. For more information about using the EWS, see 
Embedded web server.
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To print from a wireless-capable mobile device

Make sure you have installed a compatible printing app on your mobile device. For more information, visit 
www.hp.com/global/us/en/eprint/mobile_printing_apps.html.

1. Make sure you have turned on HP wireless direct on the printer.

2. Turn on the Wi-Fi connection on your mobile device. For more information, see the documentation 
provided with the mobile device.

NOTE: If your mobile device does not support Wi-Fi, you are not able to use HP wireless direct.

3. From the mobile device, connect to a new network. Use the process you normally use to connect to a 
new wireless network or hotspot. Choose the HP wireless direct name from the list of wireless networks 
shown such as HP-Print-**-Officejet XXXX (where ** are the unique characters to identify your printer 
and XXXX is the printer model located on the printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Print your document.

To print from a wireless-capable computer (Windows)

1. Make sure you have turned on HP wireless direct on the printer.

2. Turn on the computer's Wi-Fi connection. For more information, see the documentation provided with 
the computer.

NOTE: If your computer does not support Wi-Fi, you are not able to use HP wireless direct.

3. From the computer, connect to a new network. Use the process you normally use to connect to a new 
wireless network or hotspot. Choose the HP wireless direct name from the list of wireless networks 
shown such as HP-Print-**-Officejet XXXX (where ** are the unique characters to identify your printer 
and XXXX is the printer model located on the printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Proceed to step 5 if the printer has been installed and connected to the computer over a wireless 
network. If the printer has been installed and connected to your computer with a USB cable, follow the 
steps below to install the printer software using the HP HP wireless direct connection.

a. Depending on your operating system, do one of the following:

● Windows 8.1: Click the down arrow in lower left corner of the Start screen, select the printer 
name, and then click Utilities.

● Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, select 
the printer name, and then click Utilities.

● Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select 
All Programs, click HP, click the folder of your printer.

b. Click Printer Setup & Software, and then select Connect a new printer.

c. When the Connection Options software screen appears, select Wireless.

Select your HP printer software from the list of detected printers.

d. Follow the on-screen instructions.

5. Print your document.
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To print from a wireless-capable computer (OS X)

1. Make sure you have turned on HP wireless direct on the printer.

2. Turn on Wi-Fi on the computer.

For more information, see the documentation provided by Apple.

3. Click the Wi-Fi icon and choose the HP wireless direct name, such as HP-Print-**-Officejet XXXX (where 
** are the unique characters to identify your printer and XXXX is the printer model located on the 
printer).

If HP wireless direct is turned on with security, enter the password when prompted.

4. Add the printer.

a. Open System Preferences .

b. Depending on your operating system, click Print & Fax , Print & Scan , or Printers & Scanners in 
the Hardware section.

c. Click + below the list of printers at the left.

d. Select the printer from the list of detected printers (the word “Bonjour” is listed the right column 
beside the printer name), and click Add.

 Click here for online troubleshooting for HP wireless direct, or for more help with setting up HP 

wireless direct. At this time, this website might not be available in all languages.
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9 Printer management tools

This section contains the following topics:

● Toolbox (Windows)

● HP Utility (OS X)

● Embedded web server

Toolbox (Windows)
The Toolbox provides maintenance information about the printer.

NOTE: The Toolbox can be installed from the HP Software CD if the computer meets the system 
requirements. System requirements can be found in the Readme file, which is available on the HP printer 
software CD provided with your printer.

To open the Toolbox

1. Open the HP printer software. For more information, see Open the HP printer software (Windows).

2. Click Print, Scan & Fax .

3. Click Maintain Your Printer.

HP Utility (OS X)
HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and find 
website support information.

NOTE: The features available in HP Utility vary depending on the selected printer.

Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low-ink 
warning message, consider having a replacement cartridge available to avoid possible printing delays. You do 
not need to replace cartridges until the print quality becomes unacceptable.

Double-click HP Utility in the Hewlett-Packard folder in the Applications folder at the top level of the hard 
disk.

Embedded web server
When the printer is connected to a network, you can use the printer's embedded web server (EWS) to view 
status information, change settings, and manage it from your computer.

NOTE: To view or change some settings, you might need a password.

NOTE: You can open and use the embedded web server without being connected to the Internet. However, 
some features are not available.

● About cookies

● Open the embedded web server
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● Control panel lock

● Embedded web server cannot be opened

About cookies
The embedded Web server (EWS) places very small text files (cookies) on your hard drive when you are 
browsing. These files let the EWS recognize your computer the next time you visit. For example, if you have 
configured the EWS language, a cookie helps remember which language you have selected so that the next 
time you access the EWS, the pages are displayed in that language. Some cookies (such as the cookie that 
stores customer-specific preferences) are stored on the computer until you clear them manually.

You can configure your browser to accept all cookies, or you can configure it to alert you every time a cookie is 
offered, which allows you to decide which cookies to accept or refuse. You can also use your browser to 
remove unwanted cookies.

Depending on your printer, if you disable cookies, you also disable one or more of the following features:

● Using some setup wizards

● Remembering the EWS browser language setting

● Personalizing the EWS Home page

For information about how to change your privacy and cookie settings and how to view or delete cookies, see 
the documentation available with your Web browser.

Open the embedded web server
You can access the embedded web server through either a network or HP wireless direct.

To open the embedded web server through a network

1. Find out the IP address or hostname of the printer from the network configuration page.

For more information, see Network configuration page.

2. In a supported web browser on your computer, type the IP address or hostname assigned to the printer.

For example, if the IP address is 123.123.123.123, type the following address into the web browser: 
http://123.123.123.123

To open the embedded web server through HP wireless direct

1. Touch  (HP wireless direct) from the printer control panel display.

2. If the display shows that HP wireless direct is Off , touch HP Wireless Direct to turn it on.

3. From your wireless computer, turn wireless on, search for and connect to the HP wireless direct name. If 
you have HP wireless direct security on, enter the HP wireless direct password when prompted.

4. In a supported web browser on your computer, type the following address: http://
192.168.223.1.

Control panel lock
To prevent unauthorized use of certain features on the printer control panel, you can lock the features from 
the embedded web server (EWS).
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Once the control panel lock is turned on, certain features will not be accessible from the control panel. The 
setting for control panel lock itself can also be secured by setting an administrator password in EWS. The 
password must be entered when accessing the setting for turning on or off the control panel lock.

Embedded web server cannot be opened
Check your network setup

● Make sure you are not using a phone cord or a crossover cable to connect the printer to the network.

● Make sure the network cable is securely connected to the printer.

● Make sure the network hub, switch, or router is turned on and working correctly.

Check the computer

● Make sure the computer that you are using is connected to the network.

NOTE: You may also access the EWS if the printer's HP wireless direct is turned on, and you know the 
printer's IP address.

Check your web browser

● Make sure the web browser meets the minimum system requirements. For more information, see 
system requirements in the printer's Readme file found on the HP printer software CD.

● If your web browser uses any proxy settings to connect to the Internet, try turning off these settings. For 
more information, see the documentation available with your web browser.

● Make sure JavaScript and cookies are enabled in your web browser. For more information, see the 
documentation available with your web browser.

Check the printer IP address

● To check the IP address of the printer, obtain the IP address by printing a network configuration page. 
From the printer control panel display, touch Setup , touch Reports , and then touch Network 
Configuration Report.

● Ping the printer using the IP address from the command prompt (Windows) or from Network Utility (OS 
X).

NOTE: OS X Lion and OS X Mountain Lion: Network Utility is located in the Utilities folder in the 
Applications folder at the top level of the hard disk.

OS X Mavericks: Open Finder, hold down the Option key and choose System Information from the Apple 
( ) menu. Choose Window > Network Utility.

For example, if the IP address is 123.123.123.123, type the following at the command prompt 
(Windows):

C:\ping 123.123.123.123
Or

In Network Utility (OS X), click the Ping tab, type the 123.123.123.123 in the box, and then click Ping.

If a reply appears, the IP address is correct. If a time-out response appears, the IP address is incorrect.

TIP: If you are using a computer running Windows, you can visit the HP online support website at 
www.hp.com/support . This website provides information and utilities that can help you correct many 
common printer problems.
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10 Solve a problem

The information in this section suggests solutions to common problems. If your printer is not operating 
correctly and these suggestions did not solve your problem, try using one of the support services listed in HP 
support to obtain assistance.

This section contains the following topics:

● HP support

● Get help from the printer control panel

● Understand printer reports

● Solve printer problems

● Solve printing problems

● Solve copy problems

● Solve scan problems

● Solve fax problems

● Solve problems using Web Services

● Solve network problems

● Maintain the printer

● Clear paper jams

● Clear the print carriage

● Restore defaults and settings

HP support
● Register printer

● Support process

● Obtain electronic support

● HP support by phone

Register printer
By taking just a few quick minutes to register, you can enjoy quicker service, more efficient support, and 
product support alerts. If you did not register your printer while installing the software, you can register now 
at http://www.register.hp.com.
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Support process
If you have a problem, follow these steps:

1. Check the documentation that came with the printer.

2. Visit the HP online support website at www.hp.com/support .

HP online support is available to all HP customers. It is the fastest source for up-to-date product 
information and expert assistance, and includes the following features:

● Fast access to qualified online support specialists

● Software and driver updates for the printer

● Valuable troubleshooting information for common problems

● Proactive printer updates, support alerts, and HP newsgrams that are available when you register 
the printer

3. Call HP support. For more information, see HP support by phone.

Support options and availability vary by printer, country/region, and language.

Obtain electronic support
To find support and warranty information, go to the HP website at www.hp.com/support . This website 
provides information and utilities that can help you correct many common printer problems. If prompted, 
select your country/region, and then click All HP Contacts for information about calling for technical support.

This website also offers technical support, drivers, supplies, ordering information and other options such as:

● Access online support pages.

● Send HP an email message for answers to your questions.

● Connect with an HP technician by using online chat.

● Check for HP software updates.

You can also obtain support from the HP software for Windows or OS X, which provide easy, step-by-step 
solutions to common printing problems. For more information, see Printer management tools.

Support options and availability vary by printer, country/region, and language.

HP support by phone
Phone support options and availability vary by printer, country/region, and language.

This section contains the following topics:

● Before you call

● Phone support period

● Support phone numbers

● After the phone support period

Before you call

Call HP support while you are in front of the printer and a computer it is connected to. Be prepared to provide 
the following information:
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● Model number

● Serial number (located on the back or bottom of the printer)

● Messages that appear when the situation occurs

● Answers to these questions:

— Has this situation happened before?

— Can you re-create it?

— Did you add any new hardware or software to your computer at about the time that this situation 
began?

— Did anything else occur prior to this situation (such as a thunderstorm or moving the printer)?

If you need to call HP, it is often useful to print the printer status report before calling.

Phone support period

One year of phone support is available in North America, Asia Pacific, and Latin America (including Mexico). To 
determine the duration of phone support in Europe, the Middle East, and Africa, go to www.hp.com/support . 
Standard phone company charges apply.

Support phone numbers

For the most current HP list of telephone support numbers and call costs information, see www.hp.com/
support .

After the phone support period

After the phone support period, help is available from HP at an additional cost. Help may also be available at 
the HP online support website: www.hp.com/support . Contact your HP dealer or call the support phone 
number for your country/region to learn more about support options.

Get help from the printer control panel
You can use the printer’s help topics to learn more about the printer, and some help topics include animations 
that guide you through procedures, such as clearing jams.

To open the help topics from the printer control panel, touch “  (Help) from the Home screen.

Understand printer reports
You can print the following reports to help troubleshoot problems with the printer.

● Printer status report

● Network configuration page

● Print quality report

● Wireless test report

● Web access report
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Printer status report
Use the printer status report to view current printer information and ink cartridge status. Also use the printer 
status report to help you troubleshoot problems with the printer.

The printer status report also contains a log of recent events.

If you need to call HP, it is often useful to print the printer status report before calling.

To print the Printer Status Report

1. From the printer control panel, touch Setup .

2. Touch Reports and then touch Printer Status Report.

1. Product Information: Shows printer information (such as the printer name, model number, serial 
number, and firmware version number), and the accessories that are installed (such as the automatic 
two-sided printing accessory or duplexer).

2. Print Usage Information: Shows summary information about pages printed from the printer.

3. Ink Delivery System Information: Shows the estimated ink levels (represented in graphical form as 
gauges) and the part numbers and warranty expiration dates for the ink cartridges.

NOTE: Ink level warnings and indicators provide estimates for planning purposes only. When you 
receive a low-ink warning message, consider having a replacement cartridge available to avoid possible 
printing delays. You do not need to replace cartridges until the print quality becomes unacceptable.

4. Additional Assistance: Provides information about where you can go to get more information about the 
printer, as well as information about how to set up a Fax Test and how to run a Wireless Network Test.
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Network configuration page
If the printer is connected to a network, you can print a network configuration page to view the network 
settings for the printer and a list of networks detected by your printer. The last page of the report includes a 
list of all detectable wireless networks in the area, along with signal strength and the channels being used. 
This might help you select a channel for your network which is not heavily used by other networks (which will 
improve network performance).

You can use the network configuration page to help troubleshoot network connectivity problems. If you need 
to call HP, it is often useful to print this page before calling.

To print the network configuration page

1. From the printer control panel, touch Setup .

2. Touch Reports and then touch Network Configuration Report.
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1. General Information: Shows information about the current status and active connection type of the 
network, and other information, such as the URL of the embedded web server.

2. 802.3 Wired: Shows information about the active Ethernet network connection, such as the IP address, 
subnet mask, default gateway, as well as the hardware address of the printer.

3. 802.11 Wireless: Shows information about your wireless network connection, such as the host name, IP 
address, subnet mask, default gateway, and server. It also indicates the network name (SSID), the 
relative signal strengths and the channels being used. You can check the network list to view if your own 
network signal strength is good and change the wireless communication setup using Wireless Setup 
Wizard. For more information, see Change the connection type.
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4. HP wireless direct: Shows information about your HP wireless direct connection, such as the network 
name (SSID), IP address, subnet mask, default gateway, and server.

5. Miscellaneous: Shows information about more advanced network settings.

● Port 9100: The printer supports raw IP printing through TCP Port 9100. This HP-proprietary TCP/IP 
port on the printer is the default port for printing. It is accessed by HP software (for example, the 
HP Standard Port).

● Bonjour: Bonjour services (which use mDNS, or Multicast Domain Name System) are typically used 
on small networks for IP address and name resolution (through UDP port 5353), where 
a conventional DNS server is not used.

● SLP: Service Location Protocol (SLP) is an Internet standard network protocol that provides 
a framework to allow networking applications to discover the existence, location, and 
configuration of networked services in enterprise networks. This protocol simplifies discovery and 
use of network resources such as printers, web servers, fax machines, video cameras, files 
systems, backup devices (tape drives), databases, directories, mail servers, calendars.

● Microsoft Web Services: Enable or disable the Microsoft Web Services Dynamic Discovery (WS 
Discovery) protocols or Microsoft Web Services for Devices (WSD) Print services supported on the 
printer. Disable unused print services to prevent access through those services.

NOTE: For more information about WS Discovery and WSD Print, visit www.microsoft.com.

● IPP: Internet Printing Protocol (IPP) is a standard network protocol for remote printing. Unlike 
other remote IP-based protocols, IPP supports access control, authentication, and encryption, 
allowing for more secure printing.

● Proxy Settings: Shows information about proxy address, port, and the status of authentication. 
You can change the proxy settings from EWS.

To change the proxy settings, click Network from EWS, click Proxy Settings, and select the 
appropriate options.

Print quality report
Print quality problems can have many causes-software settings, a poor image file, or the printing system 
itself. If you are unhappy with the quality of your prints, a Print Quality Diagnostic page can help you 
determine if the printing system is working correctly.

To print a print quality report

1. From the printer control panel, touch Setup .

2. Touch Reports .

3. Touch Print Quality Report.
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If defects are seen on the page, follow the steps below:

1. If the Print Quality report shows faded, partial, streaked, or missing color bars or patterns, check for 
depleted ink cartridges, and replace the ink cartridge that corresponds to the defective color bar or color 
pattern. If there is no depleted ink cartridge, remove and reinstall all ink cartridges to make sure they 
are properly installed.

Do not remove the depleted cartridge until you have a new ink cartridge available to replace. For 
information about how to install new cartridges, see Replace the ink cartridges.

2. If the lines in Test Pattern 1 are not straight and connected, align the printer. For more information, see 
Maintain the printhead and ink cartridges.

3. If you see white lines across any of the color blocks in Test Pattern 2, clean the printhead. For more 
information, see Maintain the printhead and ink cartridges.
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4. If you see white or dark lines where the arrows are pointing in Test Pattern 3, align the printhead. For 
more information, see Maintain the printhead and ink cartridges.

5. If none of the previous steps have helped, contact HP support to replace the printhead. For more 
information, see HP support.

Wireless test report
Print the wireless test report for information about the printer wireless connection. The wireless test report 
provides information about the printer status, hardware (MAC) address, and IP address. If the printer is 
connected to a network, the test report displays details about the network settings.

To print the wireless test report

1. From the printer control panel, touch  (the Wireless button), and then touch  (the Settings 
button).

2. Touch Print Reports.

3. Touch Wireless Test Report.

Web access report
Print the web access report to help identify internet connectivity issues which can affect Web Services.

To print the web access report

1. From the printer control panel, touch Setup .

2. Touch Reports .

3. Touch Web Access Report.

Solve printer problems
TIP: (Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing, scanning, and 
copying issues. The application is only available in some languages.

The printer shuts down unexpectedly

● Check the power and power connections.

● Make sure the printer's power cord is connected firmly to a functioning power outlet.

Printhead alignment fails

● If the alignment process fails, make sure you have loaded unused, plain white paper into the input tray. 
If you have colored paper loaded in the input tray when you align the ink cartridges, the alignment fails.

● If the alignment process fails repeatedly, you may need to clean the printhead, or you might have a 
defective sensor. To clean the printhead, see Maintain the printhead and ink cartridges.

● If cleaning the printhead does not solve the problem, contact HP support. Go to www.hp.com/support . 
This website provides information and utilities that can help you correct many common printer 
problems. If prompted, select your country/region, and then click All HP Contacts for information on 
calling for technical support.
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Paper-feed problems

● Paper is not picked up from a tray   

— Make sure paper is loaded in the tray. For more information, see Load paper. Fan the paper before 
loading.

— Make sure the paper-width guides are set to the correct markings in the tray for the paper size you 
are loading. Also make sure the paper guides are snug, but not tight, against the stack.

— Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of the 
input tray, and does not exceed the stack height marking on the side of the tray.

— Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of the 
input tray, and does not exceed the stack height marking on the side of the tray.

— Make sure paper in the tray is not curled. Uncurl paper by bending it in the opposite direction of the 
curl.

● Pages are skewing   

— Make sure the paper loaded in the input tray is aligned to the paper-width guides. If needed, pull 
out the input tray from the printer and reload the paper correctly, making sure that the paper 
guides are aligned correctly.

— Load paper into the printer only when it is not printing.

● Multiple pages are being picked up  

— Make sure the paper-width guides are set to the correct markings in the tray for the paper size you 
are loading. Also make sure the paper-width guides are snug, but not tight, against the stack.

— Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of the 
input tray, and does not exceed the stack height marking on the side of the tray.

— Make sure the tray is not overloaded with paper.

— Ensure that the stack of paper is aligned with the appropriate paper size lines on the bottom of the 
input tray, and does not exceed the stack height marking on the side of the tray.

— Use HP paper for optimum performance and efficiency.

Solve printing problems
TIP: (Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing, scanning, and 
copying issues. The application is only available in some languages.

The printer is not responding (nothing prints)

● There are print jobs stuck in the print queue

Open the print queue, cancel all documents, and then reboot the computer. Try to print after the 
computer reboots. Refer to the Help system for the operating system for more information.

● Check the HP software installation

If the printer is turned off when printing, an alert message should appear on your computer screen; 
otherwise, the HP software provided with the printer might not be installed correctly. To resolve this, 
uninstall the HP software completely, and then reinstall the HP software.

● Check the cable connections
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Make sure both ends of the USB cable or Ethernet cable are secure.

If the printer is connected to a network, check the following:

— Check the Link light on the back of the printer above the power input.

— Make sure you are not using a phone cord to connect the printer.

● Check the printer’s wireless connection

If the printer is connected to the network with a wireless connection, check that the blue Wireless light is 
on and not blinking. A blinking light indicates there is connection problem between the printer and the 
network. You can print a Wireless Test Report to help diagnose any issues.

● Check any personal firewall software installed on the computer   

The personal software firewall is a security program that protects a computer from intrusion. However, 
the firewall might block communication between the computer and the printer. If there is a problem 
communicating with the printer, try temporarily disabling the firewall. If the problem persists, the 
firewall is not the source of the communication problem. Re-enable the firewall.

 Use this troubleshooter to help you get your printer on the network if you have a firewall or 

antivirus protection that is causing a problem. Click here to go online for more information. At this time, 
this website might not be available in all languages.

● Restart the printer and the computer

If the printer is still not responding, turn off the printer and the computer, and turn them back on.

 If the above solutions do not resolve the problem, click here for more online troubleshooting.

Something on the page is missing or incorrect

● Try the solutions in Print quality is not acceptable

● Check the printer location and length of USB cable

High electromagnetic fields (such as those generated by USB cables) can sometimes cause slight 
distortions to printouts. Move the printer away from the source of the electromagnetic fields. Also, it is 
recommended that you use a USB cable that is less than 3 meters (9.8 feet) long to minimize the effects 
of these electromagnetic fields.

Print quality is not acceptable

1. Make sure you are using genuine HP ink cartridges. Genuine HP ink cartridges are designed and tested 
with HP printers to help you easily produce great results, time after time.
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NOTE: HP cannot guarantee the quality or reliability of non-HP supplies. Printer service or repairs 
required as a result of using a non-HP supply are not covered under warranty.

If you believe you purchased genuine HP ink cartridges, go to:

www.hp.com/go/anticounterfeit

2. Check the ink levels. The ink cartridges might have insufficient ink.

NOTE: Ink level alerts and indicators provide estimates for planning purposes only. When you receive a 
low-ink alert, consider having a replacement cartridge available to avoid possible printing delays. You do 
not need to replace the ink cartridges until the print quality becomes unacceptable.

CAUTION: While ink cartridges are not damaged when left outside of the printer, the printhead does 
need to have all cartridges installed at all times after the printer is set up and in use. Leaving one or 
more cartridge slots empty for an extended period may lead to print quality problems and possibly 
damage the printhead. If you have recently left a cartridge out of the printer for an extended period, or if 
you have had a recent paper jam, and have noticed poor print quality, clean the printhead. For more 
information, see Maintain the printhead and ink cartridges.

For more information, see Check the estimated ink levels.

3. Check the paper loaded in the input tray. Make sure the paper is loaded correctly and that it is not 
wrinkled or too thick.

● Load paper with the print side facing down. For example, if you are loading glossy photo paper, 
load the paper with the glossy side down.

● Make sure the paper lays flat in the input tray and is not wrinkled. If the paper is too close to the 
printhead during printing, the ink might be smeared. This can happen if the paper is raised, 
wrinkled, or very thick, such as a mailing envelope.

For more information, see Load paper.

4. Check the paper type.

HP recommends that you use HP papers or any other paper type with ColorLok technology that is 
appropriate for the printer. All papers with the ColorLok logo are independently tested to meet high 
standards of reliability and print quality, and produce documents with crisp, vivid color, bolder blacks 
and dry faster than ordinary plain papers. For more information, see Paper basics.

Always make sure the paper you are printing on is flat. For best results when printing images, use 
HP Advanced Photo Paper.

Store specialty paper in its original packaging inside a resealable plastic bag on a flat surface in a cool, 
dry place. When you are ready to print, remove only the paper you plan to use immediately. When you 
have finished printing, return any unused photo paper to the plastic bag. This prevents the photo paper 
from curling.

5. Check the print settings by clicking the button that opens the Properties dialog box. (Depending on your 
software application, this button might be called Properties, Options, Printer Setup, Printer 
Properties, Printer, or Preferences.)

● Check the print settings in the printer driver to see if the color settings are incorrect.

For example, check to see if the document is set to print in grayscale. Or, check to see if advanced 
color settings such as saturation, brightness, or color tone, are set to modify the appearance of 
colors.

● Check the print quality setting and make sure it matches the type of paper loaded in the printer.
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You might need to choose a lower print quality setting if colors are running into each other. Or, 
choose a higher setting if you are printing a high-quality photo, and then make sure photo paper 
such as HP Advanced Photo Paper is loaded in the input tray.

NOTE: On some computer screens, colors might appear differently than they do when printed on 
paper. In this case, there is nothing wrong with the printer, print settings, or ink cartridges. No further 
troubleshooting is required.

6. Print and evaluate a print quality report. To print this report, see Print quality report.

 Use this document to help resolve print quality issues. Click here to go online for more information. 

At this time, this website might not be available in all languages.

Solve copy problems
TIP: (Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing, scanning, and 
copying issues. The application is only available in some languages.

Copies are blank or faded

● The contrast setting might be set too light. From the printer control panel display, touch Copy , touch 
( Copy Settings ), touch Lighter/Darker, and then use the arrows to create darker copies.

● The quality setting of Fast (which produces draft-quality copies) might be responsible for the missing or 
faded documents. Change to the Normal or Best setting.

Size is reduced

● The reduce/enlarge or other copy feature might have been set from the printer control panel to reduce 
the scanned image. Check the settings for the copy job to make sure that they are for normal size.

● A dirty scanner glass might reduce the scanned image. Clean the scanner glass or lid backing. For more 
information, see Maintain the printer.

● This incoming page size may be larger than the original currently loaded.

Copy quality is poor 

● Check the printer

— The scanner lid might not be closed correctly.

— The scanner glass or lid backing might need cleaning. For more information, see Maintain the 
printer.

— If the printer has a document feeder, it might need cleaning. For more information, see Maintain 
the printer.

●  Unwanted lines

The scanner glass, lid backing, or frame might need cleaning. For more information, see Maintain the 
printer.

●   Copy is slanted or skewed

If you are using the document feeder, check the following:
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— Make sure that the document feeder input tray is not too full.

— Make sure that the document feeder width adjusters are snug against the sides of the paper.

For more information, see Load an original in the document feeder.

●   Horizontal grainy or white bands in light-gray to medium-gray areas

The default enhancement setting might not be suitable for the job. Check the setting and change it to 
enhance text or photographs, if needed. For more information, see Copy.

 Get online troubleshooting and learn more about how to solve copy issues. Click here to go online for 

more information. At this time, this website might not be available in all languages.

Solve scan problems
TIP: (Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing, scanning, and 
copying issues. The application is only available in some languages.

Scanner did nothing

● Check the original

Make sure that the original is loaded correctly. For more information, see Load an original on the 
scanner glass or Load an original in the document feeder.

● Check the printer

The printer might be coming out of Sleep mode after a period of inactivity, which delays processing 
a short while.

● Check the HP software

Make sure that the HP software provided with the printer is installed correctly.

— Windows: Open the HP printer software. For more information, see Open the HP printer software 
(Windows). In the window that appears, select Print, Scan & Fax or Print & Scan , and then select 
Scan a Document or Photo under Scan .

— OS X: Open HP Utility. For more information, see HP Utility (OS X). Under Scan Settings, select Scan 
to Computer, and ensure that Enable Scan to Computer is selected.

Scan takes too long

● Scanning with higher scan resolution takes longer and results in larger file sizes. Lower the resolution to 
scan more quickly.

● If you sent a print or copy job before you tried to scan, the scan starts if the scanner is not busy. 
However, the printing and scanning processes share memory, which means that the scan might be 
slower.

Part of the document did not scan or text is missing

● Check the original

— Make sure that you loaded the original correctly.
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For more information, see Load an original on the scanner glass or Load an original in the 
document feeder.

— If you scanned the document from the document feeder, try scanning the document directly from 
the scanner glass.

For more information, see Load an original on the scanner glass.

— Colored backgrounds can cause images in the foreground to blend into the background. Try 
adjusting the settings before you scan the original, or try enhancing the image after you scan the 
original.

● Check the settings 

— Make sure that the paper size loaded in the input tray is large enough for the original that you are 
scanning.

— If you are using the HP printer software, the default settings in the printer software might be set to 
automatically perform a specific task other than the one that you are attempting. See the on-
screen Help for the printer software for instructions about changing the properties.

Text cannot be edited

● Make sure that the OCR (optical character recognition) program has been installed:

Depending on your operating system, do one of the following:

— Windows 8.1: Click the down arrow in lower left corner of the Start screen, select the printer name, 
and then click Utilities. Select Printer Setup & Software. Click Add more software, click 
Customize Software Selections, and make sure the OCR option is selected.

— Windows 8: Right-click an empty area on the Start screen, click All Apps on the app bar, select the 
printer name, and then click Utilities. Select Printer Setup & Software. Click Add more software, 
click Customize Software Selections, and make sure the OCR option is selected.

— Windows 7, Windows Vista, and Windows XP: From the computer desktop, click Start, select All 
Programs, click HP, select your printer name, and then select Printer Setup & Software. Click Add 
more software, click Customize Software Selections, and make sure the OCR option is selected.

When you scan the original, make sure that you select a document type in the software that creates 
editable text. If text is classified as a graphic, it is not converted to text.

If you are using a separate OCR program, the OCR program might be linked to a word-processing 
program that does not perform OCR tasks. For more information, see the documentation provided with 
the OCR program.

Make sure you have selected an OCR language that corresponds to the language used for the document 
you are scanning. For more information, see the documentation provided with the OCR program.

● Check the originals

— Make sure that you loaded the original correctly.

For more information, see Load an original on the scanner glass or Load an original in the 
document feeder.

— Make sure the document is not skewed.

— The software might not recognize text that is tightly spaced. For example, if the text that the 
software converts has missing or combined characters, "rn" might appear as "m."
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— The accuracy of the software depends on the image quality, text size, and structure of the original 
and the quality of the scan itself. Make sure that your original has good image quality.

— Colored backgrounds can cause images in the foreground to blend too much.

Scanned image quality is poor

● Text or images on the back of a two-sided original appear in the scan

Two-sided originals can "bleed" text or images from the back side to the scan if the originals are printed 
on paper that is too thin or too transparent.

●  Unwanted lines

Ink, glue, correction fluid, or an unwanted substance might be on the scanner glass. Try cleaning the 
scanner glass.

For more information, see Maintain the printer.

●  The scanned image is skewed (crooked) 

The original might have been loaded incorrectly. Be sure to use the paper-width guides when you load 
the originals into the document feeder. For more information, see Load an original in the document 
feeder.

For best results, use the scanner glass for scanning rather than the document feeder. For more 
information, see Load an original on the scanner glass.

●    The scanned image shows blots, lines, vertical white stripes, or other defects

— If the scanner glass is dirty, the image produced does not have optimum clarity.

See Maintain the printer for cleaning instructions.

— The defects might be on the original and are not a result of the scanning process.

●  Size is reduced

The HP printer software settings might be set to reduce the scanned image.

See the HP printer software Help for more information about changing the settings.

Unable to scan to email

● The email profile has not been set up correctly

Make sure the valid outgoing SMTP server settings have been specified in the HP software. For more 
information about the SMTP server settings, see the documentation provided by your email service 
provider.

● Email messages are sent to some recipients but not to others when sending to multiple recipients

The email addresses might not be correct or might not be recognized by the email server. Make sure that 
the email addresses for all email recipients have been entered correctly in the HP software. Check your 
email Inbox for any delivery notification failure messages from the email server.

● Sending large email messages

Some email servers have been configured to reject email messages larger than a pre-determined size. 
To determine if your email server has a maximum file-size limit, see the documentation provided by 
your email service provider. If the email server does have such a limit, change the maximum email 
attachment size for the outgoing email profile to a value smaller than that of the email server.
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 For online troubleshooting and to learn more about how to solve scan issues. Click here to go online 

for more information. At this time, this website might not be available in all languages.

Solve fax problems
This section contains fax setup troubleshooting information for the printer. If the printer is not set up 
correctly for faxing, you might experience problems when sending faxes, receiving faxes, or both.

If you are having faxing problems, you can print a fax test report to check the status of the printer. The test 
fails if the printer is not set up correctly for faxing. Perform this test after you have completed setting up the 
printer for faxing.

If the test fails, review the report for information on how to fix any problems found. Learn more information 
about running fax test, click here to go online for more information.

 If you are having problems faxing click here for online troubleshooting to resolve the problem. At this 

time, this website might not be available in all languages.

For further assistance, visit the HP online support site www.hp.com/support .

● The fax test failed

● The display always shows Phone Off Hook

● The printer is having problems sending and receiving faxes

● The printer cannot receive faxes, but can send faxes

● The printer cannot send faxes, but can receive faxes

● Fax tones are recorded on my answering machine

● The phone cord that came with my printer is not long enough

● The computer cannot receive faxes (HP Digital Fax)

The fax test failed
If you ran a fax test and the test failed, review the report for basic information about the error. For more 
detailed information, check the report to see which part of the test failed, and then review the appropriate 
topic in this section for solutions to try.

The "Fax Hardware Test" failed

● Turn the printer off by pressing  (the Power button) located on the printer control panel and then 
unplug the power cord from the back of the printer. After a few seconds, plug the power cord in again, 
and then turn the power on. Run the test again. If the test fails again, continue reviewing the 
troubleshooting information in this section.

● Try to send or receive a test fax. If you can send or receive a fax successfully, there might not be 
a problem.

● If you are running the test from the Fax Setup Wizard (Windows) or HP Utility (OS X), make sure the 
printer is not busy completing another task, such as receiving a fax or making a copy. Check the display 
for a message indicating that the printer is busy. If it is busy, wait until it is finished and in the idle state 
before running the test.
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● Make sure you use the phone cord that came with the printer. If you do not use the supplied phone cord 
to connect from the telephone wall jack to the printer, you might not be able to send or receive faxes. 
After you plug in the phone cord that came with the printer, run the fax test again.

● If you are using a phone splitter, this can cause faxing problems. (A splitter is a two-cord connector that 
plugs into a telephone wall jack.) Try removing the splitter and connecting the printer directly to the 
telephone wall jack.

After you resolve any problems found, run the fax test again to make sure it passes and the printer is ready 
for faxing. If the Fax Hardware Test continues to fail and you experience problems faxing, contact HP 
support. Go to www.hp.com/support . This website provides information and utilities that can help you 
correct many common printer problems. If prompted, select your country/region, and then click All HP 
Contacts for information on calling for technical support.

The "Fax Connected to Active Telephone Wall Jack" test failed

● Check the connection between the telephone wall jack and the printer to make sure the phone cord is 
secure.

● Make sure you use the phone cord that came with the printer. If you do not use the supplied phone cord 
to connect from the telephone wall jack to the printer, you might not be able to send or receive faxes. 
After you plug in the phone cord that came with the printer, run the fax test again.

● Make sure you have correctly connected the printer to the telephone wall jack. Using the phone cord 
supplied in the box with the printer, connect one end to your telephone wall jack, then connect the other 
end to the port labeled 1-LINE on the back of the printer.

Learn more about fax setup and test, click here to go online for more information.

● If you are using a phone splitter, this can cause faxing problems. (A splitter is a two-cord connector that 
plugs into a telephone wall jack.) Try removing the splitter and connecting the printer directly to the 
telephone wall jack.

● Try connecting a working phone and phone cord to the telephone wall jack that you are using for the 
printer and check for a dial tone. If you do not hear a dial tone, contact your telephone company and 
have them check the line.

● Try to send or receive a test fax. If you can send or receive a fax successfully, there might not be 
a problem.

After you resolve any problems found, run the fax test again to make sure it passes and the printer is ready 
for faxing.

The "Phone Cord Connected to Correct Port on Fax" test failed

Make sure you use the phone cord that came with the printer. If you do not use the supplied phone cord to 
connect from the telephone wall jack to the printer, you might not be able to send or receive faxes. After you 
plug in the phone cord that came with the printer, run the fax test again.

If you are using a phone splitter, this can cause faxing problems. (A splitter is a two-cord connector that plugs 
into a telephone wall jack.) Try removing the splitter and connecting the printer directly to the telephone wall 
jack.

Plug the phone cord into the correct port

1. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: If you use the 2-EXT port to connect to the telephone wall jack, you cannot send or receive 
faxes. The 2-EXT port should only be used to connect other equipment, such as an answering machine.
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Figure 10-1  Back view of the printer

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the "1-LINE" port

2. After you have connected the phone cord to the port labeled 1-LINE, run the fax test again to make sure 
it passes and the printer is ready for faxing.

3. Try to send or receive a test fax.

The "Using Correct Type of Phone Cord with Fax" test failed

● Make sure you used the phone cord supplied in the box with the printer to connect to the telephone wall 
jack. One end of the phone cord should be connected to the port labeled 1-LINE on the back of the 
printer, and the other end to your telephone wall jack, as shown in the illustration.

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the "1-LINE" port

If the phone cord that came with the printer is not long enough, you can use a longer 2-wire phone cord 
to extend the length. You can purchase the cord at an electronics store that carries phone accessories.

● Check the connection between the telephone wall jack and the printer to make sure the phone cord is 
secure.
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● Make sure you use the phone cord that came with the printer. If you do not use the supplied phone cord 
to connect from the telephone wall jack to the printer, you might not be able to send or receive faxes. 
After you plug in the phone cord that came with the printer, run the fax test again.

● If you are using a phone splitter, this can cause faxing problems. (A splitter is a two-cord connector that 
plugs into a telephone wall jack.) Try removing the splitter and connecting the printer directly to the 
telephone wall jack.

The "Dial Tone Detection" test failed

● Other equipment, which uses the same phone line as the printer, might be causing the test to fail. To find 
out if other equipment is causing a problem, disconnect everything from the phone line, and then run 
the test again. If the Dial Tone Detection Test passes without the other equipment, then one or more 
pieces of the equipment is causing problems; try adding them back one at a time and rerunning the test 
each time, until you identify which piece of equipment is causing the problem.

● Try connecting a working phone and phone cord to the telephone wall jack that you are using for the 
printer and check for a dial tone. If you do not hear a dial tone, contact your telephone company and 
have them check the line.

● Make sure you have correctly connected the printer to the telephone wall jack. Using the phone cord 
supplied in the box with the printer, connect one end to your telephone wall jack, then connect the other 
end to the port labeled 1-LINE on the back of the printer.

● If you are using a phone splitter, this can cause faxing problems. (A splitter is a two-cord connector that 
plugs into a telephone wall jack.) Try removing the splitter and connecting the printer directly to the 
telephone wall jack.

● If your telephone system is not using a standard dial tone, such as some private branch exchange (PBX) 
systems, this might cause the test to fail. This does not cause a problem sending or receiving faxes. Try 
sending or receiving a test fax.

● Check to make sure the country/region setting is set appropriately for your country/region. If the 
country/region setting is not set or is set incorrectly, the test might fail and you might have problems 
sending and receiving faxes.

● Make sure you connect the printer to an analog phone line or you cannot send or receive faxes. To check 
if your phone line is digital, connect a regular analog phone to the line and listen for a dial tone. If you do 
not hear a normal sounding dial tone, it might be a phone line set up for digital phones. Connect the 
printer to an analog phone line and try sending or receiving a fax.

● Make sure you use the phone cord that came with the printer. If you do not use the supplied phone cord 
to connect from the telephone wall jack to the printer, you might not be able to send or receive faxes. 
After you plug in the phone cord that came with the printer, run the fax test again.

After you resolve any problems found, run the fax test again to make sure it passes and the printer is ready 
for faxing. If the Dial Tone Detection test continues to fail, contact your telephone company and have them 
check the phone line.

The "Fax Line Condition" test failed

● Make sure you connect the printer to an analog phone line or you cannot send or receive faxes. To check 
if your phone line is digital, connect a regular analog phone to the line and listen for a dial tone. If you do 
not hear a normal sounding dial tone, it might be a phone line set up for digital phones. Connect the 
printer to an analog phone line and try sending or receiving a fax.

● Check the connection between the telephone wall jack and the printer to make sure the phone cord is 
secure.
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● Make sure you have correctly connected the printer to the telephone wall jack. Using the phone cord 
supplied in the box with the printer, connect one end to your telephone wall jack, then connect the other 
end to the port labeled 1-LINE on the back of the printer.

● Other equipment, which uses the same phone line as the printer, might be causing the test to fail. To find 
out if other equipment is causing a problem, disconnect everything from the phone line, and then run 
the test again.

— If the Fax Line Condition Test passes without the other equipment, then one or more pieces of the 
equipment is causing problems; try adding them back one at a time and rerunning the test each 
time, until you identify which piece of equipment is causing the problem.

— If the Fax Line Condition Test fails without the other equipment, connect the printer to a working 
phone line and continue reviewing the troubleshooting information in this section.

● If you are using a phone splitter, this can cause faxing problems. (A splitter is a two-cord connector that 
plugs into a telephone wall jack.) Try removing the splitter and connecting the printer directly to the 
telephone wall jack.

● Make sure you use the phone cord that came with the printer. If you do not use the supplied phone cord 
to connect from the telephone wall jack to the printer, you might not be able to send or receive faxes. 
After you plug in the phone cord that came with the printer, run the fax test again.

After you resolve any problems found, run the fax test again to make sure it passes and the printer is ready 
for faxing. If the Fax Line Condition test continues to fail and you experience problems faxing, contact your 
telephone company and have them check the phone line.

The display always shows Phone Off Hook
● You are using the wrong type of phone cord. Make sure you are using the 2-wire phone cord that came 

with the printer to connect the printer to your phone line. If the phone cord that came with the printer is 
not long enough, you can use a longer phone cord to extend the length. You can purchase the cord at an 
electronics store that carries phone accessories.

● Other equipment that uses the same phone line as the printer might be in use. Make sure extension 
phones (phones on the same phone line, but not connected to the printer) or other equipment are not in 
use or off the hook. For example, you cannot use the printer for faxing if an extension phone is off the 
hook, or if you are using a computer dial-up modem to send email or access the Internet.

The printer is having problems sending and receiving faxes
● Make sure the printer is turned on. Look at the display on the printer. If the display is blank and  (the 

Power button) light is not lit, the printer is turned off. Make sure the power cord is firmly connected to 
the printer and plugged into a power outlet. Press  (the Power button) to turn on the printer.

After turning on the printer, HP recommends you wait five minutes before sending or receiving a fax. The 
printer cannot send or receive faxes while it is initializing after being turned on.

● If HP Digital Fax has been enabled, you might not be able to send or receive faxes if the fax memory is 
full (limited by printer memory).
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● Make sure you used the phone cord supplied in the box with the printer to connect to the telephone wall 
jack. One end of the phone cord should be connected to the port labeled 1-LINE on the back of the 
printer and the other end to your telephone wall jack, as shown in the illustration.

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the "1-LINE" port

If the phone cord that came with the printer is not long enough, you can use a longer 2-wire phone cord 
to extend the length. You can purchase the cord at an electronics store that carries phone accessories.

● Try connecting a working phone and phone cord to the telephone wall jack that you are using for the 
printer and check for a dial tone. If you do not hear a dial tone, call your local telephone company for 
service.

● Other equipment, which uses the same phone line as the printer, might be in use. For example, you 
cannot use the printer for faxing if an extension phone is off the hook, or if you are using a computer 
dial-up modem to send an email or access the Internet.

● Check to see if another process has caused an error. Check the display or your computer for an error 
message providing information about the problem and how to solve it. If there is an error, the printer 
cannot send or receive a fax until the error condition is resolved.

● The phone line connection might be noisy. Phone lines with poor sound quality (noise) can cause faxing 
problems. Check the sound quality of the phone line by plugging a phone into the telephone wall jack 
and listening for static or other noise. If you hear noise, turn Error Correction Mode (ECM) off and try 
faxing again. For information about changing ECM, see Send a fax in Error Correction Mode. If the 
problem persists, contact your telephone company.

● If you are using a digital subscriber line (DSL) service, make sure that you have a DSL filter connected or 
you cannot fax successfully. Click here to go online for more information.

● Make sure the printer is not connected to a telephone wall jack that is set up for digital phones. To check 
if your phone line is digital, connect a regular analog phone to the line and listen for a dial tone. If you do 
not hear a normal sounding dial tone, it might be a phone line set up for digital phones.

● If you are using either a private branch exchange (PBX) or an integrated services digital network (ISDN) 
converter/terminal adapter, make sure the printer is connected to the correct port and the terminal 
adapter is set to the correct switch type for your country/region, if possible. Click here to go online for 
more information.
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● If the printer shares the same phone line with a DSL service, the DSL modem might not be grounded 
correctly. If the DSL modem is not grounded correctly, it can create noise on the phone line. Phone lines 
with poor sound quality (noise) can cause faxing problems. You can check the sound quality of the 
phone line by plugging a phone into the telephone wall jack and listening for static or other noise. If you 
hear noise, turn off your DSL modem and completely remove power for at least 15 minutes. Turn the 
DSL modem back on and listen to the dial tone again.

NOTE: You might notice static on the phone line again in the future. If the printer stops sending and 
receiving faxes, repeat this process.

If the phone line is still noisy, contact your telephone company. For information on turning your DSL 
modem off, contact your DSL provider for support.

● If you are using a phone splitter, this can cause faxing problems. (A splitter is a two-cord connector that 
plugs into a telephone wall jack.) Try removing the splitter and connecting the printer directly to the 
telephone wall jack.

The printer cannot receive faxes, but can send faxes
● If you are not using a distinctive ring service, check to make sure that the Distinctive Ring feature on the 

printer is set to All Rings . For more information, see Change the answer ring pattern for distinctive ring.

● If Auto Answer is set to Off , you need to receive faxes manually; otherwise, the printer cannot receive 
the fax. For information on receiving faxes manually, see Receive a fax manually.

● If you have a voice mail service at the same phone number you use for fax calls, you must receive faxes 
manually, not automatically. This means that you must be available to respond in person to incoming 
fax calls. Learn more about setting up the printer when you have a voice mail service, click here to go 
online for more information. For information on receiving faxes manually, see Receive a fax manually.

● If you have a computer dial-up modem on the same phone line with the printer, check to make sure that 
the software that came with your modem is not set to receive faxes automatically. Modems that are set 
up to receive faxes automatically take over the phone line to receive all incoming faxes, which prevents 
the printer from receiving fax calls.

● If you have an answering machine on the same phone line with the printer, you might have one of the 
following problems:

— Your answering machine might not be set up correctly with the printer.

— Your outgoing message might be too long or too loud to allow the printer to detect fax tones, and 
the sending fax machine might disconnect.

— Your answering machine might not have enough quiet time after your outgoing message to allow 
the printer to detect fax tones. This problem is most common with digital answering machines.

The following actions might help solve these problems:

— When you have an answering machine on the same phone line you use for fax calls, try connecting 
the answering machine directly to the printer, click here to go online for more information.

— Make sure the printer is set to receive faxes automatically. For information on setting up the 
printer to receive faxes automatically, see Receive a fax.

— Make sure the Rings to Answer setting is set to a greater number of rings than the answering 
machine. For more information, see Set the number of rings before answering.
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— Disconnect the answering machine and then try receiving a fax. If faxing is successful without the 
answering machine, the answering machine might be causing the problem.

— Reconnect the answering machine and record your outgoing message again. Record a message 
that is approximately 10 seconds in duration. Speak slowly and at a low volume when recording 
your message. Leave at least 5 seconds of silence at the end of the voice message. There should be 
no background noise when recording this silent time. Try to receive a fax again.

NOTE: Some digital answering machines might not retain the recorded silence at the end of your 
outgoing message. Play back your outgoing message to check.

● If the printer shares the same phone line with other types of phone equipment, such as an answering 
machine, a computer dial-up modem, or a multi-port switch box, the fax signal level might be reduced. 
The signal level can also be reduced if you use a splitter or connect extra cables to extend the length of 
your phone. A reduced fax signal can cause problems during fax reception.

To find out if other equipment is causing a problem, disconnect everything except the printer from the 
phone line, and then try to receive a fax. If you can receive faxes successfully without the other 
equipment, one or more pieces of the other equipment is causing problems; try adding them back one at 
a time and receiving a fax each time, until you identify which equipment is causing the problem.

● If you have a special ring pattern for your fax phone number (using a distinctive ring service through 
your telephone company), make sure that the Distinctive Ring feature on the printer is set to match. For 
more information, see Change the answer ring pattern for distinctive ring.

The printer cannot send faxes, but can receive faxes
● The printer might be dialing too fast or too soon. You might need to insert some pauses in the number 

sequence. For example, if you need to access an outside line before dialing the phone number, insert 
a pause following the access number. If your number is 95555555, and 9 accesses an outside line, you 
might insert pauses as follows: 9-555-5555. To enter a pause in the fax number you are typing, touch 
the * repeatedly, until a dash (-) appears on the display.

You can also send the fax using monitor dialing. This enables you to listen to the phone line as you dial. 
You can set the pace of your dialing and respond to prompts as you dial. For more information, see Send 
a fax using monitor dialing.

● The number you entered when sending the fax is not in the proper format or the receiving fax machine is 
having problems. To check this, try calling the fax number from a telephone and listen for fax tones. If 
you cannot hear fax tones, the receiving fax machine might not be turned on or connected, or a voice 
mail service could be interfering with the recipient's phone line. You can also ask the recipient to check 
the receiving fax machine for any problems.

Fax tones are recorded on my answering machine
● When you have an answering machine on the same phone line you use for fax calls, try connecting the 

answering machine directly to the printer, click here to go online for more information. If you do not 
connect the answering machine as recommended, fax tones might be recorded on your answering 
machine.

● Make sure the printer is set to receive faxes automatically and that the Rings to Answer setting is 
correct. The number of rings to answer for the printer should be greater than the number of rings to 
answer for the answering machine. If the answering machine and the printer are set to the same 
number of rings to answer, both devices answer the call and fax tones are recorded on the answering 
machine.

● Set your answering machine to a low number of rings and the printer to answer in the maximum number 
of rings supported. (The maximum number of rings varies by country/region.) In this setup, the 
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answering machine answers the call and the printer monitors the line. If the printer detects fax tones, 
the printer receives the fax. If the call is a voice call, the answering machine records the incoming 
message. For more information, see Set the number of rings before answering.

The phone cord that came with my printer is not long enough
If the phone cord that came with the printer is not long enough, you can use a longer 2-wire phone cord to 
extend the length. You can purchase the cord at an electronics store that carries phone accessories.

TIP: If you have a 2 wire phone adaptor, you may use it with a 4-wire phone cord to exend the length.

To extend your phone cord

1. Using the phone cord supplied in the box with the printer, connect to the port labeled 1-LINE on the back 
of the printer.

2. Connect another phone cord and the open port on the coupler and to the telephone wall jack.

The computer cannot receive faxes (HP Digital Fax)
● The computer selected to receive faxes is turned off. Make sure the computer selected to receive faxes is 

switched on at all times.

● Different computers are configured for setup and receiving faxes and one of them may be switched off. 
If the computer receiving faxes is different from the one used for setup, both computers should be 
switched on at all times.

● HP Digital Fax is not activated or the computer is not configured to receive faxes. Activate HP Digital Fax 
and make sure the computer is configured to receive faxes.

Solve problems using Web Services
If you are having problems using Web Services, such as HP ePrint and HP Printables, check the following:

● Make sure the printer is connected to the Internet using an Ethernet or wireless connection.

NOTE: You cannot use these web features if the printer is connected using a USB cable.

● Make sure the latest product updates have been installed on the printer. For more information, see 
Update the printer.

● Make sure Web Services is enabled on the printer. For more information, see Set up Web Services.

● Make sure the network hub, switch, or router is turned on and working correctly.

● If you are connecting the printer using an Ethernet cable, make sure you are not using a phone cord or a 
crossover cable to connect the printer to the network, and that the Ethernet cable is securely connected 
to the printer. For more information, see General network troubleshooting.

● If you are connecting the printer using a wireless connection, make sure the wireless network is 
functioning properly. For more information, see Unable to connect the printer wirelessly.

● If you are using HP ePrint, check the following:
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— Make sure the printer's email address is correct.

— Make sure that the printer's email address is the only address listed in the “To” line of the email 
message. If other email addresses are listed in the “To” line, the attachments you are sending 
might not print.

— Make sure you are sending documents that meet the HP ePrint requirements. For more 
information, visit HP Connected at www.hpconnected.com .

● If your network uses proxy settings when connecting to the Internet, make sure the proxy settings you 
are entering are valid:

— Check the settings being used by the web browser you are using (such as Internet Explorer, Firefox, 
or Safari).

— Check with the IT administrator or person who set up your firewall.

If the proxy settings used by your firewall have changed, you must update these settings in either 
the printer control panel or the embeded web server. If these settings are not updated, you will not 
be able to use Web Services.

For more information, see Set up Web Services.

TIP: For additional help on setting up and using Web Services, visit HP Connected at 
www.hpconnected.com .

Solve network problems
This section provides solutions to common problems on connecting or using the printer on a network.

● General network troubleshooting

● Unable to connect the printer wirelessly

For more information about network problems, check the following:

● Use this troubleshooter to help find your network security settings. Click here to go online for more 
information. At this time, this website might not be available in all languages.

● Use this troubleshooter that helps you to convert a USB connection to a wireless one. Click here to go 
online for more information. At this time, this website might not be available in all languages.

● Use this troubleshooter to help you connect to HP wireless direct, or to help you troubleshoot HP 
wireless direct issues, such as not being able to connect to HP wireless direct, not being able to print 
when using HP wireless direct, or you cannot connect to the Internet. Click here to go online for more 
information. At this time, this website might not be available in all languages.

● Use this troubleshooter to help you get your printer onto your network, or it was on your network and 
now it is not. Click here to go online for more information. At this time, this website might not be 
available in all languages.

● Use this troubleshooter to help you get your printer on the network if you have a firewall or antivirus 
protection that is causing a problem. Click here to go online for more information. At this time, this 
website might not be available in all languages.

General network troubleshooting
During software installation if the software cannot find the printer on the network you will be prompted to 
enter the printer's IP address which is found on the network configuration page. For more information, see 
Network configuration page.
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TIP: You can visit the HP online support website at www.hp.com/support for information and utilities that 
can help you correct many common printer problems.

(Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing, scanning, and copying 
issues. The application is only available in some languages.

Ensure the following:

● If using a wireless connection, make sure the Wireless light is on. For more information, see Turn on or 
off the wireless capability of the printer.

● If using an Ethernet connection, be sure to connect the Ethernet cable when prompted to do so during 
the software installation, and check that the Link light near the connector on the back of the printer gets 
turned on.

● All cable connections to the computer and the printer are secure.

● The network is operational and the network hub, switch, or router is turned on.

● (Windows) All applications, including virus protection programs, spyware protection programs, and 
firewalls, are closed or temporarily disabled.

Unable to connect the printer wirelessly
Make sure you have already set up the printer wireless capabilities by completing the wireless connection 
setup.

For more information about the wireless connection setup, see Set up the printer for wireless communication.

NOTE: If your printer supports Ethernet networking, make sure that an Ethernet cable is not connected to 
the printer. Connecting an Ethernet cable turns off the printer wireless capability.

Table 10-1  Understand the behaviors of the Wireless (802.11) light on the printer

Light description/Light pattern Explanation

The Wireless light is off. The wireless capability of the printer is 
turned off.

The Wireless light is on but blinking. The wireless capability of the printer is 
turned on and the printer is not connected to 
a network.
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Table 10-1  Understand the behaviors of the Wireless (802.11) light on the printer (continued)

Light description/Light pattern Explanation

The Wireless light is on and solid. The wireless capability of the printer is 
turned on and the printer is connected to a 
network.

Try the following steps to connect the printer wirelessly.

1. Make sure the Wireless (802.11) light is turned on. If the blue wireless light on the printer control panel 
is not lit, the wireless capability of the printer might be turned off.

To turn on the wireless capability of the printer

a. Touch  (the Wireless button) from the printer control panel, and then touch Settings .

b. Touch Wireless Settings.

c. Slide the button to turn on the printer wireless capability.

If the blue wireless light is blinking, it means the printer is not connected to a network. Run the Wireless 
Setup Wizard from the printer control panel display to set up wireless communication. For more 
information, see Set up the printer on your wireless network.

2. Make sure the computer is connected to the wireless network

If you cannot connect the computer to the network, there might be a hardware issue with the router or 
computer.

3. Verify that the printer's IP address has not been altered. If the printer's IP address has changed since it 
was first installed, you need to run the Update IP utility to print again. The Update IP address utility was 
installed by the software.

a. Open the printer sofware. For more information, see Open the HP printer software (Windows).

b. Select the Update IP address utility.

If the test fails, review the test report for information on how to fix the problem and run the test again.
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4. Run the wireless test to make sure the wireless connection is working properly.

a. Make sure the printer is turned on and paper is loaded in the tray.

b. From the printer control panel display, touch Setup .

c. Touch Network Setup .

d. Touch Print Reports .

e. Touch Wireless Test Report.

If the test fails, review the test report for information on how to fix the problem and run the test again.

5. Restart components of the wireless network.

a. Turn off the router and the printer.

b. Turn the router and the printer back on in this order: router first and then printer.

Sometimes, turning off devices and then turning them back on helps resolve network communication 
issues. If you still cannot connect, turn off the router, the printer, and the computer, and then turn them 
back on in this order: router first, then printer, and then computer.

 Use this troubleshooter to help you get your printer onto your network, or it was on your network 

and now it is not. Click here to go online for more information. At this time, this website might not be available 
in all languages.

If you still have problems, visit the HP Wireless Printing Center ( www.hp.com/go/wirelessprinting ). (At this 
time, this website might not be available in all languages.) The website contains the latest information about 
setting up and using the printer on a wireless network, and resolving issues on wireless connection and 
security software.

If the wireless connection cannot be made, the printer can also be connected to the network using an 
Ethernet cable.

Maintain the printer
This section provides instructions for keeping the printer in top working condition. Perform these 
maintenance procedures as necessary.

● Clean the scanner glass

● Clean the exterior 

● Clean the document feeder

● Maintain the printhead and ink cartridges

Clean the scanner glass
Dust or dirt on the scanner glass, scanner lid backing, or scanner frame can slow down performance, degrade 
the quality of scans, and affect the accuracy of special features such as fitting copies to a certain page size.

To clean the scanner glass

WARNING! Before cleaning the printer, turn the printer off by pressing  (the Power button) and unplug the 
power cord from the electrical socket.

1. Lift the scanner lid.
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2. Clean the scanner glass and lid backing by using a soft, lint-free cloth that has been sprayed with a mild 
glass cleaner.

CAUTION: Use only glass cleaner to clean the scanner glass. Avoid cleaners that contain abrasives, 
acetone, benzene, and carbon tetrachloride, all of which can damage the scanner glass. Avoid isopropyl 
alcohol because it can leave streaks on the scanner glass.

CAUTION: Do not spray the glass cleaner directly on the scanner glass. If too much glass cleaner is 
applied, the cleaner could leak under the scanner glass and damage the scanner.

3. Close the scanner lid, and turn on the printer.

Clean the exterior 

WARNING! Before cleaning the printer, turn the printer off by pressing  (the Power button) and unplug the 
power cord from the electrical socket.

Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the case. Keep fluids away from the 
interior of the printer, as well as from the printer control panel.

Clean the document feeder
If the document feeder picks up multiple pages or if it does not pick up plain paper, you can clean the rollers 
and separator pad.

To clean the rollers or separator pad

WARNING! Before cleaning the printer, turn the printer off by pressing  (the Power button) and unplug the 
power cord from the electrical socket.

1. Remove all originals from the document feeder tray.
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2. Lift the document feeder cover.

This provides easy access to the rollers (1) and separator pad (2).

1 Rollers

2 Separator pad

3. Lightly dampen a clean lint-free cloth with distilled water, then squeeze any excess liquid from the cloth.

4. Use the damp cloth to wipe any residue off the rollers or separator pad.

NOTE: If the residue does not come off using distilled water, try using isopropyl (rubbing) alcohol.

5. Close the cover of the document feeder.
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Maintain the printhead and ink cartridges
If you are experiencing problems with printing, you might have a problem with the printhead. You should 
perform the procedures in the following sections only when directed to do so for resolving print quality 
issues. For more information, see Print quality report.

Performing the aligning and cleaning procedures unnecessarily can waste ink and shorten the life of the 
cartridges.

● Clean the printhead if your printed output is streaked or has any incorrect or missing colors.

There are three stages of cleaning. Each stage lasts about two minutes, uses one sheet of paper, and 
uses an increasing amount of ink. After each stage, review the quality of the printed page. You should 
only initiate the next phase of cleaning if the print quality is poor.

If print quality still seems poor after you complete all stages of cleaning, try aligning the printer. If print 
quality problems persist after cleaning and aligning, contact HP support. For more information, see HP 
support.

● Align the printer when the printer status page shows streaking or white lines through any of the blocks 
of color, or if you are having print quality issues with your printouts.

The printer automatically aligns the printhead during the initial setup.

● Clean ink smears when your printed output has smearing on the back. Ink may have built up in some 
areas of the printer and needs to be removed.

NOTE: Cleaning uses ink, so clean the printhead only when necessary. The cleaning process takes a few 
minutes. Some noise might be generated in the process.

Turning the printer off improperly can cause print quality problems. For more information, see Turn the 
printer off.

To clean or align the printheads, or clean ink smears

1. Load Letter or A4 unused plain white paper into the input tray. For more information, see Load paper.

2. From the printer control panel display, touch Setup .

3. Touch Printer Maintenance , select the desired option, and then follow the on-screen instructions.

NOTE: You can also do the same from the HP printer software or embedded web server (EWS). To access the 
software or EWS, see Open the HP printer software (Windows) or Open the embedded web server.

Clear paper jams
Paper jams can occur either inside the printer or in the document feeder.

CAUTION: To prevent possible damage to the printhead, clear paper jams as soon as possible.

To clear a paper jam

CAUTION: Avoid pulling jammed paper from the front of the printer. Instead follow the steps below to clear 
the jam. Pulling out jammed paper from the front of the printer might cause the paper to tear and leave torn 
pieces inside the printer; this could result in more jams later. 

1. Open the ink cartridge access door.
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2. Check the paper path inside the printer.

a. Lift the handle of the paper path cover and remove the cover.
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b. Locate any jammed paper inside the printer, grasp it with both hands and pull it towards you.

CAUTION: If the paper tears when you are removing it from the rollers, check the rollers and 
wheels for torn pieces of paper that might be remaining inside the printer.

If you do not remove all the pieces of paper from the printer, more paper jams are likely to occur.

c. Reinsert the paper path cover until it snaps into place.

3. If the problem is not resolved, check the print carriage area inside the printer.

CAUTION: During the process, avoid touching the cable attached to the print carriage.
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a. If there is any jammed paper, move the print carriage to the far right of the printer, grasp the 
jammed paper with both hands, and then pull it towards you.

CAUTION: If the paper tears when you are removing it from the rollers, check the rollers and 
wheels for torn pieces of paper that might be remaining inside the printer.

If you do not remove all the pieces of paper from the printer, more paper jams are likely to occur.
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b. Move the carriage to the far left of the printer, and do the same as in the previous step to remove 
any torn pieces of paper.

4. Close the ink cartridge access door.

5. If the problem is still not resolved, check the tray area.

a. Lift the output tray.

b. Pull out the input tray to extend it.
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c. Press down the buttons on both sides of the input tray, and pull to remove the input tray.

d. Check the gap in the printer where the input tray was. If there is any jammed paper, reach into the 
gap, grasp the paper with both hands and pull it towards you.

CAUTION: If the paper tears when you are removing it from the rollers, check the rollers and 
wheels for torn pieces of paper that might be remaining inside the printer.

If you do not remove all of the pieces of paper from the printer, more paper jams are likely to occur.

e. Insert the input tray, load paper, and lower the output tray.

 Click here to use the HP online troubleshooter to resolve a paper jam.

 If the print carriage cannot move, click here to use the HP online troubleshooter to resolve a print 

carriage jam. At this time, this website might not be available in all languages.

To clear a paper jam in the document feeder

1. Lift the cover of the document feeder.
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2. Lift the green tab located on the front edge of the document feeder.
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3. Gently pull the jammed paper out of the rollers.

CAUTION: If the paper tears when you are removing it from the rollers, check the rollers and wheels 
for torn pieces of paper that might remain inside the printer. 

If you do not remove all the pieces of paper from the printer, more paper jams are likely to occur.

4. Close the document feeder cover, pressing down firmly until it snaps into place.

 If the above solutions do not resolve the problem, click here for more online troubleshooting.

To avoid paper jams

To help avoid paper jams, follow these guidelines.

● Remove printed papers from the output tray frequently.

● Make sure that you are printing with paper that is not wrinkled, folded, or damaged.

● Prevent curled or wrinkled paper by storing all unused paper flat in a resealable bag.

● Do not use paper that is too thick or too thin for the printer.

● Make sure that the trays are loaded correctly and are not too full. For more information, see Load paper.

● Ensure that paper loaded in the input tray lays flat and the edges are not bent or torn.

● Do not place too much paper in the document feeder tray. For information on the maximum number of 
sheets allowed in the document feeder, see Specifications.

● Do not combine different paper types and paper sizes in the input tray; the entire stack of paper in the 
input tray must be the same size and type.

● Adjust the paper-width guides in the input tray to fit snugly against all paper. Make sure the paper-width 
guides do not bend the paper in the input tray.

● Do not force paper too far inside the input tray.
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● If you are printing on both sides of a page, do not print highly saturated images on light weight paper.

● Use paper types that are recommended for the printer. For more information, see Recommended papers 
for printing.

● If the printer is about to run out of paper, allow the printer to run out of paper first, and then add paper. 
Do not load paper when the printer is printing.

● Make sure that the printer is clean. For more information, see Maintain the printer.

Clear the print carriage
Remove any objects, such as paper, that are blocking the print carriage.

See Clear paper jams for more information.

NOTE: Do not use any tools or other devices to remove jammed paper. Always use caution when removing 
jammed paper from inside the printer.

 If the print carriage cannot move, click here to use the HP online troubleshooter to resolve a print 

carriage jam. At this time, this website might not be available in all languages.

Restore defaults and settings
If you disable some functions or change some settings and want to change them back, you can restore the 
printer to the original factory settings or network settings.

To restore the printer to the original factory settings

1. From the printer control panel display, touch Setup .

2. Touch Printer Maintenance .

3. Touch Restore.

4. Touch Restore Settings.

5. Select which function you would like to restore to the original factory settings:

● Copy

● Scan

● Fax

● Photo

● Network

● Web Services

● Printer Setup

Touch Restore.

6. A message appears stating that the settings will be restored.

Touch Yes.
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To restore the printer to the original factory defaults

1. From the printer control panel, touch Setup .

2. Touch Printer Maintenance .

3. Touch Restore.

4. Touch Restore Factory Defaults.

A message appears stating that the factory defaults will be restored.

5. A message appears stating that the network defaults have been restored.

Touch Restore.

To restore the printer to the original network settings

1. From the printer control panel, touch Setup .

2. Touch Network Setup.

3. Touch Restore Network Settings.

4. A message appears stating that the network defaults will be restored.

Touch Yes.

5. Print the network configuration page and verify that the network settings have been reset.

For more information, see Network configuration page.

NOTE: Previously configured wireless settings are removed when you reset the printer network settings.

TIP: You can visit the HP online support website at www.hp.com/support for information and utilities that 
can help you correct many common printer problems.

(Windows) Run the HP Print and Scan Doctor to diagnose and automatically fix printing, scanning, and copying 
issues. The application is only available in some languages.
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A Technical information

This section contains the following topics:

● Specifications

● Regulatory information

● Environmental product stewardship program

Specifications
For more information, visit www.hp.com/support . Select your country or region. Click Product Support & 
Troubleshooting. Enter the name shown on the front of the printer, and then select Search. Click Product 
information, and then click Product specifications.

System requirements

● Software and system requirements can be found in the Readme file, which is available on the HP printer 
software CD provided with your printer.

● For information about future operating system releases and support, visit the HP online support website 
at www.hp.com/support .

Environmental specifications

● Operating temperature: 5° to 40° C (41° to 104° F)

● Operating humidity: 15 to 80% RH non-condensing

● Recommended operating conditions: 15° to 32° C (59° to 90° F)

● Recommended relative humidity: 20 to 80% noncondensing

Input tray capacity

● Plain paper sheets (60 to 105 g/m2 [16 to 28 lb]): Up to 225

● Envelopes: Up to 30

● Index cards: Up to 80

● Photo paper sheets: Up to 100

Output tray capacity

● Plain paper sheets (60 to 105 g/m2 [16 to 28 lb]): Up to 60

Document feeder capacity

● Plain paper sheets (60 to 105 g/m2 [16 to 28 lb]): Up to 35
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Paper size and weights

For the list of supported paper sizes, see the HP printer software.

● Plain paper: 60 to 105 g/m2 (16 to 28 lb)

● Envelopes: 75 to 90 g/m2 (20 to 24 lb)

● Cards: Up to 200 g/m2 (110-lb index maximum)

● Photo paper: 250 g/m2 (66 lb)

Print specifications

● Print speeds vary according to the complexity of the document and printer model

● Method: drop-on-demand thermal officejet

● Language: PCL3 GUI

● Print resolution:

Draft mode — Color Input/Black Render: 300x300dpi

— Output (Black/Color): Automatic

Normal mode — Color Input/Black Render: 600x600dpi

— Output (Black/Color): Automatic

Plain-Best mode — Color Input/Black Render: 600x600dpi

— Output (Black/Color): Automatic

Photo-Best mode — Color Input/Black Render: 600x600dpi

— Output (Black/Color): Automatic

Max DPI mode — Color Input/Black Render: 1200x1200dpi

— Output: Automatic (Black/Color), 4800x1200 optimized dpi (Photo Paper, Color)

To print in maximum dpi mode, see Print using the maximum dpi.

● Set minimum margins:

The document margins must match (or exceed) these margin settings in portrait orientation.
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Media (1) Left margin (2) Right margin (3) Top margin (4) Bottom margin

U.S. Letter

U.S. Legal

A4

U.S. Executive

B5

A5

Cards

Custom-sized media

Photo media

3 mm (0.12 inch) 3 mm (0.12 inch) 3 mm (0.12 inch) 3 mm (0.12 inch)

Envelopes 3 mm (0.12 inch) 3 mm (0.12 inch) 16.5 mm (0.65 
inch)

16.5 mm (0.65 
inch)

Copy specifications

● Digital image processing

● Copy speeds vary according to the complexity of the document and printer model

● Up to 99 copies from original

● Digital zoom: from 25 to 400%

● Fit to page, copy preview

Scan specifications

● Resolution: Up to 1200 x 1200 ppi optical

For more information about scan resolution, see the HP printer software.

● Color: 24-bit color, 8-bit grayscale (256 levels of gray)

● Maximum scan size:

— Scanner glass: 216 x 297 mm (8.5 x 11.7 inches)

— Document feeder: 216 x 356 mm (8.5 x 14 inches)

Fax specifications

● Walk-up black-and-white and color fax capability.

● Manual fax send and receive.

● Automatic busy redial up to five times (varies by country/region).

● Automatic no-answer redial up to two times (varies by country/region).

● Automatic communication problem redial up to five times (varies by country/region).

● Confirmation and activity reports.

● CCITT/ITU Group 3 fax with Error Correction Mode.

● Up to 33.6 Kbps transmission.
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● 4 seconds per page speed at 33.6 Kbps (based on ITU-T Test Image #1 at standard resolution). More 
complicated pages or higher resolution takes longer and uses more memory.

● Ring detect with automatic fax/answering machine switching.

● Fax resolution:

 Photo (dpi) Very Fine (dpi) Fine (dpi) Standard (dpi)

Black 203 x 196 (8-bit grayscale) 300 x 300 203 x 196 203 x 98

Color 200 x 200 200 x 200 200 x 200 200 x 200

● Fax to PC specifications

— Supported file types: TIFF and PDF

— Supported fax types: black-and-white faxes

Cartridge yield

● Visit www.hp.com/go/learnaboutsupplies for more information on estimated cartridge yields.

Acoustic emission specifications

● Sound pressure (bystander position)

— LpAm 55 (dBA) (mono Draft print)

● Sound power

— LwAd 6.9 (BA)

Regulatory information
The printer meets product requirements from regulatory agencies in your country/region.

This section contains the following topics:

● Regulatory Model Number

● FCC statement

● Notice to users in Korea

● VCCI (Class B) compliance statement for users in Japan

● Notice to users in Japan about the power cord

● Noise emission statement for Germany

● Visual display workplaces statement for Germany

● Notice to users of the U.S. telephone network: FCC requirements

● Notice to users of the Canadian telephone network

● Notice to users in the European Economic Area

● Notice to users of the German telephone network

● Australia wired fax statement

● European Union Regulatory Notice
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— Products with external AC Adapters

— Products with wireless functionality

— European telephone network declaration (Modem/Fax)

● Declaration of conformity

● Regulatory information for wireless products

— Exposure to radio frequency radiation

— Notice to users in Brazil

— Notice to users in Canada

— Notice to users in Taiwan

— Notice to users in Mexico

— Wireless notice to users in Japan

Regulatory Model Number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The Regulatory 
Model Number for your product is SNPRC-1402-01. This regulatory number should not be confused with the 
marketing name (HP Officejet 6800 e-All-in-One) or product number (E3E02A).

FCC statement
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Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan

Notice to users in Japan about the power cord

Noise emission statement for Germany

Visual display workplaces statement for Germany
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Notice to users of the U.S. telephone network: FCC requirements
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Notice to users of the Canadian telephone network

Notice to users in the European Economic Area
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Notice to users of the German telephone network

Australia wired fax statement

European Union Regulatory Notice

Products bearing the CE marking comply with one or more of the following EU Directives as may be 
applicable: Low Voltage Directive 2006/95/EC, EMC Directive 2004/108/EC, Ecodesign Directive 2009/125/EC, 
R&TTE Directive 1999/5/EC, RoHS Directive 2011/65/EU. Compliance with these directives is assessed using 
applicable European Harmonised Standards. The full Declaration of Conformity can be found at the following 
website: www.hp.com/go/certificates (Search with the product model name or its Regulatory Model Number 
(RMN), which may be found on the regulatory label.)

The point of contact for regulatory matters is:

Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen, GERMANY

Products with external AC Adapters

CE compliance of this product is valid only if powered with the correct CE-marked AC adapter provided by HP.

Products with wireless functionality

EMF

● This product meets international guidelines (ICNIRP) for exposure to radio frequency radiation.

If it incorporates a radio transmitting and receiving device then in normal use, a separation distance of 
20 cm ensures that radio frequency exposure levels comply with EU requirements.

Wireless functionality in Europe

● This product is designed for use without restrictions in all EU countries plus Iceland, Liechtenstein, 
Norway and Switzerland.

European telephone network declaration (Modem/Fax)

HP products with FAX capability comply with the requirements of the R&TTE Directive 1999/5/EC (Annex II) 
and carry the CE marking accordingly. However, due to differences between the individual PSTNs provided in 
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different countries/regions, the approval does not, of itself, give an unconditional assurance of successful 
operation on every PSTN network termination point. In the event of problems, you should contact your 
equipment supplier in the first instance.
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Declaration of conformity

ENWW Regulatory information 131



Regulatory information for wireless products
This section contains the following regulatory information pertaining to wireless products:

● Exposure to radio frequency radiation

● Notice to users in Brazil

● Notice to users in Canada

● Notice to users in Taiwan

● Notice to users in Mexico

● Wireless notice to users in Japan

Exposure to radio frequency radiation

Notice to users in Brazil
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Notice to users in Canada

Notice to users in Taiwan
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Notice to users in Mexico

Wireless notice to users in Japan

Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sustainable manner:

● Design for recycling has been incorporated into this product.

● The number of materials has been kept to a minimum while ensuring proper functionality and reliability.

● Dissimilar materials have been designed to separate easily.

● Fasteners and other connections are easy to locate, access, and remove using common tools.

● High priority parts have been designed to access quickly for efficient disassembly and repair.

For more information, visit www.hp.com/ecosolutions

This section contains the following topics:

● Paper use

● Plastics

● Material safety data sheets

● Recycling program

● HP inkjet supplies recycling program

● Disposal of waste equipment by users

● Power consumption

● Chemical substances

● Battery disposal in the Taiwan

● Battery notice for Brazil

● California Perchlorate Material Notice

● Declaration of the Presence Condition of the Restricted Substances Marking (Taiwan)

● Toxic and hazardous substance table (China)

● Restriction of hazardous substance (Ukraine)

● Restriction of hazardous substance (India)
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● EPEAT

● China SEPA Ecolabel User Information

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to 
identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP website at:

www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/regions, and 
partners with some of the largest electronic recycling centers throughout the world. HP conserves resources 
by reselling some of its most popular products. For more information regarding recycling of HP products, 
please visit:

www.hp.com/recycle

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is available in 
many countries/regions, and lets you recycle used print cartridges and ink cartridges free of charge. For more 
information, go to the following website:

www.hp.com/hpinfo/globalcitizenship/environment/recycle/

Disposal of waste equipment by users

This symbol means do not dispose of your product with your other household waste. Instead, 
you should protect human health and the environment by handing over your waste 
equipment to a designated collection point for the recycling of waste electrical and electronic 
equipment. For more information, please contact your household waste disposal service, or 
go to http://www.hp.com/recycle.

Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is qualified to the U.S. 
Environmental Protection Agency’s ENERGY STAR specifications for imaging equipment. The following mark 
will appear on ENERGY STAR qualified imaging products:
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Additional ENERGY STAR qualified imaging product model information is listed at: www.hp.com/go/energystar

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our products 
as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European 
Parliament and the Council). A chemical information report for this product can be found at: www.hp.com/go/
reach.

Battery disposal in the Taiwan

Battery notice for Brazil

California Perchlorate Material Notice
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Declaration of the Presence Condition of the Restricted Substances Marking 
(Taiwan)

限用物質含有情況標示聲明書

Declaration of the Presence Condition of the Restricted Substances Marking

單元 Unit

限用物質及其化學符號

Restricted substances and its chemical symbols

鉛

Lead

(Pb)

汞

Mercury

(Hg)

鎘

Cadmium

(Cd)

六價鉻

Hexavalent 
chromium

(Cr+6)

多溴聯苯

Polybrominated 
biphenyls

(PBB)

多溴二苯醚

Polybrominate
d diphenyl 

ethers

(PBDE)

外殼和紙匣

(External Casings and Trays)

0 0 0 0 0 0

電線 (Cables) 0 0 0 0 0 0

印刷電路板

(Printed Circuit Boards)

－ 0 0 0 0 0

列印引擎(Print Engine) － 0 0 0 0 0

列印機組件 (Print Assembly) － 0 0 0 0 0

噴墨印表機墨水匣 (Print 
Supplies)

0 0 0 0 0 0

列印機配件 (Print Accessory) － 0 0 0 0 0

備考 1.〝超出 0.1 wt %〞及〝超出 0.01 wt %〞係指限用物質之百分比含量超出百分比含量基準值。

Note 1: “Exceeding 0.1 wt %” and “exceeding 0.01 wt %” indicate that the percentage content of the restricted substance exceeds the 
reference percentage value of presence condition.

備考 2.〝0〞係指該項限用物質之百分比含量未超出百分比含量基準值。

Note 2: “0” indicates that the percentage content of the restricted substance does not exceed the percentage of reference value of 
presence.

備考 3.〝－〞係指該項限用物質為排除項目。

Note 3: The “−” indicates that the restricted substance corresponds to the exemption.

若要存取產品的最新使用指南或手冊，請前往 www.support.hp.com。選取搜尋您的產品，然後依照 畫
面上的指示繼續執行。

To access the latest user guides or manuals for your product, go to www.support.hp.com. Select Find your 
product, and then follow the onscreen instructions.
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Toxic and hazardous substance table (China)

Restriction of hazardous substance (Ukraine)

Restriction of hazardous substance (India)

EPEAT
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China SEPA Ecolabel User Information
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B Additional fax setup

After completing all the steps in the getting started guide, use the instructions in this section to complete 
your fax setup. Keep your getting started guide for later use.

In this section, you learn how to set up the printer so that faxing works successfully with equipment and 
services you might already have on the same phone line.

TIP: You can also use the Fax Setup Wizard (Windows) or HP Utility (OS X) to help you quickly set up some 
important fax settings such as the answer mode and fax header information. You can access these tools 
through the HP software you installed with the printer. After you run these tools, follow the procedures in this 
section to complete your fax setup.

This section contains the following topics:

● Set up faxing (parallel phone systems)

● Test fax setup

Set up faxing (parallel phone systems)
Before you begin setting up the printer for faxing, determine which kind of phone system your country/region 
uses. The instructions for fax setup differ depending on whether you have a serial- or parallel-type phone 
system.

● If you do not see your country/region listed in the table, you probably have a serial-type phone system. 
In a serial-type phone system, the connector type on your shared telephone equipment (modems, 
phones, and answering machines) does not allow a physical connection to the "2-EXT" port on the 
printer. Instead, all equipment must be connected at the telephone wall jack.

NOTE: In some countries/regions that use serial-type phone systems, the phone cord that came with 
the printer might have an additional wall plug attached to it. This enables you to connect other telecom 
devices to the wall jack where you plug in the printer.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

● If your country/region is listed in the table, you probably have a parallel-type telephone system. In 
a parallel-type phone system, you are able to connect shared telephone equipment to the phone line by 
using the "2-EXT" port on the back of the printer.

NOTE: If you have a parallel-type phone system, HP recommends you use the 2-wire phone cord 
supplied with the printer to connect it to the telephone wall jack.

Table B-1  Countries/regions with a parallel-type phone system

Argentina Australia Brazil

Canada Chile China

Colombia Greece India

Indonesia Ireland Japan

Korea Latin America Malaysia

Mexico Philippines Poland
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Table B-1  Countries/regions with a parallel-type phone system (continued)

Portugal Russia Saudi Arabia

Singapore Spain Taiwan

Thailand USA Venezuela

Vietnam   

If you are unsure which kind of telephone system you have (serial or parallel), check with your telephone 
company.

This section contains the following topics:

● Select the correct fax setup for your home or office

● Case A: Separate fax line (no voice calls received)

● Case B: Set up the printer with DSL

● Case C: Set up the printer with a PBX phone system or an ISDN line

● Case D: Fax with a distinctive ring service on the same line

● Case E: Shared voice/fax line

● Case F: Shared voice/fax line with voice mail

● Case G: Fax line shared with computer modem (no voice calls received)

● Case H: Shared voice/fax line with computer modem

● Case I: Shared voice/fax line with answering machine

● Case J: Shared voice/fax line with computer modem and answering machine

● Case K: Shared voice/fax line with computer dial-up modem and voice mail

Select the correct fax setup for your home or office
To fax successfully, you need to know what types of equipment and services (if any) share the same phone 
line with the printer. This is important because you might need to connect some of your existing office 
equipment directly to the printer, and you might also need to change some fax settings before you can fax 
successfully.

1. Determine if your telephone system is serial or parallel.

For more information, see Set up faxing (parallel phone systems).

2. Select the combination of equipment and services sharing your fax line.

● DSL: A Digital subscriber line (DSL) service through your telephone company. (DSL might be called 
ADSL in your country/region.)

● PBX: A private branch exchange (PBX) phone system.

● ISDN: An integrated services digital network (ISDN) system.

● Distinctive ring service: A distinctive ring service through your telephone company provides 
multiple telephone numbers with different ring patterns.

● Voice calls: Voice calls are received at the same phone number you use for fax calls on the printer.
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● Computer dial-up modem: A computer dial-up modem is on the same phone line as the printer. If 
you answer Yes to any of the following questions, you are using a computer dial-up modem:

— Do you send and receive faxes directly to and from your computer software applications 
through a dial-up connection?

— Do you send and receive email messages on your computer through a dial-up connection?

— Do you access the Internet from your computer through a dial-up connection?

● Answering machine: An answering machine that answers voice calls at the same phone number 
you use for fax calls on the printer.

● Voice mail service: A voice mail subscription through your telephone company at the same number 
you use for fax calls on the printer.

3. From the following table, select the combination of equipment and services applicable to your home or 
office setting. Then look up the recommended fax setup. Step-by-step instructions are included for each 
case in the sections that follow.

NOTE: If your home or office setup is not described in this section, set up the printer as you would a regular 
analog phone. Make sure you use the phone cord supplied in the box to connect one end to your telephone 
wall jack and the other end to the port labeled 1-LINE on the back of the printer. If you use another phone 
cord, you might experience problems sending and receiving faxes.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

Other equipment or services sharing your fax line Recommended fax setup

DSL PBX Distinctive 
ring service

Voice 
calls

Computer dial-
up modem

Answering 
machine

Voice mail 
service

       Case A: Separate fax line (no 
voice calls received)

      Case B: Set up the printer with 
DSL

      Case C: Set up the printer with 
a PBX phone system or an 
ISDN line

      Case D: Fax with a distinctive 
ring service on the same line

      Case E: Shared voice/fax line

     Case F: Shared voice/fax line 
with voice mail

      Case G: Fax line shared with 
computer modem (no voice 
calls received)

     Case H: Shared voice/fax line 
with computer modem

     Case I: Shared voice/fax line 
with answering machine
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Other equipment or services sharing your fax line Recommended fax setup

DSL PBX Distinctive 
ring service

Voice 
calls

Computer dial-
up modem

Answering 
machine

Voice mail 
service

    Case J: Shared voice/fax line 
with computer modem and 
answering machine

    Case K: Shared voice/fax line 
with computer dial-up modem 
and voice mail

Case A: Separate fax line (no voice calls received)
If you have a separate phone line on which you receive no voice calls, and you have no other equipment 
connected on this phone line, set up the printer as described in this section.

Figure B-1  Back view of the printer

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the 1-LINE port.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

To set up the printer with a separate fax line

1. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the telephone wall jack to the printer, you might not 
be able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.

2. Turn on the Auto Answer setting.

3. (Optional) Change the Rings to Answer setting to the lowest setting (two rings).

4. Run a fax test.
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When the phone rings, the printer answers automatically after the number of rings you set in the Rings to 
Answer setting. The printer begins emitting fax reception tones to the sending fax machine and receives the 
fax.

Case B: Set up the printer with DSL
If you have a DSL service through your telephone company, and do not connect any equipment to the printer, 
use the instructions in this section to connect a DSL filter between the telephone wall jack and the printer. 
The DSL filter removes the digital signal that can interfere with the printer, so the printer can communicate 
correctly with the phone line. (DSL might be called ADSL in your country/region.)

NOTE: If you have a DSL line and you do not connect the DSL filter, you cannot send and receive faxes with 
the printer.

Figure B-2  Back view of the printer

1 Telephone wall jack

2 DSL (or ADSL) filter and cord supplied by your DSL provider

3 Use the phone cord supplied in the box with the printer to connect to the 1-LINE port.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

To set up the printer with DSL

1. Obtain a DSL filter from your DSL provider.

2. Using the phone cord supplied in the box with the printer, connect one end to the open port on the DSL 
filter, and then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the DSL filter to the printer, you might not be able to 
fax successfully. This special phone cord is different from the phone cords you might already have in 
your home or office.

As only one phone cord is supplied, you might need to obtain additional phone cords for this setup.
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3. Connect an additional phone cord from the DSL filter to the telephone wall jack.

4. Run a fax test.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Case C: Set up the printer with a PBX phone system or an ISDN line
If you are using either a PBX phone system or an ISDN converter/terminal adapter, make sure you do the 
following:

● If you are using either a PBX or an ISDN converter/terminal adaptor, connect the printer to the port that 
is designated for fax and phone use. Also, make sure that the terminal adapter is set to the correct 
switch type for your country/region, if possible.

NOTE: Some ISDN systems allow you to configure the ports for specific phone equipment. For 
example, you might have assigned one port for telephone and Group 3 fax and another port for multiple 
purposes. If you have problems when connected to the fax/phone port of your ISDN converter, try using 
the port designated for multiple purposes; it might be labeled "multi-combi" or something similar.

● If you are using a PBX phone system, set the call waiting tone to "off."

NOTE: Many digital PBX systems include a call-waiting tone that is set to "on" by default. The call 
waiting tone interferes with any fax transmission, and you cannot send or receive faxes with the printer. 
Refer to the documentation that came with your PBX phone system for instructions on how to turn off 
the call-waiting tone.

● If you are using a PBX phone system, dial the number for an outside line before dialing the fax number.

● Make sure you use the supplied cord to connect from the telephone wall jack to the printer. If you do not, 
you might not be able to fax successfully. This special phone cord is different from the phone cords you 
might already have in your home or office. If the supplied phone cord is too short, you can purchase 
a longer 2-wire phone cord from your local electronics store and extend it.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Case D: Fax with a distinctive ring service on the same line
If you subscribe to a distinctive ring service (through your telephone company) that allows you to have 
multiple phone numbers on one phone line, each with a different ring pattern, set up the printer as described 
in this section.
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Figure B-3  Back view of the printer

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the 1-LINE port.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

To set up the printer with a distinctive ring service

1. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the telephone wall jack to the printer, you might not 
be able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.

2. Turn on the Auto Answer setting.

3. Change the Distinctive Ring setting to match the pattern that the telephone company assigned to your 
fax number.

NOTE: By default, the printer is set to answer all ring patterns. If you do not set the Distinctive Ring to 
match the ring pattern assigned to your fax number, the printer might answer both voice calls and fax 
calls or it might not answer at all.

TIP: You can also use the Ring Pattern Detection feature in the printer control panel to set distinctive 
ring. With this feature, the printer recognizes and records the ring pattern of an incoming call and, based 
on this call, automatically determines the distinctive ring pattern assigned by your telephone company 
to fax calls. For more information, see Change the answer ring pattern for distinctive ring.

4. (Optional) Change the Rings to Answer setting to the lowest setting (two rings).

5. Run a fax test.

The printer automatically answers incoming calls that have the ring pattern you selected ( Distinctive Ring 
setting) after the number of rings you selected ( Rings to Answer setting). The printer begins emitting fax 
reception tones to the sending fax machine and receives the fax.
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If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Case E: Shared voice/fax line
If you receive both voice calls and fax calls at the same phone number, and you have no other office 
equipment (or voice mail) on this phone line, set up the printer as described in this section.

Figure B-4  Back view of the printer

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the 1-LINE port.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

3 Telephone (optional)

To set up the printer with a shared voice/fax line

1. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the telephone wall jack to the printer, you might not 
be able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.

2. Do one of the following:

● If you have a parallel-type phone system, remove the white plug from the port labeled 2-EXT on 
the back of the printer, and then connect a phone to this port.

● If you have a serial-type phone system, you might plug your phone directly on top of the printer 
cable which has a wall plug attached to it.

3. Now you need to decide how you want the printer to answer calls, automatically or manually:

● If you set up the printer to answer calls automatically, it answers all incoming calls and receives 
faxes. The printer cannot distinguish between fax and voice calls in this case; if you suspect the call 
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is a voice call, you need to answer it before the printer answers the call. To set up the printer to 
answer calls automatically, turn on the Auto Answer setting.

● If you set up the printer to answer faxes manually, you must be available to respond in person to 
incoming fax calls or the printer cannot receive faxes. To set up the printer to answer calls 
manually, turn off the Auto Answer setting.

4. Run a fax test.

If you pick up the phone before the printer answers the call and hear fax tones from a sending fax machine, 
you need to answer the fax call manually.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Case F: Shared voice/fax line with voice mail
If you receive both voice calls and fax calls at the same phone number, and you also subscribe to a voice mail 
service through your telephone company, set up the printer as described in this section.

NOTE: You cannot receive faxes automatically if you have a voice mail service at the same phone number 
you use for fax calls. You must receive faxes manually; this means you must be available to respond in person 
to incoming fax calls. If you want to receive faxes automatically instead, contact your telephone company to 
subscribe to a distinctive ring service, or to obtain a separate phone line for faxing.

Figure B-5  Back view of the printer

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the 1-LINE port.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

To set up the printer with voice mail

1. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

You might need to connect the supplied phone cord to the adapter provided for your country/region.
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NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the telephone wall jack to the printer, you might not 
be able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.

2. Turn off the Auto Answer setting.

3. Run a fax test.

You must be available to respond in person to incoming fax calls, or the printer cannot receive faxes. You must 
initiate the manual fax before voicemail picks up the line.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Case G: Fax line shared with computer modem (no voice calls received)
If you have a fax line on which you receive no voice calls, and you also have a computer modem connected on 
this line, set up the printer as described in this section.

NOTE: If you have a computer dial-up modem, your computer dial-up modem shares the phone line with the 
printer. You cannot use both your modem and the printer simultaneously. For example, you cannot use the 
printer for faxing while you are using your computer dial-up modem to send an email or access the Internet.

● Set up the printer with a computer dial-up modem

● Set up the printer with a computer DSL/ADSL modem

Set up the printer with a computer dial-up modem

If you are using the same phone line for sending faxes and for a computer dial-up modem, follow these 
directions for setting up the printer.

Figure B-6  Back view of the printer

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the 1-LINE port.
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You might need to connect the supplied phone cord to the adapter provided for your country/region.

3 Computer with modem

To set up the printer with a computer dial-up modem

1. Remove the white plug from the port labeled 2-EXT on the back of the printer.

2. Find the phone cord that connects from the back of your computer (your computer dial-up modem) to 
a telephone wall jack. Disconnect the cord from the telephone wall jack and plug it into the port labeled 
2-EXT on the back of the printer.

3. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the telephone wall jack to the printer, you might not 
be able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.

4. If your modem software is set to receive faxes to your computer automatically, turn off that setting.

NOTE: If you do not turn off the automatic fax reception setting in your modem software, the printer 
cannot receive faxes.

5. Turn on the Auto Answer setting.

6. (Optional) Change the Rings to Answer setting to the lowest setting (two rings).

7. Run a fax test.

When the phone rings, the printer automatically answers after the number of rings you set in the Rings to 
Answer setting. The printer begins emitting fax reception tones to the sending fax machine and receives the 
fax.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Set up the printer with a computer DSL/ADSL modem

If you have a DSL line and use that phone line to send faxes, follow these instructions to set up your fax.

150 Appendix B   Additional fax setup ENWW



1 Telephone wall jack

2 Parallel splitter

3 DSL/ADSL filter

Connect one end of the phone jack that was supplied with the printer to connect to the 1-LINE port 
on the back of the printer. Connect the other end of the cord to the DSL/ADSL filter.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

4 Computer

5 Computer DSL/ADSL modem

NOTE: You need to purchase a parallel splitter. A parallel splitter has one RJ-11 port on the front and two 
RJ-11 ports on the back. Do not use a 2–line phone splitter, a serial splitter, or a parallel splitter which has two 
RJ-11 ports on the front and a plug on the back.

Figure B-7  Example of a parallel splitter

To set up the printer with a computer DSL/ADSL modem

1. Obtain a DSL filter from your DSL provider.

2. Using the phone cord provided in the box with the printer, connect one end to the DSL filter, and then 
connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the DSL filter to the back of the printer, you might 
not be able to fax successfully. This special phone cord is different from the phone cords you might 
already have in your home or office.
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3. Connect the DSL filter to the parallel splitter.

4. Connect the DSL modem to the parallel splitter.

5. Connect the parallel splitter to the wall jack.

6. Run a fax test.

When the phone rings, the printer automatically answers after the number of rings you set in the Rings to 
Answer setting. The printer begins emitting fax reception tones to the sending fax machine and receives the 
fax.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Case H: Shared voice/fax line with computer modem
There are two different ways to set up the printer with your computer based on the number of phone ports on 
your computer. Before you begin, check your computer to see if it has one or two phone ports.

NOTE: If your computer has only one phone port, you need to purchase a parallel splitter (also called 
a coupler), as shown in the illustration. (A parallel splitter has one RJ-11 port on the front and two RJ-11 ports 
on the back. Do not use a two-line phone splitter, a serial splitter, or a parallel splitter which has two RJ-11 
ports on the front and a plug on the back.)

● Shared voice/fax with computer dial-up modem

● Shared voice/fax with computer DSL/ADSL modem

Shared voice/fax with computer dial-up modem

If you use your phone line for both fax and telephone calls, use these instructions to set up your fax.

There are two different ways to set up the printer with your computer based on the number of phone ports on 
your computer. Before you begin, check your computer to see if it has one or two phone ports.

NOTE: If your computer has only one phone port, you need to purchase a parallel splitter (also called 
a coupler), as shown in the illustration. (A parallel splitter has one RJ-11 port on the front and two RJ-11 ports 
on the back. Do not use a two-line phone splitter, a serial splitter, or a parallel splitter which has two RJ-11 
ports on the front and a plug on the back.)

Figure B-8  Example of a parallel splitter
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Figure B-9  Back view of the printer

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the 1-LINE port.

3 Parallel splitter

4 Computer with modem

5 Telephone

To set up the printer on the same phone line as a computer with two phone ports

1. Remove the white plug from the port labeled 2-EXT on the back of the printer.

2. Find the phone cord that connects from the back of your computer (your computer dial-up modem) to 
a telephone wall jack. Disconnect the cord from the telephone wall jack and plug it into the port labeled 
2-EXT on the back of the printer.

3. Connect a phone to the "OUT" port on the back of your computer dial-up modem.

4. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the telephone wall jack to the printer, you might not 
be able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.

5. If your modem software is set to receive faxes to your computer automatically, turn off that setting.

NOTE: If you do not turn off the automatic fax reception setting in your modem software, the printer 
cannot receive faxes.

6. Now you need to decide how you want the printer to answer calls, automatically or manually:
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● If you set up the printer to answer calls automatically, it answers all incoming calls and receives 
faxes. The printer cannot distinguish between fax and voice calls in this case; if you suspect the call 
is a voice call, you need to answer it before the printer answers the call. To set up the printer to 
answer calls automatically, turn on the Auto Answer setting.

● If you set up the printer to answer faxes manually, you must be available to respond in person to 
incoming fax calls or the printer cannot receive faxes. To set up the printer to answer calls 
manually, turn off the Auto Answer setting.

7. Run a fax test.

If you pick up the phone before the printer answers the call and hear fax tones from a sending fax machine, 
you need to answer the fax call manually.

If you use your phone line for voice, fax, and your computer dial-up modem, follow these directions to set up 
your fax.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Shared voice/fax with computer DSL/ADSL modem

Use these instructions if your computer has a DSL/ADSL modem

1 Telephone wall jack

2 Parallel splitter

3 DSL/ADSL filter

4 Use the phone cord provided to connect to the 1-LINE port on the back of the printer.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

5 DSL/ADSL modem

6 Computer

7 Telephone
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NOTE: You need to purchase a parallel splitter. A parallel splitter has one RJ-11 port on the front and two 
RJ-11 ports on the back. Do not use a 2–line phone splitter, a serial splitter, or a parallel splitter which has two 
RJ-11 ports on the front and a plug on the back.

Figure B-10  Example of a parallel splitter

To set up the printer with a computer DSL/ADSL modem

1. Obtain a DSL filter from your DSL provider.

NOTE: Phones in other parts of the home/office sharing the same phone number with DSL service 
need to be connected to additional DSL filters to avoid noise when making voice calls.

2. Using the phone cord supplied in the box with the printers, connect one end to the DSL filter, then 
connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the DSL filter to the printer, you might not be able to 
fax successfully. This special phone cord is different from phone cords you might already have in your 
home or office.

3. If you have a parallel-type phone system, remove the white plug from the port labeled 2-EXT on the 
back of the printer, and then connect a phone to this port.

4. Connect the DSL filter to the parallel splitter.

5. Connect the DSL modem to the parallel splitter.

6. Connect the parallel splitter to the wall jack.

7. Run a fax test.

When the phone rings, the printer automatically answers after the number of rings you set in the Rings to 
Answer setting. The printer begins emitting fax reception tones to the sending fax machine and receives the 
fax.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Case I: Shared voice/fax line with answering machine
If you receive both voice calls and fax calls at the same phone number, and you also have an answering 
machine that answers voice calls at this phone number, set up the printer as described in this section.
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Figure B-11  Back view of the printer

1 Telephone wall jack

2 Use the phone cord provided to connect to the 1-LINE port on the back of the printer

You might need to connect the supplied phone cord to the adapter provided for your country/region.

3 Answering machine

4 Telephone (optional)

To set up the printer with a shared voice/fax line with answering machine

1. Remove the white plug from the port labeled 2-EXT on the back of the printer.

2. Unplug your answering machine from the telephone wall jack, and connect it to the port labeled 2-EXT 
on the back of the printer.

NOTE: If you do not connect your answering machine directly to the printer, fax tones from a sending 
fax machine might be recorded on your answering machine, and you might not receive faxes with the 
printer.

3. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the telephone wall jack to the printer, you might not 
be able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.

4. (Optional) If your answering machine does not have a built-in phone, for convenience you might want to 
connect a phone to the back of your answering machine at the "OUT" port.

NOTE: If your answering machine does not let you connect an external phone, you can purchase and 
use a parallel splitter (also known as a coupler) to connect both the answering machine and telephone to 
the printer. You can use standard phone cords for these connections.
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5. Turn on the Auto Answer setting.

6. Set your answering machine to answer after a low number of rings.

7. Change the Rings to Answer setting on the printer to the maximum number of rings supported by your 
printer. (The maximum number of rings varies by country/region.)

8. Run a fax test.

When the phone rings, your answering machine answers after the number of rings you have set, and then 
plays your recorded greeting. The printer monitors the call during this time, "listening" for fax tones. If 
incoming fax tones are detected, the printer emits fax reception tones and receives the fax; if there are no fax 
tones, the printer stops monitoring the line and your answering machine can record a voice message.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Case J: Shared voice/fax line with computer modem and answering machine
If you receive both voice calls and fax calls at the same phone number, and you also have a computer modem 
and answering machine connected on this phone line, set up the printer as described in this section.

NOTE: Since your computer dial-up modem shares the phone line with the printer, you cannot use both your 
modem and the printer simultaneously. For example, you cannot use the printer for faxing while you are 
using your computer dial-up modem to send an email or access the Internet.

● Shared voice/fax line with computer dial-up modem and answering machine

● Shared voice/fax line with computer DSL/ADSL modem and answering machine

Shared voice/fax line with computer dial-up modem and answering machine

There are two different ways to set up the printer with your computer based on the number of phone ports on 
your computer. Before you begin, check your computer to see if it has one or two phone ports.

NOTE: If your computer has only one phone port, you need to purchase a parallel splitter (also called 
a coupler), as shown in the illustration. (A parallel splitter has one RJ-11 port on the front and two RJ-11 ports 
on the back. Do not use a two-line phone splitter, a serial splitter, or a parallel splitter which has two RJ-11 
ports on the front and a plug on the back.)

Figure B-12  Example of a parallel splitter
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Figure B-13  Back view of the printer

1 Telephone wall jack

2 "IN" phone port on your computer

3 "OUT" phone port on your computer

4 Telephone (optional)

5 Answering machine

6 Computer with modem

7 Use the phone cord supplied in the box with the printer to connect to the 1-LINE port.

You might need to connect the supplied phone cord to the adapter provided for your country/region.

To set up the printer on the same phone line as a computer with two phone ports

1. Remove the white plug from the port labeled 2-EXT on the back of the printer.

2. Find the phone cord that connects from the back of your computer (your computer dial-up modem) to 
a telephone wall jack. Disconnect the cord from the telephone wall jack and plug it into the port labeled 
2-EXT on the back of the printer.

3. Unplug your answering machine from the telephone wall jack, and connect it to the port labeled "OUT" 
on the back of the computer (the computer dial-up modem).

4. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the telephone wall jack to the printer, you might not 
be able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.
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5. (Optional) If your answering machine does not have a built-in phone, for convenience you might want to 
connect a phone to the back of your answering machine at the "OUT" port.

NOTE: If your answering machine does not let you connect an external phone, you can purchase and 
use a parallel splitter (also known as a coupler) to connect both the answering machine and telephone to 
the printer. You can use standard phone cords for these connections.

6. If your modem software is set to receive faxes to your computer automatically, turn off that setting.

NOTE: If you do not turn off the automatic fax reception setting in your modem software, the printer 
cannot receive faxes.

7. Turn on the Auto Answer setting.

8. Set your answering machine to answer after a low number of rings.

9. Change the Rings to Answer setting on the printer to the maximum number of rings supported by the 
product. (The maximum number of rings varies by country/region.)

10. Run a fax test.

When the phone rings, your answering machine answers after the number of rings you have set, and then 
plays your recorded greeting. The printer monitors the call during this time, "listening" for fax tones. If 
incoming fax tones are detected, the printer emits fax reception tones and receives the fax; if there are no fax 
tones, the printer stops monitoring the line and your answering machine can record a voice message.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Shared voice/fax line with computer DSL/ADSL modem and answering machine

1 Telephone wall jack

2 Parallel splitter

3 DSL/ADSL filter
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4 Phone cord provided with the printer connected to the 1-LINE port on the back of the printer

You might need to connect the supplied phone cord to the adapter provided for your country/region.

5 DSL/ADSL modem

6 Computer

7 Answering machine

8 Telephone (optional)

NOTE: You need to purchase a parallel splitter. A parallel splitter has one RJ-11 port on the front and two 
RJ-11 ports on the back. Do not use a 2–line phone splitter, a serial splitter, or a parallel splitter which has two 
RJ-11 ports on the front and a plug on the back.

Figure B-14  Example of a parallel splitter

To set up the printer with a computer DSL/ADSL modem

1. Obtain a DSL/ADSL filter from your DSL/ADSL provider.

NOTE: Phones in other parts of the home/office sharing the same phone number with DSL/ADSL 
service need to be connected to additional DSL/ADSL filters, to avoid noise when making voice calls.

2. Using the phone cord supplied in the box with the printer, connect one end to the DSL/ADSL filter, then 
connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the DSL/ADSL filter to the printer, you might not be 
able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.

3. Connect the DSL/ADSL filter to the splitter.

4. Unplug the answering machine from the telephone wall jack, and connect it to the port labeled 2-EXT on 
the back of the printer.

NOTE: If you do not connect your answering machine directly to the printer, fax tones from a sending 
fax machine might be recorded on your answering machine, and you might not receive faxes with the 
printer.

5. Connect the DSL modem to the parallel splitter.

6. Connect the parallel splitter to the wall jack.

7. Set your answering machine to answer after a low number of rings.

8. Change your Rings to Answer setting on the printer to the maximum number of rings supported by the 
printer.

NOTE: The maximum number of rings varies by country/region.

9. Run a fax test.
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When the phone rings, your answering machine answers after the number of rings you have set, and then 
play your recorded greeting. The printer monitors the call during this time, “listening” for fax tones. If 
incoming fax tones are detected, the printer emits fax reception tones and receive the fax; if there are no fax 
tones, the printer stops monitoring the line and your answering machine can record a voice message.

If you use the same phone line for telephone, fax, and have a computer DSL modem, follow these instructions 
to set up your fax.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Case K: Shared voice/fax line with computer dial-up modem and voice mail
If you receive both voice calls and fax calls at the same phone number, use a computer dial-up modem on the 
same phone line, and subscribe to a voice mail service through your telephone company, set up the printer as 
described in this section.

NOTE: You cannot receive faxes automatically if you have a voice mail service at the same phone number 
you use for fax calls. You must receive faxes manually; this means you must be available to respond in person 
to incoming fax calls. If you want to receive faxes automatically instead, contact your telephone company to 
subscribe to a distinctive ring service, or to obtain a separate phone line for faxing.

Since your computer dial-up modem shares the phone line with the printer, you cannot use both your modem 
and the printer simultaneously. For example, you cannot use the printer for faxing if you are using your 
computer dial-up modem to send an email or access the Internet.

There are two different ways to set up the printer with your computer based on the number of phone ports on 
your computer. Before you begin, check your computer to see if it has one or two phone ports.

● If your computer has only one phone port, you need to purchase a parallel splitter (also called a coupler), 
as shown in the illustration. (A parallel splitter has one RJ-11 port on the front and two RJ-11 ports on 
the back. Do not use a two-line phone splitter, a serial splitter, or a parallel splitter which has two RJ-11 
ports on the front and a plug on the back.)

Figure B-15  Example of a parallel splitter

● If your computer has two phone ports, set up the printer as follows:
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Figure B-16  Back view of the printer

1 Telephone wall jack

2 Use the phone cord supplied in the box with the printer to connect to the 1-LINE port

You might need to connect the supplied phone cord to the adapter provided for your country/
region.

3 Computer with modem

4 Telephone

To set up the printer on the same phone line as a computer with two phone ports

1. Remove the white plug from the port labeled 2-EXT on the back of the printer.

2. Find the phone cord that connects from the back of your computer (your computer dial-up modem) to 
a telephone wall jack. Disconnect the cord from the telephone wall jack and plug it into the port labeled 
2-EXT on the back of the printer.

3. Connect a phone to the "OUT" port on the back of your computer dial-up modem.

4. Using the phone cord supplied in the box with the printer, connect one end to your telephone wall jack, 
then connect the other end to the port labeled 1-LINE on the back of the printer.

NOTE: You might need to connect the supplied phone cord to the adapter provided for your country/
region.

If you do not use the supplied cord to connect from the telephone wall jack to the printer, you might not 
be able to fax successfully. This special phone cord is different from the phone cords you might already 
have in your home or office.

5. If your modem software is set to receive faxes to your computer automatically, turn off that setting.

NOTE: If you do not turn off the automatic fax reception setting in your modem software, the printer 
cannot receive faxes.

6. Turn off the Auto Answer setting.

7. Run a fax test.
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You must be available to respond in person to incoming fax calls, or the printer cannot receive faxes.

If you encounter problems setting up the printer with optional equipment, contact your local service provider 
or vendor for further assistance.

Test fax setup
You can test your fax setup to check the status of the printer and to make sure it is set up correctly for faxing. 
Perform this test after you have completed setting up the printer for faxing. The test does the following:

● Tests the fax hardware

● Verifies the correct type of phone cord is connected to the printer

● Checks that the phone cord is plugged into the correct port

● Checks for a dial tone

● Checks for an active phone line

● Tests the status of your phone line connection

The printer prints a report with the results of the test. If the test fails, review the report for information on 
how to fix the problem and rerun the test.

To test fax setup via the printer control panel

1. Set up the printer for faxing according to your particular home or office setup instructions.

2. Make sure the ink cartridges are installed, and that full-size paper is loaded in the input tray before 
starting the test.

3. From the printer control panel, touch Setup .

4. Touch Fax Setup .

5. Touch Tools , and then touch Run Fax Test.

The printer displays the status of the test on the display and prints a report.

6. Review the report.

● If the test passes and you are still having problems faxing, check the fax settings listed in the 
report to verify the settings are correct. A blank or incorrect fax setting can cause problems faxing.

● If the test fails, review the report for more information on how to fix any problems found.
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C Errors (Windows)

● Low on ink

● Very low on ink

● Ink cartridge problem

● Paper size mismatch

● Ink cartridge carriage stalled

● Paper jam or tray problem

● Out of paper

● Document failed to print

● Printer failure

● Door open

● Ink cartridge failure

● Printer supply upgrade problem

● Counterfeit Cartridge Advisory

● Use SETUP cartridges

● Do not use SETUP cartridges

● Incompatible ink cartridges

● Problem with Printer Preparation

● Paper too short

● Ink cartridge incorrectly installed

● Problem with SETUP cartridges

● Problem with printhead

● Incompatible HP Instant Ink Cartridge

● Used HP Instant Ink Cartridge

● Please Connect Printer to HP Connected

● Cannot Print

● Output tray closed

● Paper Jam in Automatic Document Feeder

● HP Protected Cartridge Installed

Low on ink
The ink cartridge identified in the message is low on ink.
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Ink level warnings and indicators provide estimates for planning purposes only. When you receive a low ink 
warning message, consider having a replacement cartridge available to avoid possible printing delays. You do 
not need to replace cartridges until the print quality becomes unacceptable.

For information about replacing ink cartridges, see Replace the ink cartridges. For information about ordering 
ink cartridges, see Order ink cartridges. For information about recycling used ink supplies, see HP inkjet 
supplies recycling program.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways, including in the 
initialization process, which prepares the printer and cartridges for printing. In addition, some residual ink is 
left in the cartridge after it is used. For more information see www.hp.com/go/inkusage .

Very low on ink
The ink cartridge identified in the message is very low on ink.

Ink level warnings and indicators provide estimates for planning purposes only. When you receive a very low 
ink warning message, HP recommends having a replacement cartridge available to avoid possible printing 
delays. You do not need to replace cartridges until the print quality is unacceptable.

For information about replacing ink cartridges, see Replace the ink cartridges. For information about ordering 
ink cartridges, see Order ink cartridges. For information about recycling used ink supplies, see HP inkjet 
supplies recycling program.

NOTE: Ink from the cartridges is used in the printing process in a number of different ways, including in the 
initialization process, which prepares the printer and cartridges for printing. In addition, some residual ink is 
left in the cartridge after it is used. For more information see www.hp.com/go/inkusage .

Ink cartridge problem
The ink cartridge identified in the message is missing, damaged, incompatible, or inserted into the wrong slot 
in the printer.

NOTE: If the cartridge is identified in the message as incompatible, see Order ink cartridges for information 
about obtaining cartridges for the printer. 

To solve this problem, try the following solutions. Solutions are listed in order, with the most likely solution 
first. If the first solution does not solve the problem, continue trying the remaining solutions until the issue is 
resolved.

● Solution 1: Turn the printer off and on.

● Solution 2: Install the ink cartridges correctly.

Solution 1: Turn the printer off and on 

Turn off the printer, and then turn it on again.

If the problem persists, try the next solution.

Solution 2: Install the ink cartridges correctly

Make sure all of the ink cartridges are properly installed:

1. Make sure the printer is turned on.

2. Open the ink cartridge access door.

NOTE: Wait until the print carriage stops moving before proceeding.
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3. Press the front of the ink cartridge to release it, and then remove it from the slot.

4. Insert the cartridge into the slot. Press firmly on the cartridge to ensure proper contact.

5. Close the ink cartridge access door.

Paper size mismatch
The paper size or type selected in the printer driver does not match the paper loaded in the printer. Make sure 
that the correct paper is loaded in the printer, and then print the document again. For more information, see 
Load paper.

NOTE: If the paper loaded in the printer is the correct size, change the selected paper size in the printer 
driver, and then print the document again. 

Ink cartridge carriage stalled
Something is blocking the ink cartridge carriage (the part of the printer that holds the ink cartridges).

To clear the obstruction check the printer for jams.

For more information, see Clear paper jams.

Paper jam or tray problem
Paper has become jammed in the printer.

Before you try to clear the jam, check the following:

● Make sure that you have loaded paper that meets specifications and is not wrinkled, folded, or damaged. 
For more information, see Recommended papers for printing.

● Make sure that the printer is clean. For more information, see Maintain the printer.

● Make sure that the trays are loaded correctly and are not too full. For more information, see Load paper.

For instructions on clearing jams, as well as more information about how to avoid jams, see Clear paper jams.

Out of paper
The default tray is empty.

Load more paper, and then touch OK .

For more information, see Load paper.

Document failed to print
The printer could not print the document because a problem occurred in the printing system.

For information about solving printing problems, see Solve printer problems.

Printer failure
There was a problem with the printer or ink system. Usually, you can resolve such problems by completing the 
following steps:
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1. Press  (the Power button) to turn off the printer.

2. Unplug the power cord, and then plug in the power cord again.

3. Press  (the Power button) to turn on the printer.

If this problem persists, write down the error code provided in the message, and then contact HP support. For 
more information about contacting HP support, see HP support.

Door open
Before the printer can print documents, all doors and covers must be closed.

TIP: When completely closed, most doors and covers snap into place. 

If the problem persists after you’ve securely closed all doors and covers, contact HP support. For more 
information, see HP support.

Ink cartridge failure
The cartridges listed in the message are damaged or have failed.

See Replace the ink cartridges.

Printer supply upgrade problem
The supply upgrade was not successful. The cartridges listed in the message can still be used in this printer. 
Replace the Supply Upgrade cartridge. For more information, see Replace the ink cartridges.

Counterfeit Cartridge Advisory
The installed cartridge is not a new, genuine HP cartridge. Contact the store where this cartridge was 
purchased. To report suspected fraud, visit HP at www.hp.com/go/anticounterfeit . To continue using the 
cartridge, click Continue.

Use SETUP cartridges
When you first setup the printer, you must install the cartridges that shipped in the box with the printer. 
These cartridges are labeled SETUP, and they calibrate your printer before the first print job. Failure to install 
the SETUP cartridges during the initial product setup causes an error. If you installed a set of regular 
cartridges, remove them and install the SETUP cartridges to complete printer setup. After printer setup is 
complete, the printer can use regular cartridges.

if you still receive error messages and the printer cannot complete ink system initialization, contact HP 
support. For more information, see HP support.

Click here to go online for more information . At this time, this website might not be available in all languages.

Do not use SETUP cartridges
SETUP cartridges cannot be used after the printer has been initialized. Remove and install non-SETUP 
cartridges. For more information, see Replace the ink cartridges.
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Incompatible ink cartridges
The ink cartridge is not compatible with your printer.

Solution: Remove this cartridge immediately and replace with a compatible ink cartridge. For information 
about how to install new cartridges, see Replace the ink cartridges.

Problem with Printer Preparation
The printer clock has failed and ink preparation may not be complete. The estimated Ink Level gauge might be 
inaccurate.

Solution: Check the print quality of your print job. If it is not satisfactory, running the printhead cleaning 
procedure from the toolbox might improve it.

Paper too short
The paper loaded is shorter than the minimum requirement. Paper that meets the printer requirements must 
be loaded. For more information, see Recommended papers for printing and Load paper.

Ink cartridge incorrectly installed
The ink cartridge indicated in the message is not installed correctly.

Make sure all of the ink cartridges are properly installed:

1. Make sure the printer is turned on.

2. Open the ink cartridge access door.

NOTE: Wait until the print carriage stops moving before proceeding.

3. Press the front of the ink cartridge to release it, and then remove it from the slot.

4. Insert the cartridge into the slot. Press firmly on the cartridge to ensure proper contact.

5. Close the ink cartridge access door.

Problem with SETUP cartridges
There is a problem with the SETUP cartridges and the printer cannot complete ink system initialization. Please 
contact HP support.

Problem with printhead
There is a problem with the printhead.

Turn off the printer, and then turn it on again.

If the problem persists, contact HP support for service. For more information, see HP support.

Incompatible HP Instant Ink Cartridge
This cartridge can only be used in a printer that is currently enrolled in HP Instant Ink.

If you believe your printer should accept this cartridge, please contact www.hp.com/buy/supplies .
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Used HP Instant Ink Cartridge
The HP Instant Ink cartridge(s) listed on the printer control panel display can only be used in the HP Instant 
Ink printer that initially installed the cartridge. The cartridge must be replaced.

For information about replacing ink cartridges, see Replace the ink cartridges. For information about ordering 
ink cartridges, see Order ink cartridges. For information about recycling used ink supplies, see HP inkjet 
supplies recycling program.

Please Connect Printer to HP Connected
The printer must be connected to HP Connected, otherwise you will be unable to print soon without further 
warning. See the printer control panel for instructions on connecting.

Cannot Print
The printer needs to be connected to HP Connected to update its Instant Ink status.

You will be unable to print until the printer has been connected to update the Instant Ink status. See the 
printer control panel for instructions on connecting.

Output tray closed
Open the output tray to continue printing.

Paper Jam in Automatic Document Feeder
Clear a paper jam in the document feeder. For more information, see Clear paper jams.

HP Protected Cartridge Installed
The ink cartridge listed on the printer control panel can only be used in the printer that initially protected the 
cartridge using the HP Cartridge Protection feature. The ink cartridge must be replaced in this printer.

For information about how to install a new ink cartridge, see Replace the ink cartridges.
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